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1  Preface

1.1  About This Manual

This operating manual provides all the information specific to the digital standard
IEEE 802.11.

The main focus of this manual is on the provided settings and the tasks required to
generate a signal. The following topics are included:
● Welcome to the IEEE 802.11 options R&S SMx/AMU-K54/-K86/-K142

Introduction to and getting familiar with the option
● About the IEEE 802.11 and basics

Background information on basic terms and principles in the context of the signal
generation

● IEEE 802.11 configuration and settings
A concise description of all functions and settings available to configure signal gen-
eration with their corresponding remote control commands

● How to generate a signal with the IEEE 802.11 options
The basic procedure to perform signal generation tasks and step-by-step instruc-
tions for more complex tasks or alternative methods
Detailed examples to guide you through typical signal generation scenarios and
allow you to try out the application immediately

● Remote control commands
Remote commands required to configure and perform signal generation in a
remote environment, sorted by tasks

● List of remote commands
Alphabetical list of all remote commands described in the manual

● Index

The functions specific to the discontinued products R&S®SMU200A,
R&S®SMATE200A, R&S®SMJ100A and R&S®AMU200A are not described here.

Find the description of the corresponding option at the following page:

https://www.rohde-schwarz.com/product/SMU200A > "Downloads"

Contents and scope

This description assumes R&S Signal Generator equipped with all availabe options.
Depending on your model and the installed options, some of the functions may not be
available on your instrument.

Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as much as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

About This Manual

https://www.rohde-schwarz.com/product/smu200a
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The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

1.2  Documentation Overview

This section provides an overview of the R&S Signal Generator user documentation.
Unless specified otherwise, you find the documents on the R&S Signal Generator
product page at:

www.rohde-schwarz.com/manual/smbv100a

1.2.1  Quick Start Guide Manual

Introduces the R&S Signal Generator and describes how to set up and start working
with the product. Includes basic operations, typical measurement examples, and gen-
eral information, e.g. safety instructions, etc. A printed version is delivered with the
instrument.

1.2.2  Operating Manual and Help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the quick start guide man-
ual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S Signal Generator is not included.

The contents of the user manuals are available as help in the R&S Signal Generator.
The help offers quick, context-sensitive access to the complete information for the
base unit and the software options.

All user manuals are also available for download or for immediate display on the Inter-
net.

1.2.3  Service Manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

Documentation Overview

http://www.rohde-schwarz.com/manual/smbv100a
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The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS, https://gloris.rohde-schwarz.com).

1.2.4  Instrument Security Procedures

Deals with security issues when working with the R&S Signal Generator in secure
areas. It is available for download on the Internet.

1.2.5  Basic Safety Instructions

Contains safety instructions, operating conditions and further important information.
The printed document is delivered with the instrument.

1.2.6  Data Sheets and Brochures

The data sheet contains the technical specifications of the R&S Signal Generator. It
also lists the options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smbv100a

1.2.7  Release Notes and Open Source Acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The open source acknowledgment document provides verbatim license texts of the
used open source software.

See www.rohde-schwarz.com/firmware/smbv100a

1.2.8  Application Notes, Application Cards, White Papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/smbv100a.

Documentation Overview

https://gloris.rohde-schwarz.com
http://www.rohde-schwarz.com/brochure-datasheet/smbv100a
http://www.rohde-schwarz.com/firmware/smbv100a
http://www.rohde-schwarz.com/application/smbv100a
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2  IEEE 802.11 WLAN Signal Generation
The R&S Signal Generator-K54/-K86/-K142 are firmware applications that add func-
tionality to generate signals in accordance with the wireless LAN standards
IEEE 802.11a/b/g/n/ac/p/j/ax.

The option R&S SMx/AMU-K54 offers signal generation according to IEEE 802.11n,
also legacy modes of IEEE 802.11a/b/g and IEEE 802.11p/j are supported. For
IEEE 802.11ac signal generation option R&S SMx/AMU-K86 is required and for
IEEE 802.11ax signal generation option R&S SMx/AMU-K142. At least one R&S SMx/
AMU-K54 option must be installed on the respective instrument as a prerequisite.

To play back a signal from a waveform file created by the simulation software
R&S WinIQSIM2, the corresponding R&S WinIQSIM2 digital standard option must be
installed.

The R&S Signal Generator supports all mandatory and almost all optional features of
the IEEE 802.11 standard.

The following list gives an overview of the main features:
● Support of up to eight Tx antennas
● 20 MHz and 40 MHz
● 80 MHz bandwidth with option R&S SMx/AMU-K86
● Support of all three operation modes (Legacy, Mixed Mode, Green Field)
● Support of all legacy transmission modes (L-20 MHz, L-Duplicate, L-Upper, L-

Lower)
● Support of all 11n transmission modes (HT-20 MHz, HT-40 MHz, HT-Duplicate, HT-

Upper, HT-Lower)
● Support of all 11ac transmission modes with option R&S SMx/AMU-K86 (VHT-20

MHz, VHT-40 MHz, VHT-80 MHz, VHT-80+80 MHz)
● Support of all 11ax transmission modes with option R&S SMx/AMU-K142 (HE-20

MHz, HE-40 MHz, HE-80 MHz, HE-80+80 MHz)
● Additional support of the CCK and PBCC frames in accordance with

IEEE 820.11a/b/g standard
● Support of STBC (Space Time Block Coding) and Spatial Multiplexing
● Up to 8 spatial streams in all supported channel widths
● Multi User MIMO available with 2 or more total spatial streams
● Configurable number of spatial streams, space time streams and additional spatial

streams, as well as configurable modulation per spatial stream
● Support of short guard interval
● Configurable state of the scramble, interleaver, time domain windowing and chan-

nel coding
● Configurable PPDU, MAC header and FCS
● Integrated frame block concept for the generation of sequence of cascaded frame

blocks with different configurations and data rates
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● Support of simple diversity and MIMO tests (Frequency Flat MIMO channel simula-
tion) without additional channel simulator

2.1  Signal Overview

IEEE 802.11n is the extension of the WLAN IEEE 802.11a/g standard to nominal peak
data rates of 600 Mbps. Like IEEE 802.11a/g, IEEE 802.11n is also based on OFDM.
Additionally, IEEE 802.11n uses MIMO technology, up to 40 MHz bandwidth and spe-
cial coding for increased throughput. The extension towards higher data rates is also
known as high throughput mode (HT mode) of 802.11n, whereas the non-HT mode can
be seen as the part of 802.11n, which is backwards compatible to 802.11a/g.

IEEE 802.11ac further extends 802.11n to nominal peak data rates of 6240.0 Mbps.
Like IEEE 802.11a/g/n, IEEE 802.11ac is also based on OFDM. Additionally, IEEE
802.11ac uses MIMO technology, up to 160 MHz bandwidth and special coding for
increased throughput. The extension towards higher data rates is also known as very
high throughput (VHT) mode of 802.11ac.

2.1.1  Operation Modes

The IEEE 802.11n standard defined the following three operation modes:
● Legacy mode

This mode is provided for backwards compatibility with the IEEE 802. a/g standard.
The mode is also known as Non-HT mode.

● Mixed Mode
A legacy preamble and header (L-STF, L-LTF and L-SIG) are wrapping the HT part
of the frame so that the frame is complying with OFDM-PHY and ERP-OFDM-PHY
corresponding to 802.11 a/g respectively.

● Green Field
In this mode, frames are being transmitted in a new high throughput format that
does not comply with the legacy mode. Green Field is an optional mode.

The Figure 2-1 shows the packet formats of the different operation modes that can be
triggered by a device supporting the IEEE 802.11n standard.

Figure 2-1: PLCP packet format for IEEE 802.11

Signal Overview
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The Table 2-1 gives an overview of the frequency domain operation modes of the
physical layer. Note that the duplicate mode corresponds to repeating the same com-
plex numbers modulating the subcarriers of the upper channel on the lower channel.

Table 2-1: Frequency domain PHY operation

LM Legacy mode as in IEEE 802.11a/g

Also, the CCK and the PBCC frames as in IEEE 802.11b/g

HT-Mode Frequency: 20 MHz and 40 MHz, 1...4 spatial streams (HT Duplicate Mode
included)

Duplicate Non-HT mode IEEE 802.11a OFDM-PHY format, 20 MHz and 40 MHz dual operation, upper
channel rotated by 90˚ relative to lower channel

Upper mode Non-HT/HT frame in the upper 20 MHz channel

Lower mode Non-HT/HT frame in the lower 20 MHz channel

VHT-Mode Frequency 20 MHz, 40 MHz and 80 MHz, 1...8 spatial streams (option
R&S SMx/AMU-K86 required)

HE mode Frequency 20 MHz, 40 MHz, 80 MHz, 160 MHz, 1...8 spatial streams (option
R&S SMx/AMU-K142 required)

When operating in the OFDM 20 MHz mode, there are 64 subcarriers available; the
migration to 40 MHz mode offers 128 subcarriers with the same frequency spacing of
312.5 KHz. 80 MHz bandwidth is using 256 subcarriers, keeping the original frequency
spacing. With 160 MHz bandwidth 512 subcarriers apply.

For IEEE 802.11ax in the OFDMA frequency allocation, the resource units (RU) may
contain 26, 52, 106, 242, 484 or 996 tones (aka subcarriers) and are in fixed locations.
The tones/subcarriers in the resource units are adjacent and contiguous except in the
middle of the channel where DC null carriers are present.

2.1.2  Signal Generation

The generation of an IEEE 802.11n/ac/ax signal is done in multiple steps. In high
throughput (HT) and very high throughput (VHT) modes, the data of a single user is
specially coded and transmitted via up to eight Tx antennas.

In this implementation, the mapping of the Tx antennas' signals to the output paths of
the instrument can be configured. This function can be used for the simulation of fre-
quency flat MIMO channel, i.e. one carrier analysis like BER tests for instance. Another
application of the configurable mapping is the possibility to generate a combined signal
from different antennas if there is one path instrument or limited number of baseband
paths.

Refer to Figure 2-2 for an overview of the signal flow for generation of such a signal in
HT mode.

Signal Overview
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Figure 2-2: IEEE 802.11 n/ac/ax transmission chain

2.2  Typical Workflows

The R&S Signal Generator equipped with the option digital standard
IEEE 802.11 WLAN allows you to generate signals for different transmitter and receiver
tests scenarios.

The test scenarios require different number of baseband paths, i.e. instruments. For
receiver test for example, the number of the Rx antenna to be simulated simultane-
ously determines the number of the required basebands of one or more instruments,
since one baseband generates the signal of one Rx antenna. In case of transmitter test
applications, the number of the Tx antenna to be simulated determines the number of
the required basebands of one or more instruments, since one baseband generates
the signal of one Tx antenna.

This chapter provides examples of some typical generic workflows and setups for
working with this option.

2.2.1  Generating a 4xN or 3xN MIMO WLAN-n/ac Signal with two R&S
Signal Generators for Transmitter Tests

This example shows the connection and configuration of two two-path instruments for
the generation of WLAN-n/ac signal for transmitter tests. Signal generated in this way
can be additionally fed to a fading simulator (requires option R&S SMU/AMU-K74/B14/
B15) for the simulation of realistic MxN MIMO channel conditions.

The 4xN and 3xN MIMO WLAN-n/ac signal generation scenario requires two two-path
instruments.

The instruments have to be configured and connected as described in the following
sections. Since the configuration and connection of the instruments is identical for both
scenarios, only the 4xN MIMO case is explained.

Typical Workflows
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Connecting two two-path R&S Signal Generators for 4xN MIMO WLAN-n/ac sig-
nal generation

Connect the instruments as follow:

1. To provide the instruments with reference frequency, connect either the inputs REF
IN of both instruments to the external reference source or connect the output REF
OUT of the first instrument (the R&S Signal Generator that will simulate Tx 1) to the
input REF IN of the second one.

2. Provide an external trigger source to the inputs TRIGGER 1 for both paths of both
instruments.

3. Avoid unnecessary cable lengths and branching points.

The figure below shows the cabling of two two-path R&S Signal Generators for gener-
ating a 4xN MIMO WLAN-n/ac signal.

Figure 2-3: Connecting two two-path R&S Signal Generators for the generation of 4xN MIMO WLAN-
n/ac signal

Configuring two R&S Signal Generators for MxN MIMO Simulation

1. Configure the Reference Oscillator Settings, depending on whether an External
Reference Source or the Reference Signal (REF OUT) of the first instrument is
used.

Typical Workflows
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a) Select "External Reference Frequency Source" for both instruments and config-
ure the Synchronization Bandwidth and the External Reference Frequency
accordingly.

SCPI command: SOUR:ROSC:SOUR EXT
b) Use the Reference Frequency of the first instrument, i.e. select an "Internal

Reference Frequency Source" for the first instrument and an External one for
the second instrument.

SCPI command (R&S Signal Generator #1):
SOUR:ROSC:SOUR INT
SCPI command (R&S Signal Generator #2):
SOUR:ROSC:SOUR EXT

2. For both instruments, select an "External Trigger Source".

SCPI command:
SOUR:BB:WLNN:TRIG:SOUR EXT | BEXT

3. Configure the first instrument to generate the desired WLAN-n/ac signal:

a) In the WLAN-n/ac main menu of the first instrument, enable signal generation
in coupling mode (enable parameter "Configure Baseband B from Baseband
A)".

SCPI command:
SOUR:BB:WLNN:PATH:COUP:STAT ON

b) In the "Tx Antenna Setup" menu of the first instrument, select four "Antennas".
The number of the Tx Antennas determines the value M in the MxN MIMO sys-
tem and the number of the transmission chains.

SCPI command:
SOUR:BB:WLNN:ANT:MODE A4

Typical Workflows
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c) In the "Tx Antenna Setup" menu of the first instrument, enable the Baseband A
of the instrument to generate the Tx 1 signal and respectively the Baseband B
to generate the Tx 2 signal.
Use the default values of the transmission chain matrix.

SCPI command:
SOUR:BB:WLNN:ANT:TCH1:OUTP:DEST BB
SOUR:BB:WLNN:ANT:TCH2:OUTP:DEST BB_B
SOUR:BB:WLNN:ANT:TCH3:OUTP:DEST OFF
SOUR:BB:WLNN:ANT:TCH4:OUTP:DEST OFF

d) To enable the R&S Signal Generator to generate a WLAN-n/ac signal of anten-
nas with different power level, set the power level of the corresponding path to
the desired level in the header display of the instrument.
SCPI command:
SOUR:POW -30
SOUR2:POW -20

e) Use the default "Frame Block Configuration" settings or adjust them as
required.

f) Use the default "PPDU Configuration" settings or adjust them if necessary to,
for instance, add redundancy.

g) Enable signal generation.
SCPI command:
SOUR:BB:WLNN:STAT ON

4. Enable the second instrument to generate the Tx 3 and Tx 4 of the same WLAN-
n/ac signal:

a) Save the settings of the first instrument by means of the "Save/Recall" function
and copy the settings file to USB stick, external USB HDD, or use a LAN con-
nection to transfer the settings file.
SCPI command (R&S Signal Generator #1):
SOUR:BB:WLNN:SETT:STOR "c:/11n_Settings/wlann_settings1"

b) Connect the USB stick or the USB HDD to USB connector of Instrument#2 and
copy the settings file to the instrument's target directory, e.g. c:/
11n_Instrument1.

c) Load the settings file of R&S Signal Generator #1 to R&S Signal Generator #2.
SCPI command (R&S Signal Generator #2):
SOUR:BB:WLNN:SETT:STOR "c:
/11n_Instrument1/wlann_settings1"

Typical Workflows
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d) In the "Tx Antenna Setup" menu of the second instrument, enable the Base-
band A of the instrument to generate the Tx 3 signal and respectively the Base-
band B to generate the Tx 4 signal and activate the digital standard in the sec-
ond one.
SCPI command (R&S Signal Generator #2):
SOUR:BB:WLNN:ANT:TCH3:OUTP:DEST BB
SOUR:BB:WLNN:ANT:TCH4:OUTP:DEST BB_B
SOUR:BB:WLNN:ANT:TCH1:OUTP:DEST OFF
SOUR:BB:WLNN:ANT:TCH2:OUTP:DEST OFF
SOUR:BB:WLNN:STAT ON

5. Send an external trigger signal.

2.2.2  Generating a Realistic MxN MIMO WLAN 802.11n/ac/p Signal for
Receiver Test under Static Conditions

This example shows you how to enable the R&S Signal Generator to generate a
WLAN 802.11n/802.11ac/802.11p signal for simple diversity and simulation of fre-
quency flat MIMO channel conditions. No additional channel simulator is necessary for
this test application.

The figure below shows an example of a simple diversity scenario with three transmis-
sion antennas Tx1..Tx3 and one receiving antenna Rx1. The channel is represented by
the weight coefficients w1 .. w3.

The R&S Signal Generator provides the possibility to weight, sum and map the gener-
ated Tx antenna signals to the output(s) of the signal generator, i.e. to simulate a fre-
quency flat MIMO channel conditions for single carrier analysis e.g. BER tests.

Typical Workflows
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The R&S Signal Generator generates the WLAN 802.11n/802.11ac/802.11p signal of
one Rx antenna per baseband path. Hence, two instruments are required for the Mx2
MIMO receiver testing.

To generate a realistic WLAN 802.11n/802.11ac/802.11p MIMO signal under static con-
ditions, configure the instrument(s) as follows:

1. In the "Frame Block Configuration" dialog set the "Std." for the required standard.

2. Use the default "Frame Block Configuration" settings or adjust them as required.

3. Use the default "PPDU Configuration" settings or adjust them if necessary to, for
instance, add redundancy.

4. In the "Transmit Antenna Setup" dialog, select the number of "Tx Antennas" to be
simulated. The number of the Tx Antennas determines the value M in the MxN
MIMO system and the number of the transmission chains.

5. Configure the subcarrier to be analyzed, i.e. configure the "Spatial Mapping Mode"
and set the "Time Shifts".

6. In the Tx Antenna Setup dialog, enable the Baseband to generate the Rx1 signal.

7. Select the mapping coordinates and adjust the weights of the Tx signals in the
Transmission Chain Matrix.

Typical Workflows
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8. To enable the R&S Signal Generator to generate a WLAN 802.11n/802.11ac/
802.11p signal of antennas with different power level, set the power level of the
corresponding path to the desired level in the header display of the instrument.

9. Enable signal generation.

The Baseband of the R&S Signal Generator will generate the Rx signal as a sum of the
three Tx signals, weighted with the selected coefficients.

Typical Workflows
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3  WLAN User Interface
► To access the dialog, select "Baseband Block > IEEE 802.11"

The dialog is split into several sections for configuring the standard. The upper section
of the dialog is where the IEEE 802.11 WLAN digital standard is enabled and the trans-
mission bandwidth is selected. A button leads to dialogs for loading and saving the
IEEE 802.11 WLAN configuration.

The buttons of the lower dialog section lead to dialogs for setting the transmission
antennas and configuring the frame blocks.

The screenshots provided in this description show parameter values that have been
selected to illustrate as much as possible of the provided functions and possible inter-
dependencies between them.
These values are not necessarily representative of realistic test situations.

3.1  General Settings for WLAN Signals

This section describes the general IEEE 802.11 WLAN settings, like enabling the stan-
dard and configuring the transmission bandwidth.

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

General Settings for WLAN Signals
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Remote command: 
[:SOURce<hw>]:BB:WLNN:STATe on page 106

Set to default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

General Parameters  

State Not affected by "Set to Default"

Transmission Bandwidth 20 MHz

Configure Baseband B from Baseband A Off

Tx Antennas 1

Filter Cosine

Clipping Off

Frame Blocks Configuration  

Frame Blocks 1

Frame Block Type DATA

Frame Blocks State On

Physical Mode MIXED MODE

Tx Mode HT-20 MHz

Frames 1

Idle Time 0.1 ms

Data Source PN9

TX Antenna Setup  

Antennas 1

Mapping Coordinates Cartesian

Output First set Baseband, rest is set to Off

Matrix Elements (Real, Imaginary, Magnitude,
Phase)

All zero but diagonal = 1

PPDU Configuration  

Spatial Streams 1

Space Time Streams 1

Extended Spatial Streams 0

Space Time Block Coding inactive

Parameter Value  

MCS 1

General Settings for WLAN Signals
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Parameter Value

Data Rate (Mbps) 13

Data Bits Per Symbol 52

Stream 1 QPSK

Channel Coding BCC

Coding Rate ½

Guard Long

Data Length 1024 bytes

Number of Data Symbols 158

Scrambler ON (User Init)

Scrambler Init 01

Interleaver Active ON

Service Field 0000

Time Domain Windowing Active On

Transition Time 100 ns

Preamble/Header Active ON

Smoothing ON

Spatial Mapping  

Mode Spatial Expansion

Index k 20

Remote command: 
[:SOURce<hw>]:BB:WLNN:PRESet on page 104

Save/Recall
Calls the "Save/Recall" menu.

From the "Save/Recall" menu, the "File Select" windows for saving and recalling IEEE
802.11 WLAN configurations and the "File Manager" can be called.

IEEE 802.11 WLAN configurations are stored as files with the predefined file extension
*.wlann. The file name and the directory they are stored in are user-definable.

The complete settings in the "IEEE 802.11 WLAN" menu are saved and recalled.

"Recall WLAN setting"
Opens the "File Select" window for loading a saved IEEE 802.11
WLAN configuration.
The configuration of the selected (highlighted) file is loaded by press-
ing the "Select" button.

General Settings for WLAN Signals
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"Save WLAN setting"
Opens the "File Select" window for saving the current IEEE 802.11
WLAN signal configuration.
The name of the file is specified in the "File name" entry field, the
directory selected in the "save into" field. The file is saved by pressing
the "Save" button.
The "Fast Save" checkbox determines whether the instrument per-
forms an absolute or a differential storing of the settings. Enable this
function to accelerate the saving process by saving only the settings
with values different to the default ones. "Fast Save" is not affected
by the "Preset" function.

"File Manager" Calls the "File Manager".
The "File Manager" is used to copy, delete, and rename files and to
create new directories.

Remote command: 
[:SOURce<hw>]:BB:WLNN:SETTing:CATalog? on page 104
[:SOURce<hw>]:BB:WLNN:SETTing:LOAD on page 105
[:SOURce<hw>]:BB:WLNN:SETTing:STORe on page 105
[:SOURce<hw>]:BB:WLNN:SETTing:STORe:FAST on page 106
[:SOURce<hw>]:BB:WLNN:SETTing:DELete on page 105

Data List Management…
Calls the "Data List Management" menu. This menu is used to create and edit a data
list.

All data lists are stored as files with the predefined file extension *.dm_iqd. The file
name and the directory they are stored in are user-definable.

The data lists must be selected as a data source from the submenus under the individ-
ual function, e.g. in the channel table of the cells.

Note: All data lists are generated and edited by means of the SOURce:BB:DM subsys-
tem commands. Files containing data lists usually end with *.dm_iqd. The data lists
are selected as a data source for a specific function in the individual subsystems of the
digital standard.

Example: Creating and editing the data list:
SOUR:BB:DM:DLIS:SEL 'd_list1'
SOUR:BB:DM:DLIS:DATA #B1111010101000001111....
SOUR:BB:DM:DLIS:DATA:APP #B1111010101000001111....

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA on page 128
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:DSELection on page 129

General Settings for WLAN Signals
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Generate Waveform File…
Calls the "Generate Waveform" menu. This menu is used to store the WLAN output
stream with "Baseband" destination as ARB signal in a waveform file.

This file can be loaded in the "ARB" menu and processed as multi carrier or multi seg-
ment signal.

The file name is entered in the submenu. The file is stored with the predefined file
extension *.wv. The file name and the directory it is stored in are user-definable.

Remote command: 
[:SOURce<hw>]:BB:WLNN:WAVeform:CREate on page 106

Transmission Bandwidth
Selects the transmission bandwidth.

If the system bandwidth is set to 20 MHz, all invalid configurations in the frame blocks
table are set to the default values.

Remote command: 
[:SOURce<hw>]:BB:WLNN:BWidth on page 103

Transmit Antennas Setup
Calls the menu for configuring the TX antennas.

The menu is described in Chapter 3.2, "Transmit Antenna Setup", on page 26.

Remote command: 
n.a.

Frame Block Configuration
Calls the menu for configuring the frame blocks.

The menu is described inChapter 3.3, "Frame Block Configuration", on page 28 .

Remote command: 
n.a.

Filter/Clipping Settings
Calls the menu for setting baseband filtering and clipping. The current setting is dis-
played next to the button.

The filter settings are enabled for configuration only for se Transmission Bandwidth t to
20 MHz.

The menu is described in Chapter 3.9, "Filter/Clipping Settings", on page 84.

Remote command: 
n.a.

Trigger/Marker
(Trigger for R&S SMx and R&S AMU instruments only)

Calls the menu for selecting the trigger source, for configuring the marker signals and
for setting the time delay of an external trigger signal (see Chapter 3.10, "Trigger/
Marker/Clock Settings", on page 88.

The currently selected trigger source is displayed to the right of the button.

General Settings for WLAN Signals
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Remote command: 
n.a.

Execute Trigger
(R&S SMx and R&S AMU instruments only)

Executes trigger manually.

A manual trigger can be executed only when an internal trigger source and a trigger
mode other than "Auto" have been selected.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:EXECute on page 113

Clock
(R&S SMx and R&S AMU instruments only)

Calls the menu for selecting the clock source and for setting a delay (see Chapter 3.10,
"Trigger/Marker/Clock Settings", on page 88).

Remote command: 
n.a.

3.2  Transmit Antenna Setup

Access:

► Select "Main Menu > Transmit Antennas Setup".

This dialog is used to map the generated Tx chains to different destinations ("Base-
band A/B", "File" or "OFF") and makes it possible to combine different Tx antenna
signals.

Settings

Antennas ...................................................................................................................... 27
Mapping Coordinates ................................................................................................... 27
Transmission Antenna Table.........................................................................................27

Transmit Antenna Setup



WLAN User InterfaceIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

27Operating Manual 1178.6985.02 ─ 23

└ Output ............................................................................................................ 27
└ Real/Magnitude ..............................................................................................27
└ Imaginary/Phase ............................................................................................28

Antennas
Selects the number of transmit antennas to be used.

Remote command: 
[:SOURce<hw>]:BB:WLNN:ANTenna:MODE on page 125

Mapping Coordinates
Selects the coordinate system of the transmission chain matrix.

"Cartesian" Sets the Cartesian coordinates system ("Real", "Imaginary").

"Cylindrical" Sets the cylindrical coordinates system ("Magnitude", "Phase").

Remote command: 
[:SOURce<hw>]:BB:WLNN:ANTenna:SYSTem on page 125

Transmission Antenna Table
Configures the output matrix and transmission chain matrix coefficients.

During signal calculation, the R&S Signal Generator evaluates the transmission chain
matrix and takes into account the set phase ratios. However, the power ratio of the
antennas is not considered.

To generate a WLAN signal of antennas with different power level, set the power level
of the corresponding path to the desired level in the header display of the instrument.

Output ← Transmission Antenna Table
Selects the destination of the calculated IQ chains.

"OFF" No mapping takes place.

"Baseband A/B"
The IQ chain is output to the selected baseband. Exactly one output
stream can be mapped to a baseband.

"File" The IQ chain is saved in a file.

Remote command: 
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:DESTination
on page 125
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:FSELect
on page 125

Real/Magnitude ← Transmission Antenna Table
Enters the value of the real or the magnitude coordinates.

Remote command: 
For "Cartesian" mapping coordinates:
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:REAL on page 126
For "Cylindrical" mapping coordinates:
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:MAGNitude
on page 127

Transmit Antenna Setup
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Imaginary/Phase ← Transmission Antenna Table
Enters the value of the imaginary or the phase coordinates.

Remote command: 
For Cartesian mapping coordinates:
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:IMAGinary
on page 126
For "Cylindrical" mapping coordinates:
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:PHASe on page 126

3.3  Frame Block Configuration

Access:

► Select "Main Menu > Frame Block Configuration".

This tab comprises the settings to select and configure a frame block.

Settings

Standard........................................................................................................................29
Type ............................................................................................................................. 30
Physical Mode ..............................................................................................................30
Tx Mode ....................................................................................................................... 30
Frames ......................................................................................................................... 32
Idle Time / ms ...............................................................................................................32
Data ..............................................................................................................................32
Boost /dB ......................................................................................................................33
PPDU ........................................................................................................................... 33
Data Rate/Mbps ........................................................................................................... 33
State .............................................................................................................................33
Append .........................................................................................................................33
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Insert ............................................................................................................................ 33
Delete ...........................................................................................................................34
Copy .............................................................................................................................34
Paste ............................................................................................................................ 34

Standard
Selects the IEEE 802.11 WLAN standard. After you have set your standard only the
settings for this standard relevant "Type", "Physical Mode" and "Tx Mode" are availa-
ble, see Table 3-1.
Table 3-1: Availability "Standard", "Type", "Physical Mode", "TxMode"

Standard Type Physical mode Txmode

User all all all

11a/g Data/ Beacon/ Trigger Legacy L-20MHz

   L-Duplicate

   L-Upper

   L-Lower

11b/g Data/ Beacon/ Trigger Legacy CCK

   PBCC

11p/j Data/ Beacon/ Trigger Legacy L-10MHz

11n Data/ Sounding/Beacon/
Trigger

Mixed Mode/ Green
Field

HT-20MHz

   HT-40MHz

   HT-Duplicate

   HT-Upper

   HT-Lower

11ac Data/ Sounding/ Beacon/
Trigger

Mixed Mode VHT-20MHz

   VHT-40MHz

   VHT-80MHz

   VHT-80 + 80 MHz

    

11ax Data/ Trigger Mixed Mode HE-20MHz

HE-40MHz

HE-80MHz

HE-80 + 80MHz

 

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STANdard on page 131

Frame Block Configuration
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Type
Selects the PPDU type.

"Data" Only "Data Long Training" fields are used to probe the channel.

"Sounding" Staggered preambles are used to probe additional dimension of the
MIMO channel.
"Type > Sounding" is not available for "Physical Mode > Legacy".

"Beacon" A frame of type "Beacon" contains all the information about a net-
work, for example the beacon interval, capability information and the
IBSS parameter set. The access point (AP) of a service set periodi-
cally transmits the beacon frame to establish and maintain the net-
work.

"Trigger" A downlink trigger frame is generated to synchronize the transmission
of a DUT's trigger-based uplink frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TYPE on page 132

Physical Mode
Selects the preamble design.

For "Physical Mode > Legacy", only "Type > Data" is available.

For 80 MHz transmission bandwidth and "Type > Data", you can only operate in "Phys-
ical Mode > Mixed Mode".

Note: "Physical Mode > Mixed Mode" transmissions can be detected by a physical
layer transceiver of 802.11a/g OFDM, MAC FCS would however fail.

"Legacy" Compatible with 802.11a/g OFDM devices. Also, CCK/PBCC frames
as defined in IEEE 802.11b/g are supported.
This mode applies to "Cylindrical" mapping coordinates.

"Mixed Mode" For High Throughput (HT), Very High Throughput (VHT) , High Effi-
ciency (HE) and 802.11a/g OFDM devices.

"Green Field" For HT networks only.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PMODe on page 130

Tx Mode
Sets the Tx mode.

The available Tx modes depend on the physical mode (see table below).

Type Physical
mode

Tx mode Transmission bandwidth

20 MHz 40 MHz 80 MHz 160 MHz

Data/ Trigger Legacy L-10MHz X X X X

L-20MHz X X X X

L-Duplicate - X X X

L-Upper - X X X

L-Lower - X X X

Frame Block Configuration
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Type Physical
mode

Tx mode Transmission bandwidth

20 MHz 40 MHz 80 MHz 160 MHz

CCK X X X X

PBCC X X X X

Data/ Trigger Mixed Mode HT-20MHz X X X X

HT-40MHz - X X X

HT-Duplicate - X X X

HT-Upper - X X X

HT-Lower - X X X

VHT-20MHz X X X X

VHT-40MHz - X X X

VHT-80MHz - - X X

VHT-80+80MHz - - X X

VHT-160MHz - - - X

HE-20MHz x x x x

HE-40MHz - x x x

HE-80MHz - - x x

HE-80 + 80MHz - - x x

HE-160MHz - - - x

Data Green Field HT-20MHz X X X X

HT-40MHz - X X X

HT-Duplicate - X X X

HT-Upper - X X X

HT-Lower - X X X

Sounding Mixed Mode HT-20MHz X X X X

HT-40MHz - X X X

HT-Duplicate - X X X

HT-Upper - X X X

HT-Lower - X X X

VHT-20MHz X X X X

VHT-40MHz - X X X

VHT-80MHz - - X X

VHT-80+80MHz - - X X

VHT-160MHz - - - X
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Type Physical
mode

Tx mode Transmission bandwidth

20 MHz 40 MHz 80 MHz 160 MHz

Sounding Green Field HT-20MHz X X X X

HT-40MHz - X X X

HT-Duplicate - X X X

HT-Upper - X X X

HT-Lower - X X X

Beacon Legacy L-10MHz X X X X

L-20MHz X X X X

L-Duplicate - X X X

L-Upper - X X X

L-Lower - X X X

CCK X X X X

PBCC X X X X

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TMODe on page 131

Frames
Sets the number of frames to be transmitted in the current frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:FCOunt on page 128

Idle Time / ms
Sets the time interval separating two frames in this frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ITIMe on page 130

Data
Selects the data source.

For "Std > 11ax", only the "A-MPDU" data source is available.

The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.

Frame Block Configuration
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– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to
select an existing data list.

– Use the "New" and "Edit" functions to create internally new data list or to edit
an existing one.

– Use the standard "File Manager" function to transfer external data lists to the
instrument.

See also "Main Dialog > Data List Management".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA on page 128
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:PATTern on page 129
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:DSELection on page 129

Boost /dB
Assigns a specific RMS power boost/attenuation to the corresponding frame block
modulation.

The power level of a frame block modulation is calculated as sum of the power boost
and the power level set in the header of the instrument.

Note: At least one frame block should have a power boost set to 0 dB value, so that
the gated power mode functionality works properly.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BOOSt on page 128

PPDU
Calls the dialog for PPDU configuration of the frame blocks.

The dialog is described in Chapter 3.4, "PPDU Configuration", on page 34.

Remote command: 
n.a.

Data Rate/Mbps
Indicates the PPDU data rate.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE? on page 130
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DATA:RATE? on page 137

State
Enables the corresponding frame block for transmission.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STATe on page 131

Append
Adds a default frame block behind the selected frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock:APPend on page 103

Insert
Adds a default frame block before the selected frame block.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert on page 103

Delete
Deletes the selected frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete on page 104

Copy
Copies the selected frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY on page 103

Paste
Pastes the copied frame block behind the selected frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe on page 104

3.4  PPDU Configuration

In the "PPDU Configuration" dialog, the PPDU configuration for all frames in the
selected frame block is done. The parameters available for configuration depend on
the selected "Type", "Physical Layer" and "Tx Mode".

The figure below shows the settings of the "PPDU Configuration" for "Type > Sounding
" and "Physical Mode > Green Field".

PPDU Configuration
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The following figure shows the parameters for a configuration of the "Type > Data" in
"Physical Mode > Mixed Mode", and "Multi User MIMO" function.

PPDU Configuration
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The figure below shows the parameters of a "PPDU Configuration" for "Physical Mode
> Legacy" and "Tx Mode > CCK/PBCC".

PPDU Configuration
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Settings

● General Settings..................................................................................................... 37
● HE Configuration Settings.......................................................................................42
● User Configuration.................................................................................................. 47
● Data Settings...........................................................................................................50
● Header Settings...................................................................................................... 53

3.4.1  General Settings

Access:

1. Select "Frame Blocks > PPDU > Config...".

2. Select "General".

The dialog comprises the settings for the configuration of the stream settings, the
modulation and coding scheme and also the PSDU bit rate. The parameters availa-
ble for configuration depend on the selected "Type", "Physical Layer" and "Tx
Mode".

Settings

● Stream Settings.......................................................................................................38
● User Settings...........................................................................................................39
● Modulation and Coding Scheme Settings...............................................................40
● CCK/PBCC Settings................................................................................................41

PPDU Configuration
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3.4.1.1  Stream Settings

Access:

1. Select "Frame Blocks > PPDU > Config...".

2. Select "General > Stream Settings".

Provided are the following settings:

Spatial Streams ............................................................................................................38
Space Time Streams ....................................................................................................38
Extended Spatial Streams ............................................................................................38
Multi User MIMO .......................................................................................................... 38
Segment .......................................................................................................................38
Space Time Block Coding ............................................................................................39

Spatial Streams
Enters the number of the spatial streams. For "Physical Mode > Legacy", only the
value 1 is valid. For "Tx Mode > HT-Duplicate", only the value 1 is valid. In all other
cases, the number of spatial streams depends on the number of antennas configured
in the "TX Antenna Setup" window.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SSTReam on page 147

Space Time Streams
Enters the number of the space time streams. This value depends on the setting in the
"Spatial Streams" field. Changing the number of the spatial streams immediately
changes the value of the "Space Time Streams" to the same value.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STSTream on page 148

Extended Spatial Streams
Enters the value of the extended spatial streams. This field is active for "Type > Sound-
ing" only to probe additional dimensions of the channel.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ESSTream on page 139

Multi User MIMO
Activates multi user MIMO. This function applies to "Spatial Streams">1.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MUMimo:STATe on page 140

Segment
(available only for "Tx Mode > VHT-80+80 MHz")

In "Tx Mode > VHT-80+80 MHz", one of the two segments can be selected with trans-
mission bandwidth 80 MHz or 160 MHz. Both segments can be only generated with
bandwidth 160 MHz.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SEGMent on page 146

Space Time Block Coding
Displays the status of the space time block coding.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STBC:STATe? on page 147

3.4.1.2  User Settings

Access:

1. In the "Frame Blocks" dialog, select "Std. > 11ac".

2. Open the "PPDU > Conf.." dialog.

3. Select "Spatial Streams " > 2.

4. Select "Multi User MIMO > ON".

This section contains the parameters for selecting and configuring signal genera-
tion of multiple users.

Settings

User Index.....................................................................................................................39
Multi User MIMO Settings Table....................................................................................39

User Index
Defines the currently generated user. For "Multi User MIMO > Active", only one user
can be generated at a time. This parameter selects the generated one out of four avail-
able users.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:UINDex on page 149

Multi User MIMO Settings Table
Sets the user-defined parameters for all available users.
● User index

A maximum of four users are supported
● N_STS

Number of space time streams for each user
● Group ID

Group ID for each user

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:NSTS on page 141
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:GID on page 141
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3.4.1.3  Modulation and Coding Scheme Settings

Access:

1. Select "Frame Blocks > PPDU > Config...".

2. Select "General > MCS Configuration".

Settings

MCS ............................................................................................................................. 40
Data Rate/Mbps ........................................................................................................... 40
Data Bits Per Symbol ................................................................................................... 40
Stream n .......................................................................................................................40
Channel Coding ........................................................................................................... 40
Encoders ...................................................................................................................... 41
Cod Rate ...................................................................................................................... 41
Guard ........................................................................................................................... 41
DCM ............................................................................................................................. 41

MCS
Selects the modulation and coding scheme for all spatial streams.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MCS on page 140
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MCS on page 140

Data Rate/Mbps
Indicates the PPDU data rate.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE? on page 130
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DATA:RATE? on page 137

Data Bits Per Symbol
Displays the number of data bits sent by an OFDM symbol on all spatial streams.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:BPSymbol? on page 136
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DATA:BPSymbol?
on page 136

Stream n
Selects the modulation used for the selected spatial stream.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MODulation<st> on page 140
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MODulation<st>
on page 140

Channel Coding
Selects the channel coding.
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"Off" No channel coding is used.

"BCC" Binary convolution code

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:TYPE on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:CODing:TYPE
on page 135

Encoders
Displays the number of encoders to be used. This value depends on the data rate. For
data rate ≤ 300 mps, this value is 1. Otherwise, the number of encoders is 2.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:ENCoder? on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:CODing:ENCoder?
on page 135

Cod Rate
Selects the coding rate.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:RATE on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:CODing:RATE
on page 135

Guard
Selects which guard interval is used for the OFDM guard.

For "Physical Mode > Green Field/Legacy", the field is read-only, since the modes
have long guard intervals only.

The values "0.8µs", "1.6 µs" and "3.2 µs" are available only for "Std.> 11ax".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:GUARd on page 139

DCM
Available only for "MCS > 0/1/3/4"

Indicates the use of dual carrier modulation (DCM) for a HE data field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:DCM on page 136

3.4.1.4  CCK/PBCC Settings

In this dialog, the "PSDU Bit Rate (OFDM)" can be set.

Settings

PSDU Bit Rate ............................................................................................................. 42
PSDU Modulation .........................................................................................................42
Barker Spreading ......................................................................................................... 42
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PSDU Bit Rate
(available only for "Tx Mode > CCK/PBCC")

Selects the bit rate of the PSDU.

The data rates available are 1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps and 22 Mbps. The
1 Mbps data rate is only available if the long PLCP format has been selected. The
selection of the data rate also determines the possible modulation modes.

The following table shows the correlation between data rate and modulation.

Data rate Possible modulation mode

1 Mbps Barker sequence (DBPSK)

the information data sequence is spread with an 11-chip Barker
sequence, chip rate is 11 Mcps

2 Mbps Barker sequence (DQPSK)

the information data sequence is spread with an 11-chip Barker
sequence, chip rate is 11 Mcps

5.5 Mbps CCK (DQPSK) or PBCC (BPSK)

11 Mbps CCK (DQPSK) or PBCC (QPSK)

22 Mbps PBCC (8PSK)

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BRATe on page 143

PSDU Modulation
(available only for "Tx Mode > CCK/PBCC")

Indicates the modulation type.

The modulation type is determined by the selected PSDU "Bit Rate".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:MODulation? on page 144

Barker Spreading
Requires "Tx Mode > CCK/PBCC".

Activates/deactivates barker spreading (bit rates 1 Mbps or 2 Mbps only).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BSPReading:STATe on page 144

3.4.2  HE Configuration Settings

This chapter describes the HE configuration settings for 802.11ax.

● HE General Settings .............................................................................................. 43
● Additional HE-SIG-A-Fields.....................................................................................45
● Logging................................................................................................................... 47
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3.4.2.1  HE General Settings

Contains the general HE settings like "Link direction", "PPDU Format" and the settings
for the "HE-SIG A fields".

Settings

Link Direction................................................................................................................ 43
Guard ........................................................................................................................... 43
Max PE Duration........................................................................................................... 43
Time Domain Windowing Active ...................................................................................43
Beam change................................................................................................................ 44
PPDU Format................................................................................................................44
HE-LTF Symb Duration................................................................................................. 44
Cur PE Duration............................................................................................................ 44
Right 106-Tone RU........................................................................................................44
Transition Time .............................................................................................................44
SIG-B DCM................................................................................................................... 45
SIG-B MCS................................................................................................................... 45
Preamble Puncturing.....................................................................................................45

Link Direction
Selects the link direction.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:LINK on page 151

Guard
Selects which guard interval is used for the OFDM guard.

For "Physical Mode > Green Field/Legacy", the field is read-only, since the modes
have long guard intervals only.

The values "0.8µs", "1.6 µs" and "3.2 µs" are available only for "Std.> 11ax".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:GUARd on page 139

Max PE Duration
Selects the maximum packet extension (PE) duration.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAXPe on page 152

Time Domain Windowing Active
Activates/deactivates the time domain windowing.

Time domain windowing is a method to influence the spectral characteristics of the sig-
nal, which is not stipulated by the standard. However, it does not replace oversampling
and subsequent signal filtering.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TDWindowing:STATe on page 148
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Beam change
Requires "PPDU Format > HE SU/HE SU EXT".

If enabled, the beam is changed between pre-HE and HE modulated fields. The pre-
HE fields are: L-STF, L-LTF, L-SIG, RL-SIG, HE-SIG-A, HE-SIG-A-R, and HE-SIG-B
fields. The HE modulated fields are: HE-STF, HE-LTF and data fields.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BCHG on page 149

PPDU Format
Selects the PPDU format.

"HE SU" HE SU (single-user) carries a single PSDU. The HE signal A (HE-
SIG-A) field is not repeated.

"HE MU" HE MU (multi-user) carries multiple PSDUs to one or more users.

"HE SU EXT" Carries a single PSDU. The HE-SIG-A field is repeated.
This format is only transmitted in 20 MHz channel bandwidths. It is
intended for a user who is further away from the access point (AP).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PFORmat on page 152

HE-LTF Symb Duration
Selects the duration of the HE long training field (LTF).The symbol duration value does
not include the guard interval. The values available are 3.2 μs (1x LTF), 6.4 μs (2x
LTF), and 12.8 μs (4x LTF) LTF symbol durations.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SYMDuration on page 154

Cur PE Duration
Displays the current PE duration for all users. The possible values are 0 μs, 4 μs, 8 μs,
12 μs and 16 μs.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CURPe? on page 151

Right 106-Tone RU
Available only for "Tx Mode > HE-20MHz" and "PPDU Format > HE SU EXT".

If enabled, indicates that the right 106-tone RU is within the primary 20 MHz.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:RIGHt106tone on page 146

Transition Time
Sets the transition time when "Time Domain Windowing > Active".

The transition time defines the overlap range of two OFDM symbols. At a setting of 100
ns and if BW = 20 MHz, one sample overlaps.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TTIMe on page 148
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SIG-B DCM
Enables the use of dual carrier modulation (DCM) in a signal B field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BDCM on page 150

SIG-B MCS
Selects the modulation and coding scheme (MCS) for the signal B field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BMCS on page 150

Preamble Puncturing
Requires "Tx Mode > HE-80MHz/HE-80+80MHz" and "PPDU Format > HE MU".

Enables preamble puncturing of the HE MU PPDU in 80 MHz or (80+80)/160 MHz
channels.

If enabled, preambles of specific 20 MHz subchannels are not transmitted.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PPUNcturing:STATe on page 153

3.4.2.2  Additional HE-SIG-A-Fields

The signal A field provides information about how to interpret the HE PPDUs.

Settings

BSS Color..................................................................................................................... 45
TXOP Duration..............................................................................................................45
Spatial Reuse................................................................................................................46
Doppler..........................................................................................................................46
pre-FEC Padding Factor............................................................................................... 46
PE Disambiguity............................................................................................................46
Preamble Puncturing Bandwidth...................................................................................46

BSS Color
Sets the BSS color, an identifier of the basic service sets (BSS) field. This parameter
helps to check if a detected frame is coming from an overlapping station.

If a WLAN station detects an 802.11ax frame, it checks the BSS color. The station
compares the color result to the color that was announced by the access point (AP). If
the BSS colors match, the frame is treated as intra-BSS. If the BSS colors mismatch,
the wireless station considers the frame as inter-BSS.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BSSColor on page 150

TXOP Duration
If transmission opportunity (TXOP) is set to 127, it indicates no duration information. If
it is set to any other value, it indicates duration information for network allocation vector
(NAV) parameter and that the TXOP is protected.

PPDU Configuration



WLAN User InterfaceIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

46Operating Manual 1178.6985.02 ─ 23

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TXOPduration on page 154

Spatial Reuse
Indicates if the spatial reuse is allowed (value set to 1) or not (value set to 0).

The spatial reuse is a method of the 802.11ax standard that aims to improve network
performance in dense deployments.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SPAReuse<st> on page 154

Doppler
If enabled, the Doppler effect is used for the PPDU.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DOPPler on page 151

pre-FEC Padding Factor
Displays the pre forward error condition (FEC) padding factor used in the trigger
PPDU.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PFPFactor? on page 153

PE Disambiguity
Displays the disambiguity in the number of symbols occurring due to the packet exten-
sion.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PED? on page 152

Preamble Puncturing Bandwidth
Requires "Preamble Puncturing > On".

Sets the bandwidth mode of preamble puncturing.

If enabled, the preamble part of the 20/40 MHz subchannel(s) is punctured, i.e. this
part is not transmitted (see Table 3-2).

Use enabled preamble puncturing, when you want to simulate channel allocation in
highly deployed access point or station scenarios.
Table 3-2: Bandwidth modes of preamble puncturing for HE-80MHz/80+80MHz PPDUs

Bandwidth
mode

HE channel Primary

20 MHz

Secondary

20 MHz

Secondary

40 MHz low

Secondary

40 MHz high

Secondary

80 MHz

4 80 MHz Unpunctured Punctured Unpunctured Unpunctured -

5 80 MHz Unpunctured Unpunctured Punctured Unpunctured -

 80 MHz Unpunctured Unpunctured Unpunctured Punctured -

6 80+80 MHz Unpunctured Punctured Unpunctured Unpunctured Unpunctured

7 80+80 MHz Unpunctured Unpunctured Punctured Punctured Unpunctured

 80+80 MHz Unpunctured Unpunctured Unpunctured Punctured Unpunctured
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Bandwidth
mode

HE channel Primary

20 MHz

Secondary

20 MHz

Secondary

40 MHz low

Secondary

40 MHz high

Secondary

80 MHz

 80+80 MHz Unpunctured Unpunctured Punctured Unpunctured Unpunctured

 80+80 MHz Unpunctured Unpunctured Unpunctured Unpunctured Unpunctured

"4,5" Sets the bandwidth mode for "Tx Mode > HE-80MHz" channels.

"6,7" Sets the bandwidth mode for "Tx Mode > HE-80+80MHz" channels.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PPUNcturing:STATe on page 153

3.4.2.3  Logging

This tab includes the setting for configuring a logging state.

Settings

Logging State................................................................................................................ 47
Output File.....................................................................................................................47

Logging State
If enabled, the contents of HE-SIG-A and HE-SIG-B fields and the payload are written
into a file in text form.

When the 802.11 standard is active ("General > State > On"), the file is saved into the
file path as specified in "Output File".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:LOGGing on page 152

Output File
Displays the fixed file path including the file name, in that the log file is saved.

The file name consists of the digital standard "wlan" and the selected frame block. For
example, the file wlan_fb7 has logging data of frame block 7.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:LOGFile? on page 151

3.4.3  User Configuration

This chapter describes the user configuration settings for 802.11ax. For more informa-
tion on the settings, you can also refer to the white paper 1MA222: IEEE 802.11ax
Technology Introduction.

Since multiple users are intended recipients in the OFDMA downlink, the AP needs to
tell the STAs which resource unit belongs to them. In 802.11ax, the AP uses the
HESIG- B field in the HE_MU_PPDU for this purpose.

The SIG-B contains two fields:
● Common field, where RU allocation info is included.
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● User-specific field, where per-STA info belongs.

In the "User Configuration" dialog, you can define the different settings of the SIG-B
fields.

Settings

1st/2nd Content Channel.............................................................................................. 48
└ RU Selection...................................................................................................48
└ Number of MU-MIMO users............................................................................48
└ Center 26-tone RU..........................................................................................48

User Config................................................................................................................... 49
└ STA Id............................................................................................................. 49
└ Nsts.................................................................................................................49
└ RU Type..........................................................................................................49
└ MU MIMO........................................................................................................49
└ Gain / dB.........................................................................................................49
└ TxBF............................................................................................................... 49
└ PPDU..............................................................................................................49
└ State................................................................................................................49

1st/2nd Content Channel
Available only for "PPDU Format > HE MU/HE TRIG".

Defines the settings of the common field of the HE-SIG-B field. For "Tx Mode > HE-20
MHz ", only the 1st content channel is available.

RU Selection ← 1st/2nd Content Channel
Selects the RU allocation subfield of the HE-SIG-B common block field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH1:RUSelection<st> on page 155
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH2:RUSelection<st> on page 155

Number of MU-MIMO users ← 1st/2nd Content Channel
Sets the number of MU-MIMO users. This value depends on the RU selection and the
number of spatial streams. It configures the yyy/zzz value of the RU allocation subfield.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH1:MUNum<st> on page 156
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH2:MUNum<st> on page 155

Center 26-tone RU ← 1st/2nd Content Channel
Available only for "PPDU Format > HE MU/HE TRIG", and "Tx Mode > HE-80MHz/
HE-80+80MHz".

For full bandwidth 80 MHz: if enabled, indicates that center 26 -tone RU is allocated
in the common block fields of both SIGB content channels with same value.

For full bandwidth 80+80 MHz: if enabled, indicates that center 26 -tone RU is alloca-
ted for one individual 80 MHz in common block fields of both SIGB content channels.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CENRu<st> on page 156

PPDU Configuration



WLAN User InterfaceIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

49Operating Manual 1178.6985.02 ─ 23

User Config
In this table, you can define settings of the user-specific part of the HE-SIG-B field.

STA Id ← User Config
Sets the station ID, the 11 least significant bits of the association identifier (AID).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:STAid on page 157

Nsts ← User Config
Sets the number of space time streams allocated to a particular user.

If "Space time stream" is greater than 1 and "Number of MU-MIMO users" is also
greater than 1, RUs of size 106 subcarriers or larger can accommodate more than one
user. The "Nsts" setting allocates a portion of the available space time streams to a
particular user.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:NSTS on page 156

RU Type ← User Config
Displays the resource unit type for each user.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:RUTYpe? on page 157

MU MIMO ← User Config
Displays if the MU-MIMO is used for current user. All MU-MIMO users share the same
RU using different space time streams.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:MUMimo:STATe?
on page 156

Gain / dB ← User Config
Sets the additional gain that can be applied to the RU allocated by a particular user.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:GAIN on page 156

TxBF ← User Config
If enabled, indicates that the beamforming matrix is applied to the waveform.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:TXBF on page 157

PPDU ← User Config
Opens a dialog for configuring the PPDU.

State ← User Config
Sets the state of the respective user.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:STATe on page 157
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3.4.4  Data Settings

The dialog comprises the settings for the configuration of the data.

Settings

Data Length ..................................................................................................................50
Scrambler .....................................................................................................................50
Ch. Bandwidth in Non HT .............................................................................................51
Interleaver Active ......................................................................................................... 51
Time Domain Windowing Active ...................................................................................51
Default PN Seed........................................................................................................... 51
Number Of Data Symbols ............................................................................................ 52
Scrambler Init (hex) ......................................................................................................52
Dyn. Bandwidth in Non HT ...........................................................................................52
Service Field (hex) ....................................................................................................... 52
Transition Time .............................................................................................................52
Service Field Clock Bit ................................................................................................. 53
PLCP P+H Format ....................................................................................................... 53
PN Seed........................................................................................................................53

Data Length
Sets the size of the data field in bytes.

For "Data Length" = 0, no data field is generated for the case of a sounding frame.

The maximum data length depends on the physical mode:
● In "Physical Mode > Legacy", the maximum value is 4061 bytes.
● In "Physical Mode > Mixed Mode" and "Physical Mode > Green Field", the maxi-

mum value is 1048575 bytes.
The data length is related to the number of data symbols. Whenever the data length
changes, the number of data symbols is updated and vice versa.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:LENGth on page 137
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DATA:LENGth
on page 137

Scrambler
Selects the different options for the scrambler.

"OFF" The scrambler is deactivated.

"On (Random Init)"
(not available for "Tx Mode > CCK/PBCC"
The scrambler is activated.
The initialization value of the scrambler is selected at random. Each
frame has a different random initialization value. This value is also dif-
ferent if there is successive recalculations with the same setting
parameters so that different signals are generated for each calcula-
tion.
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"On (User Init)" (not available for "Tx Mode > CCK/PBCC")
The scrambler is activated.
The initialization value of the scrambler is set to a fixed value that is
entered in the "Scrambler Init (hex)". This value is then identical in
each generated frame.

"ON" (available only for "Tx Mode > CCK/PBCC")
The scrambler is activated.

"Preamble
Only"

(available only for "Tx Mode > CCK/PBCC")
The scrambler is activated.
Only the preamble is scrambled.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:MODE on page 145
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:SCRambler:MODE
on page 145

Ch. Bandwidth in Non HT
(available only for "Tx Mode > VHT")

This parameter is used to modify the first 7 bits of the scrambling sequence to indicate
the duplicated bandwidth of the PPDU.

"NON_HT20 | 40 | 80"
Indicates 20 MHz, 40MHz, 80MHz or 80+80 MHz channel bandwidth
of the transmitted packet.

"Not present" Channel bandwidth in non HT is not present.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CBINonht on page 134

Interleaver Active
Activates/deactivates the interleaver of the data field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ILEaver:STATe on page 139
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:ILEaver:STATe
on page 139

Time Domain Windowing Active
Activates/deactivates the time domain windowing.

Time domain windowing is a method to influence the spectral characteristics of the sig-
nal, which is not stipulated by the standard. However, it does not replace oversampling
and subsequent signal filtering.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TDWindowing:STATe on page 148

Default PN Seed
Requires "Data > PNxx" set as the data source.

Activates the default PN seed. The seed is used initially to generate the pseudo-ran-
dom noise sequence.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DPNSeed:STATe
on page 138

Number Of Data Symbols
Sets the number of data symbols per frame block.

If the number of OFDM data symbols is changed, the generator calculates the data
field length as a function of the set PPDU bit rate. This value is displayed at "Data
Length".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:SYMBols on page 138

Scrambler Init (hex)
Enters the initialization value for "Scrambler >User". This value is then identical in each
generated frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:PATTern on page 146
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:SCRambler:PATTern
on page 146

Dyn. Bandwidth in Non HT
(available only for "Tx Mode > VHT")

If present, this parameter is used to modify the first 7 bits of the scrambling sequence
to indicate if the transmitter supports "Static" or "Dynamic" bandwidth operation.

"Not present" Dynamic bandwidth in non HT is not present.

"Static" The transmitter supports static bandwidth operation.

"Dynamic" The transmitter supports dynamic bandwidth operation.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DBINonht on page 138

Service Field (hex)
Enters the value of the service field. The standard specifies a default value of 0. Other
values can be entered in hexadecimal form for test purposes or future extensions.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SERVice:PATTern on page 146
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:SERVice:PATTern
on page 146

Transition Time
Sets the transition time when "Time Domain Windowing > Active".

The transition time defines the overlap range of two OFDM symbols. At a setting of 100
ns and if BW = 20 MHz, one sample overlaps.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TTIMe on page 148
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Service Field Clock Bit
(available only for "Tx Mode > CCK/PBCC")

Sets the locked clock bit in service field of the PLCP header.

Via this flag (bit), the transmitter indicates whether transmission frequency and symbol
rate have been derived from the same oscillator. If so (locked), the bit is set to 1, other-
wise (not locked) to 0.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:LCBit:STATe on page 142

PLCP P+H Format
(available only for "Tx Mode > CCK/PBCC")

Selects the packet type (PPDU format) with long or short PLCP (physical layer conver-
gence protocol).

Depending on the selected format, the structure, modulation and data rate of the PLCP
the preamble and the header are modified.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:FORMat on page 142

PN Seed
Requires "Default PN Seed > Off".

Sets the PN seed, a 24 bit value in hexadecimal representation. Use this setting, if you
don't use the default PN seed.

The maximum PN seed value is internally limited by the length of the used shift regis-
ter. E.g. "Data > PN 9" has 9 bit resolution for and limits the PN seed to 1FF.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:PNSeed on page 143

3.4.5  Header Settings

This dialog comprises the settings for the configuration of the header.

Settings

Preamble/Header Active .............................................................................................. 53
Smoothing .................................................................................................................... 54
Partial AID (hex) ...........................................................................................................54
No TXOP PS ................................................................................................................ 54
Configure MAC Header and FCS .................................................................................54
Spatial Mapping ........................................................................................................... 54

Preamble/Header Active
Activates/deactivates the preamble and signal fields of the frames in the current frame
block.

For "Type > Sounding", the preamble and signal field are always activated and cannot
be deactivated.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PREamble:STATe on page 143

Smoothing
(available for all except "Tx Mode > VHT")

Indicates to the receiver whether frequency-domain smoothing is recommended as
part of channel estimation.

"On" Indicates that channel estimate smoothing is recommended.

"Off" Indicates that only per-carrier independent channel (unsmoothed)
estimate is recommended.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMOothing on page 147

Partial AID (hex)
(available only for "Tx Mode > VHT")

Provides an abbreviated indication of the intended recipient(s) of the frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PAID:PATTern on page 142

No TXOP PS
(available only for "Tx Mode > VHT")

Indicates whether the VHT access point (AP) allows VHT non-AP stations (STAs) in
transmit opportunity (TXOP) power save mode to enter during TXOP.

"On" Indicates that the VHT AP allows VHT non-AP STAs to enter doze
mode during a TXOP.

"Off" Indicates that the VHT AP does not allow VHT non-AP STAs to enter
doze mode during a TXOP.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:NTPS on page 141

Configure MAC Header and FCS
Calls the menu of the MAC Header and FCS Configuration to configure the MAC of
each frame in this frame block.

The menu is described in Chapter 3.6, "MAC Header and FCS Configuration for Frame
Block", on page 56.

Remote command: 
n.a.

Spatial Mapping
Calls the menu for spatial mapping to configure the spatial mapping to be used for the
selected frame block. The menu is described in Chapter 3.8, "Spatial Mapping",
on page 81.

Remote command: 
n.a.
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3.5  A-MPDU Settings

This chapter describes the aggregate mac protocol data unit (A-MPDU) settings.

1. To access this dialog select "IEEE 802.11... > Frame Block Configuration...".

2. Select "Type > Data".

3. Select "Data > A-MPDU".

4. Select "DList/Pattern > Config".

The "A-MPDU Config" dialog opens.

This dialog comprises the A-MPDU settings.

Settings

Number of MPDUs........................................................................................................ 55
A-MPDU Length............................................................................................................ 55
EOF...............................................................................................................................55
Data Length / bytes ...................................................................................................... 56
Data...............................................................................................................................56
DList / Pattern............................................................................................................... 56

Number of MPDUs
Determines the number of MPDUs in the frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:COUNt on page 158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU:COUNt on page 158

A-MPDU Length
Indicates the overall A-MPDUs length, resulting from the "Data Length / bytes" settings
of all MPDUs.

Remote command: 
n.a.

EOF
Selects the EOF value.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:EOF on page 160
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU:EOF on page 160

Data Length / bytes
Determines the size of the data field in bytes.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:LENGth on page 159
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:LENGth
on page 159

Data
Selects the data source.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:SOURce on page 159
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:SOURce
on page 159

DList / Pattern
Depending on the selected data source, selects a data list or allows entering a user
defined bit pattern.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:DSELection
on page 158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:
DSELection on page 158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:PATTern on page 159
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:
PATTern on page 159

3.6  MAC Header and FCS Configuration for Frame Block

In the real IEEE 802.11 system, a MAC (medium access control) header is transmitted
in the PPDU before the actual data section. This header comprises the control informa-
tion of the MAC layer. It is also possible to protect the PPDU by a frame checksum.
These two functions can be controlled in the dialog.
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The dialog comprises the "MAC Header" and "MAC Frame Control Field" settings.

Settings

● MAC Header and FCS............................................................................................ 57
● 802.11 MAC Frame Field........................................................................................ 58
● Beacon Settings......................................................................................................62
● Trigger Frame Settings........................................................................................... 67

3.6.1  MAC Header and FCS

MAC Header
Activates/deactivates the generation of the MAC header for the PPDU. If the MAC
header is activated, all MAC header fields are enabled for operation.

The individual fields of the MAC header are described in the following.

All values of the MAC fields (except addresses) are entered in hexadecimal form with
least significant bit (LSB) in right notation. In the data stream, the values are output
standard-conformal with the LSB coming first.

Note: IEEE 802.11ac requires an A-MPDU frame aggregation. Therefore, when gener-
ating a IEEE 802.11ac signal you have to set "IEEE 802.11... > Frame Blocks> Data >
A-MPDU".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:STATe on page 166
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:STATe on page 166

FCS (checksum)
Activates/deactivates the calculation of the FCS (frame check sequence). The stan-
dard defines a 32-bit (4-byte) checksum to protect the MAC header and the user data
(frame body).
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCS:STATe on page 164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCS:STATe
on page 164

3.6.2  802.11 MAC Frame Field

The MAC frame control field is used to define the protocol version, the frame type, sub
type, and its function, etc.

Frame Control

Enters the value of the frame control field.

The MAC frame control field has a length of 2 bytes (16 bits) and is used to define the
protocol version, the frame type, sub type, and its function, etc. As an alternative, the
individual bits can be set in the lower part of the graph.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol on page 162
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PVERsion on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TYPE on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:SUBType on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TDS on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:FDS on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MFRagments
on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:RETRy on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PMANagement
on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MDATa on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:WEP on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:ORDer on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol
on page 162
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:
PVERsion on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:TYPE
on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:SUBType
on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:TDS
on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:FDS
on page 163
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:
MFRagments on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:RETRy
on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:
PMANagement on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:MDATa
on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:WEP
on page 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:ORDer
on page 163

Duration Id
Enters the value of the duration ID field.

Depending on the frame type, the 2-byte field "Duration/ID" is used to transmit the
association identity of the station transmitting the frame. Or it indicates the duration
assigned to the frame type.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:DID on page 162
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:DID on page 162

MAC Address
Enters the value of the address fields 1 ... 4.

The MAC header can contain up to four address fields, but not all must be available.
Each of the 4 address fields can be activated or deactivated. The fields are used for
transmitting the basic service set identifier, the destination address, the source
address, the receiver address and the transmitter address. Each address is 6 bytes (48
bit) long. The addresses can be entered in hexadecimal form in the entry field of each
address field. The LSB is in left notation.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st>:STATe on page 161
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:ADDRess<st>:
STATe on page 161

SA (hex)
(available only for "Physical Mode > Beacon")

Enters the value of the source address (SA) field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SA on page 164

BSSID (hex)
(available only for "Physical Mode > Beacon")

Enters the value of the basic service set identification (BSSID) field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:BSSid on page 162
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Sequence Control
Activates/deactivates the sequence control field.

The sequence control field has a length of 2 bytes and is divided in two parts, the frag-
ment number (4 bits) and the sequence number (12 bits) field. A long user data stream
to be transmitted is first split up into MSDUs (MAC service data units). The MSDUs can
either be transmitted as PSDU frames or further divided into fragments.

The sequence number and the fragment number are then used to number the individ-
ual subpackets of the user data stream to be transmitted. Thus, all PSDUs are
assigned a consecutive number. The assignment allows the receiver to arrange the
data packets in the correct order. It also allows the receiver to determine whether an
incorrectly transmitted packet was retransmitted and to find out whether packets are
missing.

If the receiver can detect a packet without an error and does not request a retransmis-
sion, the sequence number is incremented by 1 for each packet (the field is reset to 0
at the latest after a count of 4095). The fragment number field is incremented by 1
when another fragment of the current MPDU is transmitted. The start count for the
transmission (normally 0) and the number of packets required to increment the corre-
sponding counter can be defined for both numbers. This is done with the parameters
"Start Number" and "Incremented every ... packet(s)".

Example: 
An error-free transmission of 50 packets (no packet retransmission) is to be simulated.
The sequence number should be incremented by 1 for each packet. Since no packet is
fragmented, the fragment counter can always remain at 0. In this case the following
values have to be set:

If it is to be simulated that some packets are received incorrectly or if the response of
the receiver should be tested when the same packet arrives several times, the number
of packets required to increment the sequence number can be set to 2, for example.
Each packet will then automatically be sent twice (with identical data).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:STATe on page 166
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:STATe
on page 166

Start Number ← Sequence Control
Sets the start number of the fragment bits or the sequence bits of the sequence con-
trol.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:STARt
on page 165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:STARt
on page 166
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:
FRAGment:STARt on page 165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:
SEQuence:STARt on page 166

Increment Every ← Sequence Control
Defines the number of packets required to increment the counter of the fragment bits
or the sequence bits of the sequence control.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:INCRement
on page 165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:INCRement
on page 165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:
FRAGment:INCRement on page 165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:
SEQuence:INCRement on page 165

HT Config
Calls the menu for configuring the MAC high throughput (HT).

Note: Only the"Physical Modes > Mixed Mode " or "Physical Modes > Green Field
" (QoS data frames) provide the HT or VHT transmission technology. For "Physical
Modes > Legacy ", this configuration field is not indicated.
The dialog is described in Chapter 3.7, "MAC Header HT/HE and VHT Configuration",
on page 72.

Remote command: 
n.a.

Frame Body
Indicates the length of the user data (frame body).

Remote command: 
n.a.

FCS
Indicates the length of the check sum.

Remote command: 
n.a.
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3.6.3  Beacon Settings

A beacon frame is a management frame that contains all the information about a net-
work. The beacon settings are used to define the timestamp, the beacon interval, the
SSID, the supported rate etc. They also comprise the capability information and the
ERP parameters.

Access:

► Select "IEEE 802.11 > Frame Block Configuration > Beacon > Config... > Configure
Beacon Frame...".

The dialog comprises the beacon settings.

Settings

● General Beacon Functions......................................................................................62
● Capability Information Parameters..........................................................................63
● ERP Parameters..................................................................................................... 65
● HT Capability Information........................................................................................66

3.6.3.1  General Beacon Functions

The section provides general beacon settings.

Settings

Timestamp (hex)........................................................................................................... 63
Beacon Interval............................................................................................................. 63
SSID..............................................................................................................................63
Supported Rates........................................................................................................... 63
DSSS(Current Channel)................................................................................................63
IBSS(ATIM Window) (hex)............................................................................................ 63
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Timestamp (hex)
Updates the local clock of a station (the timing synchronization function (TSF) of a
frames' source) after receiving a beacon frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:TSTamp
on page 181

Beacon Interval
Defines the time interval between two beacon transmissions in ms.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:BINTerval
on page 180

SSID
Specifies the desired service set identifier (SSID) or the wildcard SSID. The maximal
allowed length is 32 characters.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SSID on page 181

Supported Rates
Contains the set of data rates supported by the AP, including indication which rates are
part of the BSSBasicRateSet.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SRATe on page 180

DSSS(Current Channel)
Indicates the current channel of this direct sequence spread spectrum (DSSS) net-
work.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:DCCHannel?
on page 180

IBSS(ATIM Window) (hex)
Contains the set of parameters necessary to support an independent basic service set
(IBSS). The information field contains the announcement traffic indication message
(ATIM) window parameter.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:IAWindow
on page 180

3.6.3.2  Capability Information Parameters

The section provides capability information settings.

The capability info parameters indicate, if requested optional capabilities and services
are allowed, supported or in use.
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For example if "DSSS-OFDM" is enabled the associated stations in the network is
informed that use of direct sequence spread spectrum - OFDM modulation (DSSS-
OFDM) is allowed.

Settings

Capability Information Parameters................................................................................64

Capability Information Parameters
Table 3-3: Functions of capability information parameters

Function
name

If enabled this function indicates that: SCPI command

"Immediate
Block Ack"

Immediate block Ack is allowed (suitable for high-
bandwidth, low latency traffic).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:IBACk
on page 183

"Delayed
Block Ack"

Delayed block Ack is allowed (delayed block Ack is
suitable for applications that tolerate moderate
latency).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:DBACk
on page 184

"DSSS-
OFDM"

Direct sequence spread spectrum - OFDM is allowed
(encodes packet data using the DSSS headers and
OFDM encoding of the payload).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:DOFDm
on page 184

"Radio Mea-
surement"

Radio measurement is supported (for example
requests, performs and reports radio measurements
in supported channels and provides information
about neighbor APs).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:RMEasurement
on page 185

"APSD" Automatic power save delivery (APSD) is supported
(energy saving function).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:APSD on page 182

"Short Slot
Time"

Short slot time is supported (reduces the slot time
resulting in higher throughput (used at IEEE802.11g).
The AP only uses short slot time when all clients
support short slot time).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:SSTime
on page 186

"QoS" Quality of service (QoS) is supported (takes care that
important applications always get enough band-
width).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:QOS on page 185
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Function
name

If enabled this function indicates that: SCPI command

"Spectrum
Mgmt"

Spectrum management is enabled (the process of
regulating the use of radio frequencies).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:SMGMt
on page 185

"Channel Agil-
ity"

Channel agility is enabled (overcomes some inherent
difficulty with a tone jammer).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:CAGility
on page 182

"PBCC" Packet binary convolutional coding (PBCC) is
allowed (a modulation mode for IEEE 802.11g).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:PBCC on page 184

"Short Pream-
ble"

Short preamble is allowed (uses 56 instead of 128
bits for the "sync" field. Created to improve WLAN
efficiency).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:SPReamble
on page 186

"Privacy" Privacy mode is enabled (thus encryption is required
for all data frames).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:PRIVacy
on page 184

"CF-Poll
Request"

Contention-free poll is requested (indicates how the
AP handles poll requests).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:CPRequest
on page 182

"CF Pollable" The node can use the point coordination function
(PCF), as opposed to the distributed coordination
function (DCF). PCF is a method of coordinating
wireless transmissions in which one station notifies
other stations when they can broadcast.

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:CPOLlable
on page 182

"IBSS" The network is an independent basic service set
(IBSS) type network. IBSS is an operation mode of a
WLAN. An IBSS does not need an AP. The wireless
clients directly connect with each other. This mode is
also named ad hoc mode.

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:IBSS on page 183

"ESS" The network is an extended service set (ESS) type
network (ESS is a set of connected BSSs. APs in an
ESS are connected by a distribution system. Each
ESS has an ID called the SSID which is a 32-byte
(maximum) character string).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:ESS on page 183

3.6.3.3  ERP Parameters

The section provides extended rate PHY (ERP) settings.

The ERP parameters indicate special features/modes.
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Settings

ERP Parameters........................................................................................................... 66

ERP Parameters

Function
name

If enabled this function indicates that: SCPI command

"Barker Pre-
amble Mode"

Associated stations have to use the long preamble (in
IEEE802.11g networks) . If all stations are capable of
short preambles, Barker Preamble Mode should be
disabled and all stations will use short preambles for
efficiency.

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:ERP:
BPMode on page 187

"Use Protec-
tion"

A station not IEEE802.11g-capable (usually stations
equipped with IEEE802.11b or IEEE802.11) is associ-
ated to the network and thus all stations have to
enable use protection.

"Use Protection" may be activated when "NonERP
Present" is activated.

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:ERP:
UPRotection on page 187

"NonERP
Present"

A non ERP station is present in the network. [:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:ERP:
NEPResent on page 187

3.6.3.4  HT Capability Information

The section provides HT capability information.

Settings

State..............................................................................................................................66
Green Field................................................................................................................... 66

State
Activates/ deactivates the HT capability information element.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:
STATe on page 186

Green Field
If enabled, the function indicates that the reception of PPDUs with HT Greenfield for-
mat is supported.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:
GFIeld on page 186
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3.6.4  Trigger Frame Settings

Access:

1. Select "IEEE 802.11 > Frame Blocks".

2. Set "Type > Trigger"

3. Select "PPDU > Config...".

4. Select "MAC Header & FCS".

The dialog comprises the trigger frame settings, including the setup of the common
info and user info fields.

Settings

● Common Info Field..................................................................................................67
● User Info Field.........................................................................................................70

3.6.4.1  Common Info Field

Includes the settings of the common info field.
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Settings

Trigger Type.................................................................................................................. 68
Length........................................................................................................................... 68
Cascade Indication........................................................................................................68
CS Required..................................................................................................................68
BW................................................................................................................................ 68
GI LTF........................................................................................................................... 69
MU-MIMO LTF Mode.....................................................................................................69
Num HE-LTF Symbols...................................................................................................69
STBC.............................................................................................................................69
LDPC Ext Symb Seg.....................................................................................................69
AP Tx Power................................................................................................................. 69
Packet Extension.......................................................................................................... 70
Spatial Reuse................................................................................................................70
Doppler..........................................................................................................................70
HE-SIG-A Reserved......................................................................................................70
Rsv................................................................................................................................ 70
Trigger Dependent Common Info..................................................................................70

Trigger Type
Specifies the type of trigger frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
TTYPe? on page 179

Length
Specifies the value of the L-SIG length field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:LEN
on page 178

Cascade Indication
If set to 1, then there is a subsequent trigger frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
CINDication on page 178

CS Required
If set to 1, the stations identified in the user field can sense the medium state and con-
sider the nav in determining if to respond or not.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
CSRequired on page 178

BW
Specifies the bandwidth. It can have the following values:
● 0: corresponds to a bandwidth of 20 MHz
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● 1: corresponds to a bandwidth of 40 MHz
● 2: corresponds to a bandwidth of 80 MHz
● 3: corresponds to a bandwidth of 80+80 MHz

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:BW
on page 178

GI LTF
Specifies the GI and HE-LTF. It can have the following values:
● 0: corresponds to a value of 1xLTF + 1.6µs GI
● 1: corresponds to a value of 2xLTF + 0.8µs GI
● 2: corresponds to a value of 2xLTF + 1.6µs GI
● 3: corresponds to a value of 4xLTF + 3.2µs GI

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:GILTf
on page 178

MU-MIMO LTF Mode
Specifies the LTF mode of the UL MU-MIMO.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
MLTFmode on page 178

Num HE-LTF Symbols
Specifies the number of HE-LTF symbols present.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
NHLSym on page 178

STBC
If set to 1, STBC encoding is used for the HE trigger-based PPDU response. Other-
wise the value is set to 0.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:STBC
on page 178

LDPC Ext Symb Seg
If set to 1, LDPC extra symbol is present. Otherwise the value is set to 0.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
LESSeg on page 178

AP Tx Power
Specifies the combined average power per 20 MHz bandwidth of all antennas that
transmitted the trigger frame.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:TXPow
on page 179

Packet Extension
Specifies the packet extension duration.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
PEXTension on page 178

Spatial Reuse
Specifies the value of the spatial reuse of the HE trigger-based PPDU transmitted as a
response to a trigger frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
SPAReuse on page 178

Doppler
Specifies a high doppler mode of transmission.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
DOPPler on page 178

HE-SIG-A Reserved
Specifies the value of the reserved bits in the HE-SIG-A field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:
HREServed on page 178

Rsv
Specifies the value of the reserved bits in the "Rsv" field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:RSV
on page 178

Trigger Dependent Common Info
The value of this field depends on the trigger variant. It is present for MU-BAR frame
formats.

Remote command: 
n.a.

3.6.4.2  User Info Field

Includes the settings of the user info field.
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Settings

No. Of User Info............................................................................................................ 71
User Info........................................................................................................................71
AID12............................................................................................................................ 71
RU allocation.................................................................................................................71
Coding Type.................................................................................................................. 71
MCS.............................................................................................................................. 71
DCM.............................................................................................................................. 72
SS Allocation.................................................................................................................72
Target RSSI...................................................................................................................72
Rsv................................................................................................................................ 72
Trigger Dependent User Info.........................................................................................72

No. Of User Info
Sets the number of "User Info" fields in the trigger frame.

You can set up to 37 fields.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:NUINfo
on page 179

User Info
"No. Of User Info = 1": Displays the "User Info = 0" field.

"No. Of User Info > 1": Selects the "User Info x" field, where "x = 1 to 36".

Remote command: 
n.a.

AID12
Carries the least significant 12 of the AID of the STA.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
AID on page 179

RU allocation
Specifies the RU used by the HE trigger-based PPDU of the STA, which is identified by
the "AID12" field value.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
RUALlocation on page 179

Coding Type
Specifies the code type. The value 0 indicates a BCC coding and 1 LDPC.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
CODType on page 179

MCS
Specifies the MCS.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
MCS on page 179

DCM
Specifies the dual carrier modulation. If the value is 0, then no DCM is used.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
DCM on page 179

SS Allocation
Specifies the spatial streams. This field contains 3 bits that specify the starting spatial
stream and 3 bits that specify the number of spatial streams.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
SSALlocation on page 179

Target RSSI
Specifies the target received signal power.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
TRSSi on page 179

Rsv
Specifies the value of the reserved bits in the "Rsv" field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
RSV on page 179

Trigger Dependent User Info
The value of this field depends on the trigger variant.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
TDUSerinfo on page 179

3.7  MAC Header HT/HE and VHT Configuration

The "HT/VHT Control Field" may be included in any frame except a non-QoS Data
frame. The presence of the HT/VHTcontrol field in frames carried in a HT/VHT PPDU is
indicated by setting the order bit in the MAC header. The HT/VHT Control Field
appears last in the MAC header, excluding any security fields.
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Figure 3-1: IEEE 802.11 WLAN: MAC header HT configuration window

Figure 3-2: IEEE 802.11 WLAN: MAC header VHT configuration window

Settings

● Common Settings....................................................................................................73
● MAC HT Configuration............................................................................................74
● MAC VHT Configuration..........................................................................................77
● MAC HE Configuration............................................................................................80

3.7.1  Common Settings

Provided are the following settings for enabling the MAC HT/VHT Control Field:

QoS Control ................................................................................................................. 73
HT/VHT/HE Control ......................................................................................................74

QoS Control
Control field (2 Bytes) with an embedded checkbox for activating the control mecha-
nism of Quality of Service (QoS) Data Frames.

The QoS solicits an acknowledgement policy from the receiver, according to specific
feedback rules. QoS control ensures a high level of transmission performance like high
bit rate, low latency or low bit error probability.

Information on contents of the QoS Control Data frame is for example duration request
field, TXOP limit, and AP Buffer State or queue size.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl:STATe on page 164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl on page 164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:QSControl
on page 164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:QSControl:STATe
on page 164

HT/VHT/HE Control
Enables HT/VHT/HE control and sets the HT/VHT/HE control field as hex value.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl on page 167
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl on page 172
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:STATe on page 171
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HTControl:STATe
on page 171
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HEControl
on page 177

3.7.2  MAC HT Configuration

The following functions describe the control field of the MAC HT configuration:

Settings

RDG/More PPDU ......................................................................................................... 74
AC Constraint ...............................................................................................................75
Reserved ......................................................................................................................75
NDP Announcement .................................................................................................... 75
CSI Steering .................................................................................................................75
Reserved ......................................................................................................................75
Calibration Sequence ...................................................................................................76
Calibration Position ...................................................................................................... 76
Link Adaption Control ...................................................................................................76
HT/VHT ........................................................................................................................ 77

RDG/More PPDU
The RDG/More signal field (LSB, 1 bit) issues the reverse direction grant. When trans-
mitted by an initiator or a responder, this field is interpreted differently.

Transmitted by initiator
0 = No reverse grant.

1 = A reverse grant is present, as defined by the Duration/ID field.

Transmitted by responder
0 = The PPDU carrying the MPDU is the last transmission by the responder.

1 = The PPDU carrying the frame is followed by another PPDU.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:RDGMore on page 170

AC Constraint
Indicates the access point of the responder (1 bit).

0 = The response may contain data from any traffic identifier (TID)

1 = The response may contain data only from the same AC as the last data received
from the initiator.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ACConstraint
on page 167

Reserved
This signal field (5 bit) is defined, but not used. It is set to zero by the transmitter and
ignored by the receiver.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:REServed
on page 171

NDP Announcement
The NDP announcement (1 bit) indicates that a null data packet (NDP) will be transmit-
ted after the frame.

0 = no NDP follows

1 = NDP follows

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:NDP on page 170
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ZLF on page 172

CSI Steering
Sets the position of the CSI feedback (2 bit)

00 = CSI

01 = uncompressed steering matrix

10 = compressed steering matrix

11 = reserved

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CSISteering
on page 168

Reserved
This signal field (2 bit) is defined, but not used.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:SREServed
on page 171
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:FREQuest
on page 169
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Calibration Sequence
Identifies the calibration sequence (2 bit). The field is included in each frame within the
calibration procedure. Its value remains unchanged during one calibration procedure
and is incremented each time a new calibration procedure starts.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:
SEQuence on page 168

Calibration Position
Sets the position in the Calibration Sounding Exchange sequence (2 bit):

00 = Not a calibration frame (Default setting)

01 = Calibration Start

10 = Sounding Response

11 = Sounding Complete

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:
POSition on page 168

Link Adaption Control
Sets the parameters of the link adaption control field. The following subfields enable
configuring the response signal of the link adaption.

B0 (1bit) MA - MA payload

When the MA (Management Action) field is set to 1, the payload of the QoS Null Data
MPDU (Medium Access Controller Protocol Data Unit) is interpreted as a payload of
the management action frame.

B1 (1bit) TRQ - Sounding Request

1 = Request to the responder to transmit a sounding PPDU (Physical layer Protocol
Data Unit).

B2 (1bit) MRQ - MCS Request

1 = Request for feedback of MCS (Modulation Coding Scheme).

B3-B5 (3bit) MRS - MRQ Sequence Identifier

Set by sender to any value in the range '000'-'110' to identify MRQ. = Invalid if MRQ =
0

B6-B8 (3bit) MFS - MFB Sequence Identifier

Set to the received value of MRS. Set to '111' for unsolicited MFB.

B9-B15 (7bit) MFB - MCS Feedback

Link adaptation feedback containing the recommended MCS. When a responder is
unable to provide MCS feedback or the feedback is not available, the MFB is set to 'all-
ones' (default value) and also MFS is set to '1'.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:LAControl
on page 169
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HT/VHT
The subfield indicates the used format (HT or VHT).

0 = indicates use of the HT format.

1 = indicates use of the VHT format.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:HVINdicator?
on page 169

3.7.3  MAC VHT Configuration

The following functions describe the control field of the MAC VHT configuration:

Settings

RDG/More PPDU ......................................................................................................... 77
AC Constraint ...............................................................................................................77
Unsolicited MFB ........................................................................................................... 78
FB Tx Type ...................................................................................................................78
Coding Type ................................................................................................................. 78
GID-H ........................................................................................................................... 78
MFB ..............................................................................................................................78
MFSI/GID-L .................................................................................................................. 79
MSI ...............................................................................................................................79
MRQ .............................................................................................................................79
Rsv ............................................................................................................................... 80
HT/VHT ........................................................................................................................ 80

RDG/More PPDU
The RDG/More signal field (LSB, 1 bit) issues the reverse direction grant. When trans-
mitted by an initiator or a responder, this field is interpreted differently.

Transmitted by initiator
0 = No reverse grant.

1 = A reverse grant is present, as defined by the Duration/ID field.

Transmitted by responder
0 = The PPDU carrying the MPDU is the last transmission by the responder.

1 = The PPDU carrying the frame is followed by another PPDU.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:RDGMore
on page 176

AC Constraint
Indicates the access point of the responder (1 bit).

0 = The response may contain data from any TID (Traffic Identifier)

1 = The response may contain data only from the same AC as the last data received
from the initiator.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:ACConstraint
on page 173

Unsolicited MFB
0 = if the MFB is a response to an MRQ.

1 = if the MFB is not a response to an MRQ.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:UMFB on page 176

FB Tx Type
0 = If the Unsolicited MFB subfield is set to 1 and FB Tx Type subfield is set to 0, the
unsolicited MFB refers to either an unbeamformed VHT PPDU or transmit diversity
using an STBC VHT PPDU.

1 = If the Unsolicited MFB subfield is set to 1 and the FB Tx Type subfield is set to 1,
the unsolicited MFB refers to a beamformed SU-MIMO VHT PPDU.

Otherwise this subfield is reserved.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:FTTYpe on page 173

Coding Type
If the Unsolicited MFB subfield is set to 1, the Coding Type subfield contains the Cod-
ing information (set to 0 for BCC and set to 1 for LDPC) to which the unsolicited MFB
refers.

0 = for BCC

1 = for LDPC

Otherwise this subfield is reserved.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:CTYPe on page 173

GID-H
If the Unsolicited MFB subfield is set to 1, the GID-H subfield contains the highest 3
bits of Group ID of the PPDU to which the unsolicited MFB refers.

Otherwise this subfield is reserved.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:GIDH on page 174

MFB
MFB subfield is interpreted as defined in Table 3-4. This subfield contains the recom-
mended MFB. The value of MCS=15 and VHT N_STS=7 indicates that no feedback is
present.

MAC Header HT/HE and VHT Configuration



WLAN User InterfaceIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

79Operating Manual 1178.6985.02 ─ 23

Table 3-4: MFB subfield in the VHT format HT control field

Subfield Meaning Definition

VHT
N_STS

Recommended VHT
NSTS

Indicates the recommended VHT NSTS (Link adaption using the
VHT format of the HT Control field).

MCS Recommended MCS
feedback

Indicates the recommended VHT MCS (Link adaption using the
VHT format of the HT Control field).

BW Bandwidth of the recom-
mended MCS

MFB = 1

If the unsolicited MFB subfield is set to 1, the BW subfield con-
tains the bandwidth of which the recommended MCS is intended
for (Link adaption using the VHT format of the HT Control field).
The BW subfield is set as follows:
● 0 for 20 MHz
● 1 for 40 MHz
● 2 for 80 MHz
● 3 for 80+80 MHz

MFB = 1

If the Unsolicited MFB subfield is set to 0, the BW subfield is
reserved and set to 0.

SNR Average SNR Indicates the average SNR, which is an SNR averaged over data
subcarriers and spatial streams (Link adaption using the VHT for-
mat of the HT Control field).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MFB on page 174

MFSI/GID-L
MFB = 0
If the Unsolicited MFB subfield is set to 0, the MFSI/GID-L subfield contains the
received value of MSI contained in the frame to which the MFB information refers.

MFB = 1
The MFSI/GID-L subfield contains the lowest 3 bits of Group ID of the PPDU to which
the unsolicited MFB refers.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MGL on page 175

MSI
MRQ = 0
When the MRQ subfield is set to 0, the MSI subfield is reserved.

MRQ = 1
When the MRQ subfield is set to 1, the MSI subfield contains a sequence number in
the range 0 to 6 that identifies the specific request.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MSI on page 175

MRQ
0 = to request MCS feedback (solicited MFB).

1 = otherwise.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MRQ on page 175

Rsv
This signal field (1 bit) is defined, but not used. It is set to zero by the transmitter and
ignored by the receiver.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:VREServed
on page 176

HT/VHT
The subfield indicates the used format (HT or VHT).

0 = indicates use of the HT format.

1 = indicates use of the VHT or HE format, depending on the value of the HE field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:HVINdicator?
on page 174
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:VHTControl:
HVINdicator? on page 169

3.7.4  MAC HE Configuration

The following functions describe the control field of the MAC HE configuration:

Settings

Aggregated control .......................................................................................................80
HE ................................................................................................................................ 80
HT/VHT ........................................................................................................................ 81

Aggregated control
Enters the value of the aggregated control (A-Control) field. This field consists of a
sequence of one or more control subfields.

A control subfield consists of a 4-Bit control ID subfield and a control information of a
variable size. The values are as defined in the 802.11ax amendment.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HEControl:
ACONtrol on page 177

HE
Indicates the use of the HE format, if "HT/VHT" is set to 1.

0 = indicates use of the VHT format.

1 = indicates use of the HE format.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HEControl:
HEINdicator? on page 177
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HT/VHT
The subfield indicates the used format (HT or VHT).

0 = indicates use of the HT format.

1 = indicates use of the VHT or HE format, depending on the value of the HE field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:HVINdicator?
on page 174
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:VHTControl:
HVINdicator? on page 169

3.8  Spatial Mapping

The WLAN standard IEEE 802.11 builds upon previous 802.11 standards by adding
MIMO (multiple-input multiple-output). MIMO uses multiple transmitter and receiver
antennas for increased data throughput via spatial multiplexing and increased range by
exploiting the spatial diversity. Mode, time shifts and transmit parameters are defined in
the "Spatial Mapping for Frame Block" dialog.

Spatial Mapping



WLAN User InterfaceIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

82Operating Manual 1178.6985.02 ─ 23

When loaded, the spatial mapping dialog shows the frame block number for which this
spatial mapping dialog is loaded. The transmit matrix corresponding to index k has NTX

rows (representing the number of transmit antennas) and NSTS columns (representing
the space time streams). The text label shows the spatial mapping mode selected in
the dialog which is updated whenever the mode changes. For "Physical Layer" >
"Sounding", a second submatrix horizontally sided to the transmit matrix with NTX rows
and NESS columns is used as a transmit matrix for the extended long training fields
(ELTF). The values displayed for the transmit matrices are also normalized (internally)
so that the expectation of IQ sum-power of all antennas is 0 dBr. Also for "OFF",
"Direct", and "Spatial Expansion", the expected IQ power is the same for all antennas
and hence these modes can be intermixed without caring about any power regulation
issue. Relative RMS levels are displayed in the dialog for each antenna.

Settings

Mode ............................................................................................................................ 82
Index k ..........................................................................................................................82
Time Shift ..................................................................................................................... 83
I (Transmit Matrix) ........................................................................................................ 83
Q (Transmit Matrix) ...................................................................................................... 83

Mode
Selects the spatial mapping mode for the selected frame block. The matrix element
values are loaded using Info Class Methods.

"Off" (available only for "Physical Mode > Legacy" frame)
The spatial mapping mode is switched off automatically.

"Direct" (available only for "Physical Mode > Mixed Mode" or "Physical Mode
> Green Field" when NTX = NSTS)
Sets the spatial mapping to "Direct" mode.
The transmit matrix is a CSD matrix, that is, a diagonal matrix of unit
magnitude and complex values that represent cyclic shifts in the time
domain.

"Indirect" (available only for "Physical Mode > Mixed Mode" or "Physical Mode
> Green Field" )
In indirect mode, the transmit matrix is the product of a CSD matrix
and the Hadamard unitary matrix.

"Spatial
Expansion"

Requires "Physical Mode > Mixed Mode" or "Physical Mode > Green
Field".
In spatial expansion mode, the transmit matrix is the product of a
CSD matrix and a square matrix formed of orthogonal columns, as
defined in the IEEE 802.11 specification.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:MODE on page 188

Index k
Sets the index of the subcarrier. A matrix is mapped to each subcarrier.

Except for k = 0, the index can be set in the following ranges:
● 20 MHz channel, e.g. HT-20 MHz: -32 ... 31

Spatial Mapping
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● 40 MHz channel, e.g. VHT-40 MHz: -64 ... 63
● 80 MHz channel, e.g. VHT-80 MHz: -128 ... 127
● 160 MHz channel, e.g. VHT-160 MHz: -256 ... 255

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:INDex on page 189

Time Shift
Sets the spatial mapping time shift. This value is relevant for spatial mapping mode
"Direct" and "Spatial Expansion" only.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:TSHift<st> on page 188

I (Transmit Matrix)
Displays the time shift value of element I of the selected row and column of the spatial
transmit matrix.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:I?
on page 189

Q (Transmit Matrix)
Displays the time shift value of element Q of the selected row and column of the spatial
transmit matrix.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:Q?
on page 189

Spatial Mapping
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3.9  Filter/Clipping Settings

Access:

► Select "Main dialog > Filter/Clipping Settings".

The dialog comprises the settings, necessary to configure the baseband filter and
to enable clipping.

3.9.1  Filter Settings

The dialog comprises the settings, necessary to configure the baseband filter.

Settings

Use Default Wlan Filter................................................................................................. 84
Filter.............................................................................................................................. 85
Roll Off Factor or BxT ...................................................................................................85
Cut Off Frequency Factor..............................................................................................85
Cut Off Frequency Shift ................................................................................................85
Sample Rate Variation ..................................................................................................86
IFFT Upsampling...........................................................................................................86

Use Default Wlan Filter
Requires "Transmission Bandwidth > 40 MHz" or higher.

Activates the WLAN default filter. The default filter setting is optimized to achieve best
possible EVM results while complying with the spectrum emission mask.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:DEFSetting:STATe on page 108

Filter/Clipping Settings
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Filter
Selects the baseband filter.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:TYPE on page 111

Roll Off Factor or BxT
Sets the roll-off factor

The rolloff factor affects the steepness of the filter slopes. A "Rolloff Factor = 0" results
in the steepest slopes; values near to 1 make the slopes more flat.

Figure 3-3: Example of the frequency response of a filter with different roll off factors

For the default cosine filter, a roll-off factor of 0.10 is used.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:APCO25 on page 109
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine on page 109
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:GAUSs on page 110
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:PGAuss on page 111
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:RCOSine on page 111
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:SPHase on page 111

Cut Off Frequency Factor
Sets the value for the cutoff frequency factor. The cutoff frequency of the filter can be
adjusted to reach spectrum mask requirements.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASs on page 110
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASSEVM on page 110

Cut Off Frequency Shift
Requires "Filter > Cosine".

The cutoff frequency is a filter characteristic that defines the frequency at the 3 dB
down point. The "Cut Off Frequency Shift" affects this frequency in the way that the fil-
ter flanks are "moved" and the transition band increases by "Cut Off Frequency
Shift"*"Sample Rate".
● A "Cut Off Frequency Shift" = -1 results in a very narrow-band filter
● Increasing the value up to 1 makes the filter more broad-band

Filter/Clipping Settings
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● By "Cut Off Frequency Shift" = 0, the -3 dB point is at the frequency determined by
the half of the selected "Sample Rate".

Tip: Use this parameter to adjust the cutoff frequency and reach spectrum mask
requirements.

Figure 3-4: Example of the frequency response of a filter with different cut off frequency shift

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine:COFS on page 109

Sample Rate Variation
Sets the sample rate of the signal.

A variation of this parameter only affects the ARB clock rate; all other signal parame-
ters remain unchanged. If the sampling rate in the frame configuration menu is
changed, this parameter is reset to the chosen sampling rate.

Remote command: 
[:SOURce<hw>]:BB:WLNN:SRATe:VARiation on page 112

IFFT Upsampling
Activates inverted Fast Fourier Transformation (IFFT) upsampling.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:IUPSampling on page 109

3.9.2  Clipping Settings

The dialog comprises the settings, necessary to configure the clipping.

Settings

Clipping State ...............................................................................................................86
Clipping Level................................................................................................................87
Clipping Mode .............................................................................................................. 87

Clipping State
Switches baseband clipping on and off.

Filter/Clipping Settings
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Baseband clipping is a simple and effective way of reducing the crest factor of the
WLAN signal.

WLAN signals can have high crest factors. High crest factors entail two basic prob-
lems:
● The nonlinearity of the power amplifier (compression) causes intermodulation

which expands the spectrum (spectral regrowth).
● Since the level in the D/A converter is relative to the maximum value, the average

value is converted with a relatively low resolution. This results in a high quantiza-
tion noise.

Both effects increase the adjacent-channel power.

With baseband clipping, all the levels are limited to a settable value ("Clipping Level").
This level is specified as a percentage of the highest peak value. Since clipping is done
before filtering, the procedure does not influence the spectrum. The EVM however
increases.

Since clipping the signal not only changes the peak value but also the average value,
the effect on the crest factor is unpredictable. The following table shows the effect of
the "Clipping" on the crest factor for typical scenarios.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLIPping:STATe on page 108

Clipping Level
Sets the limit for clipping.

This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLIPping:LEVel on page 107

Clipping Mode
Selects the clipping method. The menu provides a graphical illustration how the clip-
ping methods work.

"Vector | I + q |"
The limit is related to the amplitude | I + q |. The I and Q components
are mapped together, the angle is retained (see "Clipping State").

"Scalar | I | + | q |"
The limit is related to the absolute maximum of all the I and Q values |
I | + | q | .

The I and Q components are mapped separately, the angle changes.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLIPping:MODE on page 108

Filter/Clipping Settings
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3.10  Trigger/Marker/Clock Settings

The trigger, clock, and marker delay functions are available for R&S SMx and R&S
AMU instruments only.

To access this dialog, select "Main Menu > Trigger/Marker".

The "Trigger In" section is where the trigger for the signal is set. Various parameters
will be provided for the settings, depending on which trigger source - internal or exter-
nal - is selected. The current status of signal generation ("Running" or "Stopped") is
indicated for all trigger modes.

The "Marker Mode" section is where the marker signals at the [MARKER] output con-
nectors are configured.

The "Marker Delay" section is where a marker signal delay can be defined, either with-
out restriction or restricted to the dynamic section, i.e., the section in which it is possi-
ble to make settings without restarting signal and marker generation.

Trigger/Marker/Clock Settings
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The "Clock Settings" section is where the clock source is selected and - in the case of
an external source - the clock type.

The buttons in the last section lead to submenu for general trigger, clock and mapping
settings.

3.10.1  Trigger In

The trigger functions are available for R&S SMx and R&S AMU instruments only.

The Trigger In section is where the trigger for the IEEE 802.11 WLAN signal is set. The
current status of the signal generation is displayed for all trigger modes.

The "Trigger In" section is where the trigger for the signal is set. Various parameters
will be provided for the settings, depending on which trigger source - internal or exter-
nal - is selected. The current status of signal generation ("Running" or "Stopped") is
indicated for all trigger modes.

Trigger Mode
Selects trigger mode, i.e. determines the effect of a trigger event on the signal genera-
tion.
● "Auto"

The signal is generated continuously.
● "Retrigger"

The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal or exter-
nal) causes a restart.

● "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal or external)
causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".

Trigger/Marker/Clock Settings
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Every subsequent trigger event (internal or external) causes a restart.

Remote command: 
[:SOURce<hw>]:BB:WLNN[:TRIGger]:SEQuence on page 116

Signal Duration Unit
Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:SLUNit on page 115

Signal Duration
Enters the length of the signal sequence to be output in the "Single" trigger mode.

Use this parameter to output part of the signal deliberately, an exact sequence of the
signal, or a defined number of repetitions of the signal.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:SLENgth on page 114

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.
● "Running"

The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:RMODe? on page 114

Arm
Stops the signal generation until subsequent trigger event occurs.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:ARM:EXECute on page 113

Execute Trigger
Executes trigger manually. A manual trigger can be executed only when an internal
trigger source and a trigger mode other than "Auto" have been selected.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:EXECute on page 113

Trigger Source
Selects trigger source. This setting is effective when a trigger mode other than "Auto"
has been selected.
● "Internal"

The trigger event is executed by "Execute Trigger".
● "External (Trigger 1/2)"

The trigger event is the active edge of an external trigger signal, supplied at the
TRIGGER 1/2 connector.

Trigger/Marker/Clock Settings
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Use the "Global Trigger/Clock Settings" dialog to define the polarity, the trigger
threshold and the input impedance of the trigger signal.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:SOURce on page 115

Sync. Output to External Trigger
(enabled for Trigger Source External)

Enables/disables output of the signal synchronous to the external trigger event.

For R&S SMBV instruments:

For or two or more R&S SMBVs configured to work in a master-slave mode for syn-
chronous signal generation, configure this parameter depending on the provided sys-
tem trigger event and the properties of the output signal. See the table below for an
overview of the required settings.
Table 3-5: Typical Applications

System Trigger Application "Sync. Output to External Trig-
ger"

Common External Trigger event
for the master and the slave
instruments

All instruments are synchronous
to the external trigger event

ON

All instruments are synchronous
among themselves but starting
the signal from first symbol is
more important than synchronicity
with external trigger event

OFF

Internal trigger signal of the mas-
ter R&S SMBV for the slave
instruments

All instruments are synchronous
among themselves

OFF

"On" Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first sam-
ples are cut off and no signal is outputted. After elapsing of the inter-
nal processing time, the output signal is synchronous to the trigger
event.
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"Off" The signal output begins after elapsing of the processing time and
starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequences
with signal duration comparable with the processing time of the
instrument.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:EXTernal:SYNChronize:OUTPut
on page 114

Trigger Delay
Delays the trigger event of the signal from:
● The external trigger source
Use this setting to:
● Synchronize the instrument with the device under test (DUT) or other external devi-

ces

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal<ch>]:DELay on page 116

Trigger Inhibit
Sets the duration for inhibiting a new trigger event subsequent to triggering. The input
is to be expressed in samples.

In the "Retrigger" mode, every trigger signal causes signal generation to restart. This
restart is inhibited for the specified number of samples.

This parameter is only available on external triggering.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal<ch>]:INHibit on page 116

3.10.2  Marker Mode

The marker output signal for synchronizing external instruments is configured in the
Marker settings section "Marker Mode".

The R&S SMBV supports only two markers.
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Marker Mode
Selects a marker signal for the associated MARKER output.

"Restart" A marker signal is generated at the start of each signal sequence
(period = all frame blocks).

"Frame Block" Number of Frame Blocks = 1, that is, a marker signal is generated at
the start of each frame block. Otherwise a specific frame block index
is given and the whole frame block is marked.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FBINdex on page 119

"Frame" Number of Frame Blocks = 1, that is, a marker signal is generated at
the start of each frame in the single frame block. Otherwise, the
frame block and frame index are entered and the specific frame is
masked.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FINDex on page 119
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"Frame Active Part / Frame Inactive Part"
A marker signal is generated to mark every active part of each frame.
The active data transfer part (PPDU) of a frame period is marked with
high, the inactive part (idle time) with low. This marker can be used to
decrease the carrier leakage during inactive signal parts by feeding it
into the pulse modulator.
Otherwise, the frame block and frame index are entered and the
active part of the specific frame is masked.
The parameters "Rising Edge Shift / Falling Edge Shift" open when
"Frame Active Part" or "Frame Inactive Part" is selected.
They shift the rising/falling edge of the marker the specified number
of samples. Negative values result in a shift back of the marker edge.

Figure 3-5: "Frame active Part" marker and shifting of its rising/falling edges

1 = Marker shift rising edge
2 = Marker shift falling edge

Figure 3-6: "Frame Inactive Part" marker and shifting of its rising/falling edges

1 = Marker shift rising edge
2 = Marker shift falling edge
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Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FESHift on page 119
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:RESHift on page 120

"Pulse" A regular marker signal is generated. The clock frequency is defined
by entering a divider. The frequency is derived by dividing the chip
rate by the divider. The input box for the divider opens when Pulse is
selected, and the resulting pulse frequency is displayed below it.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:DIVider on page 120
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:FREQuency?
on page 121

"Pattern" A marker signal that is defined by a bit pattern is generated. The pat-
tern has a maximum length of 32 bits and is defined in an input field
that opens when "pattern" is selected.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PATTern on page 120

"ON/OFF Ratio"
A regular marker signal that is defined by an ON/OFF ratio is gener-
ated. A period lasts one ON and OFF cycle.

The ON time and OFF time are each expressed as a number of chips
and are set in an input field which opens when ON/OFF ratio is
selected.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:ONTime on page 118
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:OFFTime on page 118

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:MODE on page 117

3.10.3  Marker Delay

The marker delay functions are available for R&S SMx and R&S AMU instruments
only.
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The delay of the signals on the [MARKER] outputs is set in the"Marker Delay" section.

The R&S SMBV supports only two markers.

Marker x Delay
Enters the delay between the marker signal at the marker outputs and the start of the
frame or slot.

Note: The input is expressed as a number of symbols/samples. If the setting "Fix
marker delay to dynamic range" is enabled, the setting range is restricted to the
dynamic range. In this range the delay of the marker signals can be set without restart-
ing the marker and signal.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay on page 121

Current Range without Recalculation
Displays the dynamic range within which the delay of the marker signals can be set
without restarting the marker and signal.

The delay can be defined by moving the setting mark.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MAXimum?
on page 122
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MINimum?
on page 122

Fix marker delay to current range
Restricts the marker delay setting range to the dynamic range. In this range the delay
can be set without restarting the marker and signal.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut:DELay:FIXed on page 121

3.10.4  Clock Settings

The clock functions are available for R&S SMx and R&S AMU instruments only.

The Clock Settings is used to set the clock source and a delay if required.

Sync. Mode
(for R&S SMBV only)

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of sev-
eral connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave one and between each two consecutive slave instruments must
have the same length and type.
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Avoid unnecessary cable length and branching points.

"None" The instrument is working in stand-alone mode.

"Sync. Master" The instrument provides all connected instrument with its synchroni-
sation (including the trigger signal) and reference clock signal.

"Sync. Slave" The instrument receives the synchronisation and reference clock sig-
nal from another instrument working in a master mode.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLOCk:SYNChronization:MODE on page 124

Set Synchronization Settings
(for R&S SMBV only)

Performs automatically adjustment of the instrument's settings required for the syn-
chronization mode, selected with the parameter "Sync. Mode".

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLOCk:SYNChronization:EXECute on page 123

Clock Source
Selects the clock source.

"Internal" The internal clock reference is used to generate the sample clock.

"External" The external clock reference is fed in as the sample clock or multiple
thereof via the CLOCK connector.
The sample rate must be correctly set to an accuracy of ( 2 % (see
data sheet).
The polarity of the clock input can be changed with the aid of "Global
Trigger/Clock Settings".

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLOCk:SOURce on page 123

Clock Mode
Enters the type of externally supplied clock.

"Sample" A sample clock is supplied via the [CLOCK] connector.

"Multiple Sample"
A multiple of the sample clock is supplied via the [CLOCK] connector;
the sample clock is derived internally from this.
The Multiplier window provided allows the multiplication factor to be
entered.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLOCk:MODE on page 122

Chip Clock Multiplier
Enters the multiplication factor for clock type Multiple.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLOCk:MULTiplier on page 123
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Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.

Remote command: 
CLOCk:INPut:FREQuency?

3.10.5  Global Settings

This section provides access general trigger, clock and mapping settings.

Global Trigger/Clock Settings
Accesses the "Global Trigger/Clock/Input Settings" dialog.

This dialog is to set the trigger threshold, the input impedance and the polarity of the
clock and trigger inputs.

The parameters in this dialog affect all digital modulations and standards, and are
described in chapter "Global Trigger/Clock/Input Settings" in the operating manual.

Trigger/Marker/Clock Settings



Remote-Control CommandsIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

99Operating Manual 1178.6985.02 ─ 23

4  Remote-Control Commands
The following commands are required to perform signal generation with the IEEE
802.11 WLAN options in a remote environment. We assume that the R&S Signal Gen-
erator has already been set up for remote operation in a network as described in the
R&S Signal Generator documentation. A knowledge about the remote control opera-
tion and the SCPI command syntax are assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S Signal Generator operating manual.

The SOURce:BB:WLNN subsystem contains commands for the primary and general
settings of the IEEE 802.11 WLAN standard. With these settings, you can activate the
standard, set the transmission direction, filter, clock, trigger and clipping settings and
do a preset.

The commands for defining the frame configuration for physical layer modes OFDM
and CCK/PBCC are described in the next section. The commands are divided up in
this way to make the comprehensive SOURce:BB:WLNN subsystem clearer.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> [1]|2 available baseband signals

OUTPut<ch> 1 .. 4 available markers

R&S SMBV supports two markers

EXTernal<ch> 1|2 external trigger connectors

FBLock<ch> [1]...100 available frame blocks

MPDU<st> 1...10 available MPDUs

Placeholder <root>

For commands that read out or save files in the default directory, the default directory
is set using command MMEM:CDIRectory. The examples in this description use the
place holder <root> in the syntax of the command.
● D:\ - for selecting the internal hard disk of a Windows instrument
● E:\ - for selecting the memory stick which is inserted at the USB interface of a

Windows instrument
● /var/user/ - for selecting the internal flash card of a Linux instrument
● /usb/ - for selecting the memory stick which is inserted at the USB interface of a

Linux instrument.
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Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, the tasks include:
● Managing settings and data lists, i.e. storing and loading settings, creating and

accessing data lists, accessing files in a particular directory, etc.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as configuring networks and remote opera-

tion
● Using the common status registers

For a description of such tasks, see the R&S Signal Generator operating manual.

The following commands specific to the IEEE 802.11 WLAN are described here:

● Programming Examples........................................................................................100
● General Commands..............................................................................................102
● Filter/Clipping Settings.......................................................................................... 107
● Trigger Settings..................................................................................................... 112
● Marker Settings..................................................................................................... 117
● Clock Settings....................................................................................................... 122
● Antenna Configuration Settings............................................................................ 124
● Frame Block Configuration....................................................................................127
● Frame Configuration Settings............................................................................... 133

4.1  Programming Examples

The following sections provide programming examples for the IEEE 802.11 Wlan
options.

The purpose of the examples is to present all commands for a given task. In real appli-
cations, one would rather reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the example
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument reset is recom-
mended to set the instrument to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

4.1.1  Trigger Settings

// ******************************************************************
// Configure trigger in automatic mode. 
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// ******************************************************************
SOURce1:BB:WLNN:TRIGger:SEQuence AUTo

/ ******************************************************************
// Alternatively configure trigger in retrigger mode, source
// internal. Start signal generation via executing the trigger.
// ******************************************************************
SOURce1:BB:WLNN:TRIGger:SEQuence RETR
SOURce1:BB:WLNN:TRIGger:SOURce INTernal
SOURce1:BB:WLNN:TRIGger:EXEcute

 ******************************************************************
// Alternatively configure trigger in armed retrigger mode, use 
// external global trigger. Enable synchronization output.
// Set inhibit duration, specify delay in samples.
// ******************************************************************
SOURce1:BB:WLNN:TRIGger:SEQuence ARET
SOURce1:BB:WLNN:TRIGger:SOURce EGT1
SOURce1:BB:WLNN:TRIGger:EXTernal:SYNChronize:OUTPut 1
SOURce1:BB:WLNN:TRIGger:EXTernal:INHibit 10
SOURce1:BB:WLNN:TRIGger:DELay:UNIT SAMP
SOURce1:BB:WLNN:TRIGger:EXTernal:DELay 25

/ ******************************************************************
// Alternatively set and query delay in seconds.
// ******************************************************************
SOURce1:BB:WLNN:TRIGger:DELay:UNIT TIME
SOURce1:BB:WLNN:TRIGger:EXTernal:TDELay 0.00001
SOURce1:BB:WLNN:TRIGger:EXTernal:RDELay?

// ******************************************************************
// Configure trigger in single mode. Set the output of
// the current waveform to the first sample after 
// the next trigger event. Execute the trigger.
// ******************************************************************
SOURce1:BB:WLNN:TRIGger:SEQuence SINGle
SOURce1:BB:WLNN:TRIGger:SLUNit SAMP
SOURce1:BB:WLNN:TRIGger:SLENgth 1
SOURce1:BB:WLNN:TRIGger:EXEcute

/ ******************************************************************
// Alternatively configure internal trigger in armed retrigger
// mode. Start signal generation via executing the trigger.
// Stop signal generation via arming the trigger.
// Execute the trigger again to restarts signal generation.
// ******************************************************************
SOURce1:BB:WLNN:TRIGger:SEQuence ARETrigger
SOURce1:BB:WLNN:TRIGger:SOURce INTernal
SOURce1:BB:WLNN:TRIGger:EXEcute
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SOURce1:BB:WLNN:TRIGger:ARM:EXECute
SOURce1:BB:WLNN:TRIGger:EXEcute

// ******************************************************************
// Query trigger signal generation status.
// ******************************************************************
SOURce1:BB:WLNN:TRIGger:RMODe?

4.1.2  Marker Settings

Example: Marker configuration
// ******************************************************************
// Query marker mode, set rising and falling offsets.
// ******************************************************************
SOURce:BB:WLNN:TRIGger:OUTPut2:MODE?
// RESTart
SOURce:BB:WLNN:TRIGger:OUTPut2:FOFFset 10
SOURce:BB:WLNN:TRIGger:OUTPut2:ROFFset 20

4.1.3  Clock Settings

This section is not relevant for R&S WinIQSIM2.

Example: Clock configuration
// ******************************************************************
// Select internal clock. 
// ******************************************************************
SOURce1:BB:WLNN:CLOCk:SOURce INTernal

4.2  General Commands

[:SOURce<hw>]:BB:WLNN:BWidth..................................................................................103
[:SOURce<hw>]:BB:WLNN:FBLock:APPend.....................................................................103
[:SOURce<hw>]:BB:WLNN:IFBLock................................................................................ 103
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert................................................................ 103
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY................................................................ 103
[:SOURce<hw>]:BB:WLNN:CFBLock...............................................................................103
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete.............................................................. 104
[:SOURce<hw>]:BB:WLNN:DFBLock...............................................................................104
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe................................................................104
[:SOURce<hw>]:BB:WLNN:PFBLock............................................................................... 104
[:SOURce<hw>]:BB:WLNN:PRESet.................................................................................104
[:SOURce<hw>]:BB:WLNN:SETTing:CATalog?................................................................. 104
[:SOURce<hw>]:BB:WLNN:SETTing:DELete.................................................................... 105
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[:SOURce<hw>]:BB:WLNN:SETTing:LOAD...................................................................... 105
[:SOURce<hw>]:BB:WLNN:SETTing:STORe.................................................................... 105
[:SOURce<hw>]:BB:WLNN:SETTing:STORe:FAST........................................................... 106
[:SOURce<hw>]:BB:WLNN:STATe................................................................................... 106
[:SOURce<hw>]:BB:WLNN:WAVeform:CREate.................................................................106

[:SOURce<hw>]:BB:WLNN:BWidth <BWidth>

The command selects the transmission bandwidth. Whenever the bandwidth changes
from a higher to a lower one, the frame blocks are validated because some of them
could be invalid in the lower bandwidth (invalid TX Mode).

Parameters:
<BWidth> BW20 | BW40 | BW80 | BW160

*RST: BW20
Default unit: MHz

Example: BB:WLNN:BW BW40
sets the transmission bandwidth to 40 MHz.

Manual operation: See " Transmission Bandwidth " on page 25

[:SOURce<hw>]:BB:WLNN:FBLock:APPend

Appends a frame block to the end of the frame blocks list.

Example: BB:WLNN:FBL:APP
Usage: Event

Manual operation: See " Append " on page 33

[:SOURce<hw>]:BB:WLNN:IFBLock <IfBlock>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert
The command adds a default frame block before the selected frame block.

Example: BB:WLNN:FBL2:INS
inserts a default frame block before the selected frame block.

Usage: Event

Manual operation: See " Insert " on page 33

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY
[:SOURce<hw>]:BB:WLNN:CFBLock <CfBlock>

Copies the selected frame block.

Setting parameters: 
<CfBlock> integer

Range: 1  to  100
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Example: BB:WLNN:CFBL 5
copies frame block 5 for later insertion.

Usage: Setting only

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete
[:SOURce<hw>]:BB:WLNN:DFBLock <DfBlock>

Deletes the selected frame block.

Setting parameters: 
<DfBlock> integer

Range: 1  to  100

Example: BB:WLNN:DFBL 10
deletes the selected frame block.

Usage: Setting only

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe
[:SOURce<hw>]:BB:WLNN:PFBLock <PfBlock>

Pastes the selected frame block.

Setting parameters: 
<PfBlock> integer

Range: 1  to  99

Example: BB:WLNN:PFBL 20
pastes the frame block to row 20.

Usage: Setting only

[:SOURce<hw>]:BB:WLNN:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:WLNN:STATe.

Example: SOURce:BB:WLNN:PRESet
Usage: Event

Manual operation: See " Set to default " on page 22

[:SOURce<hw>]:BB:WLNN:SETTing:CATalog?

Reads out the files with IEEE 802.11a/b/g/n/ac settings in the default directory. The
default directory is set using command MMEM:CDIRectory. Only files with the file
extension *.wlann will be listed.

Return values: 
<Catalog> string
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Example: MMEM:CDIR '<root>wlann'
Sets the default directory to <root>wlann.
BB:WLNN:SETT:CAT?
Reads out all the files with IEEE 802.11 settings in the default
directory.
Response: 'wlann_1','wlann_2'
The files ''wlann1' and 'wlann2'' are available.

Usage: Query only

Manual operation: See " Save/Recall " on page 23

[:SOURce<hw>]:BB:WLNN:SETTing:DELete <Filename>

Deletes the selected file with IIEEE 802.11a/b/g/n/ac settings. The directory is set
using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files
with the file extension *.wlann are listed and can be deleted.

Setting parameters: 
<Filename> string

Example: BB:WLNN:SETT:DEL 'wlann_1'
Deletes file 'wlann_1'.

Usage: Setting only

Manual operation: See " Save/Recall " on page 23

[:SOURce<hw>]:BB:WLNN:SETTing:LOAD <Filename>

Loads the selected file with IEEE 802.11 WLAN settings. The directory is set using
command MMEM:CDIRectory. A path can also be specified, in which case the files in
the specified directory are read. The file extension may be omitted. Only files with the
file extension *.wlann will be loaded.

Setting parameters: 
<Filename> string

Example: BB:WLNN:SETT:LOAD 'wlann_1'
Loads file 'wlann_1'.

Usage: Setting only

Manual operation: See " Save/Recall " on page 23

[:SOURce<hw>]:BB:WLNN:SETTing:STORe <Filename>

Stores the current IEEE 802.11a/b/g/n/ac settings into the selected file. The directory is
set using command MMEM:CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. Only the file name has to be entered. IEEE
802.11a/b/g/n/ac settings are stored as files with the specific file extensions *.wlann.
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Setting parameters: 
<Filename> string

Example: BB:WLNN:SETT:STOR 'wlann_1'
Stores the current settings into file 'wlann_1'.

Usage: Setting only

Manual operation: See " Save/Recall " on page 23

[:SOURce<hw>]:BB:WLNN:SETTing:STORe:FAST <Fast>

Determines whether the instrument performs an absolute or a differential storing of the
settings.

Enable this function to accelerate the saving process by saving only the settings with
values different to the default ones.

Note: This function is not affected by the "Preset" function.

Parameters:
<Fast> 0 | 1 | OFF | ON

*RST: 1

Manual operation: See " Save/Recall " on page 23

[:SOURce<hw>]:BB:WLNN:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:BB:WLNN:STATe ON
Activates the standard.

Manual operation: See " State " on page 21

[:SOURce<hw>]:BB:WLNN:WAVeform:CREate <Filename>

Creates a waveform using the current settings of the "WLAN" menu. The file name is
entered with the command. The file is stored with the predefined file extension *.wv.
The file name and the directory it is stored in are user-definable.

Setting parameters: 
<Filename> string

Example: MMEM:CDIR '<root>waveform'
Sets the default directory to <root>waveform.
BB:WLNN:WAV:CRE 'wlann_1'
Creates the waveform file wlann_1.wv in the default directory.
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Usage: Setting only

Manual operation: See " Generate Waveform File… " on page 25

4.3  Filter/Clipping Settings

[:SOURce<hw>]:BB:WLNN:CLIPping:LEVel......................................................................107
[:SOURce<hw>]:BB:WLNN:CLIPping:MODE.................................................................... 108
[:SOURce<hw>]:BB:WLNN:CLIPping:STATe.....................................................................108
[:SOURce<hw>]:BB:WLNN:FILTer:DEFSetting:STATe........................................................108
[:SOURce<hw>]:BB:WLNN:FILTer:IUPSampling................................................................109
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:APCO25.................................................... 109
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine......................................................109
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine:COFS............................................109
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:GAUSs.......................................................110
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASs........................................................110
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASSEVM................................................ 110
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:PGAuss......................................................111
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:RCOSine....................................................111
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:SPHase......................................................111
[:SOURce<hw>]:BB:WLNN:FILTer:TYPE...........................................................................111
[:SOURce<hw>]:BB:WLNN:SRATe?.................................................................................112
[:SOURce<hw>]:BB:WLNN:SRATe:VARiation....................................................................112

[:SOURce<hw>]:BB:WLNN:CLIPping:LEVel <Level>

Sets the limit for level clipping. This value indicates at what point the signal is clipped.
It is specified as a percentage, relative to the highest level. 100% indicates that clip-
ping does not take place.

Level clipping is activated if [:SOURce<hw>]:BB:WLNN:CLIPping:STATe is set to
ON.

Parameters:
<Level> integer

Range: 1 PCT  to  100 PCT
Increment: 1 PCT
*RST: 100 PCT

Example: BB:WLNN:CLIP:LEV 80PCT
Sets the limit for level clipping to 80% of the maximum level.
BB:WLNN:CLIP:STAT ON
Activates level clipping.

Manual operation: See "Clipping Level" on page 87
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[:SOURce<hw>]:BB:WLNN:CLIPping:MODE <Mode>

Sets the method for level clipping.

Parameters:
<Mode> VECTor | SCALar

VECTor
The reference level is the amplitude | i+jq |.
SCALar
The reference level is the absolute maximum of the I and Q val-
ues.
*RST: VECTor

Example: BB:WLNN:CLIP:MODE SCAL
Selects the absolute maximum of all the I and Q values as the
reference level.
BB:WLNN:CLIP:LEV 80PCT
Sets the limit for level clipping to 80% of this maximum level.
BB:WLNN:CLIP:STAT ON
Activates level clipping.

Manual operation: See " Clipping Mode " on page 87

[:SOURce<hw>]:BB:WLNN:CLIPping:STATe <State>

Activates level clipping (Clipping). The value is defined with [:SOURce<hw>]:BB:
WLNN:CLIPping:LEVel, the mode of calculation with [:SOURce<hw>]:BB:WLNN:
CLIPping:MODE.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:CLIP:STAT ON
Activates level clipping.

Manual operation: See " Clipping State " on page 86

[:SOURce<hw>]:BB:WLNN:FILTer:DEFSetting:STATe <UseDefaultFilte>

Activates the WLAN default filter settings.

Parameters:
<UseDefaultFilte> 0 | 1 | OFF | ON

*RST: 1

Example: SOURce1:BB:WLNN:FILTer:DEFSetting:STATe 1
Activates the WLAN default filter settings.

Manual operation: See "Use Default Wlan Filter" on page 84

Filter/Clipping Settings



Remote-Control CommandsIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

109Operating Manual 1178.6985.02 ─ 23

[:SOURce<hw>]:BB:WLNN:FILTer:IUPSampling <IFFTUpsampling>

Activates inverted Fast Fourier Transformation (IFFT) upsampling.

Parameters:
<IFFTUpsampling> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:BB:WLNN:FILTer:IUPSampling ON
Activates IFFT upsampling.

Manual operation: See "IFFT Upsampling" on page 86

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:APCO25 <Apco25>

Sets the roll-off factor for filter type APCO25.

Parameters:
<Apco25> float

Range: 0.05  to  0.99
Increment: 0.01
*RST: 0.2

Example: BB:WLNN:PAR:APCO25 0.2
Sets the roll-off factor to 0.2 for filter type APCO25.

Manual operation: See " Roll Off Factor or BxT " on page 85

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine <Cosine>

Sets the roll-off factor for the cosine filter type.

Parameters:
<Cosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.1

Example: BB:WLNN:PAR:COS 0.35
Sets the roll-off factor to 0.35 for filter type cosine.

Manual operation: See " Roll Off Factor or BxT " on page 85

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine:COFS <CoFs>

The command sets the "cut of frequency shift' value for the Cosine filter type.

Parameters:
<CoFs> float

Range: -1  to  1
Increment: 0.01
*RST: 0
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Example: BB:WLNN:FILT:PAR:COS:COFS 0.04
the "cut of frequency shift" value is set to 0.04.

Manual operation: See " Cut Off Frequency Shift " on page 85

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:GAUSs <Gauss>

Sets the roll-off factor for the Gauss filter type.

Parameters:
<Gauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: BB:WLNN:PAR:GAUS 0.5
Sets B x T to 0.5 for the Gauss filter type.

Manual operation: See " Roll Off Factor or BxT " on page 85

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASs <LPass>

Sets the cut off frequency factor for the Lowpass (ACP optimization) filter type.

Parameters:
<LPass> float

Range: 0.05  to  2
Increment: 0.01
*RST: 0.5

Example: BB:WLNN:FILT:PAR:LPAS 0.5
The cut of frequency factor is set to 0.5.

Manual operation: See "Cut Off Frequency Factor" on page 85

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASSEVM <LPassevm>

Sets the cut off frequency factor for the Lowpass (EVM optimization) filter type.

Parameters:
<LPassevm> float

Range: 0.05  to  2
Increment: 0.01
*RST: 0.5

Example: BB:WLNN:FILT:PAR:LPASSEVM 0.5
The cut of frequency factor is set to 0.5.

Manual operation: See "Cut Off Frequency Factor" on page 85
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[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:PGAuss <PGauss>

Sets the roll-off factor for the pure gauss filter type.

Parameters:
<PGauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: BB:WLLN:FILT:PAR:PGAUS 0.5
Sets B x T to 0.5 for the pure gauss filter type.

Manual operation: See " Roll Off Factor or BxT " on page 85

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:RCOSine <RCosine>

Sets the roll-off factor for the root cosine filter type.

Parameters:
<RCosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.22

Example: BB:WLNN:PAR:RCOS 0.22
Sets the roll-off factor to 0. 22 for filter type root cosine.

Manual operation: See " Roll Off Factor or BxT " on page 85

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:SPHase <SPhase>

Sets B x T for the Split Phase filter type.

Parameters:
<SPhase> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 2

Example: BB:WLNN:PAR:SPH 0.5
Sets B x T to 0.5 for the Split Phase filter type.

Manual operation: See " Roll Off Factor or BxT " on page 85

[:SOURce<hw>]:BB:WLNN:FILTer:TYPE <Type>

The command selects the filter type.
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Parameters:
<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |

COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape | LPASSEVM
*RST: Depends on layer mode

Example: BB:WLNN:FILT:TYPE COS
sets the filter type COSine.

Manual operation: See "Filter" on page 85

[:SOURce<hw>]:BB:WLNN:SRATe?

Displays the sample rate specific for the selected bandwidth ([:SOURce<hw>]:BB:
WLNN:BWidth).

Return values: 
<SampRate> float

20MHz for BW20, 60MHz for BW40.

Usage: Query only

[:SOURce<hw>]:BB:WLNN:SRATe:VARiation <Variation>

Sets the sample rate of the signal.

Parameters:
<Variation> float

Range: 400  to  40000000
Increment: 0.001
*RST: 20000000
Default unit: Hz (c/s)

Example: BB:WLNN:SRAT:VAR 4000000
Sets the output sample rate to 4 MHz.

Manual operation: See " Sample Rate Variation " on page 86

4.4  Trigger Settings

EXTernal<ch>
The numeric suffix to EXTernal<ch> distinguishes between the external trigger via
the [TRIGGER 1] (suffix 1) and [TRIGGER 2] (suffix 2) connector.
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Example: Configure and enable triggering
SOURce1:BB:WLNN:TRIGger:SOURce INT
SOURce1:BB:WLNN:TRIGger:SEQuence ARETrigger
SOURce1:BB:WLNN:STAT ON
SOURce1:BB:WLNN:TRIGger:EXEcute
// executes a trigger, signal generation starts
SOURce1:BB:WLNN:TRIGger:ARM:EXECute
// signal generation stops
SOURce1:BB:WLNN:TRIGger:EXEcute
// executes a trigger, signal generation starts again

[:SOURce<hw>]:BB:WLNN:TRIGger:ARM:EXECute..........................................................113
[:SOURce<hw>]:BB:WLNN:TRIGger:EXECute..................................................................113
[:SOURce<hw>]:BB:WLNN:TRIGger:EXTernal:SYNChronize:OUTPut.................................114
[:SOURce<hw>]:BB:WLNN:TRIGger:RMODe?..................................................................114
[:SOURce<hw>]:BB:WLNN:TRIGger:SLENgth.................................................................. 114
[:SOURce<hw>]:BB:WLNN:TRIGger:SLUNit.....................................................................115
[:SOURce<hw>]:BB:WLNN:TRIGger:SOURce.................................................................. 115
[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal<ch>]:DELay.............................................. 116
[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal<ch>]:INHibit.............................................. 116
[:SOURce<hw>]:BB:WLNN[:TRIGger]:SEQuence..............................................................116

[:SOURce<hw>]:BB:WLNN:TRIGger:ARM:EXECute

Stops signal generation for trigger modes armed auto and armed retrigger. A subse-
quent internal or external trigger event restart signal generation.

Example: See Example "Configure and enable triggering" on page 113

Usage: Event

Manual operation: See "Arm" on page 90

[:SOURce<hw>]:BB:WLNN:TRIGger:EXECute

Executes a trigger. The internal trigger source must be selected using the command
BB:WLNN:TRIG:SOUR INT and a trigger mode other than AUTO must be selected
using the command [:SOURce<hw>]:BB:WLNN[:TRIGger]:SEQuence.

Example: BB:WLNN:TRIG:SOUR INT
Sets internal triggering.
BB:WLNN:TRIG:SEQ RETR
Sets retrigger mode, i.e. every trigger event causes signal gen-
eration to restart.
BB:WLNN:TRIG:EXEC
Executes a trigger.

Usage: Event

Manual operation: See " Execute Trigger " on page 26
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[:SOURce<hw>]:BB:WLNN:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

Enables signal output synchronous to the trigger event.

Parameters:
<Output> 0 | 1 | OFF | ON

OFF
*RST: 1

Example: BB:WLNN:TRIG:SOUR EXT
Sets external triggering.
BB:WLNN:TRIG:EXT:SYNC:OUTP ON
Enables synchronous output to external trigger.

Manual operation: See "Sync. Output to External Trigger" on page 91

[:SOURce<hw>]:BB:WLNN:TRIGger:RMODe?

The command queries the current status of signal generation for all trigger modes with
IEEE 802.11 WLAN modulation on.

Return values: 
<RMode> RUN | STOP

RUN
the signal is generated. A trigger event occurred in the triggered
mode.
STOP
the signal is not generated. A trigger event did not occur in the
triggered modes, or signal generation was stopped by the com-
mand :BB:WLNN:TRIG:ARM:EXECute (armed trigger modes
only).

Example: BB:WLNN:TRIG:SOUR EXT
sets external triggering.
BB:WLNN:TRIG:MODE ARET
selects the Armed_Retrigger mode.
BB:WLNN:TRIG:RMOD?
queries the current status of signal generation.
Response: RUN
the signal is generated, an external trigger was executed.

Usage: Query only

Manual operation: See "Running/Stopped" on page 90

[:SOURce<hw>]:BB:WLNN:TRIGger:SLENgth <Slength>

The command defines the length of the signal sequence to be output in the "Single"
trigger mode ([:SOURce<hw>]:BB:WLNN[:TRIGger]:SEQuence is set to SING).
The input is made in terms of samples.
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It is possible to output deliberately just part of the frame, an exact sequence of the
frame, or a defined number of repetitions of the frame.

Parameters:
<Slength> integer

Range: 1  to  (2^32) - 1
*RST: 1
Default unit: sample

Example: BB:WLNN:SEQ SING
Sets trigger mode single.
BB:WLNN:TRIG:SLEN 200
Sets a sequence length of 200 samples. The first 200 samples
of the current frame will be output after the next trigger event.

Manual operation: See "Signal Duration" on page 90

[:SOURce<hw>]:BB:WLNN:TRIGger:SLUNit <Slunit>

Defines the unit for the entry of the length of the signal sequence ([:SOURce<hw>]:
BB:WLNN:TRIGger:SLENgth) to be output in the single trigger mode ([:
SOURce<hw>]:BB:WLNN[:TRIGger]:SEQuence is set to SINGle).

Parameters:
<Slunit> SAMPle | SEQuence

SAMPle
Unit Sample. A single sample is generated after a trigger event.
SEQuence
Unit Sequence Length. A single sequence is generated after a
trigger event.
*RST: SEQuence

Example: BB:WLNN:SEQ SING
Sets trigger mode single.
BB:WLNN:TRIG:SLUN SEQ
Sets unit sequence for the entry of sequence length.
BB:WLNN:TRIG:SLEN 2
Sets a sequence length of 2 sequences. Two sequences will be
output after the next trigger event.

Manual operation: See "Signal Duration Unit" on page 90

[:SOURce<hw>]:BB:WLNN:TRIGger:SOURce <Source>

Selects the trigger source.

Parameters:
<Source> INTernal|OBASeband|BEXTernal|EXTernal

INTernal
manual trigger or *TRG.
EXTernal|BEXTernal
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trigger signal on the TRIGGER 1/2 connector.
*RST: INTernal

Example: SOURce1:BB:WLNN:TRIGger:SOURce EXTernal
sets external triggering via the TRIGGER 1 connector.

Manual operation: See "Trigger Source" on page 90

[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal<ch>]:DELay <Delay>

Parameters:
<Delay> float

Range: 0  to  65535
Increment: 0.01
*RST: 0

Example: BB:WLNN:TRIG:SOUR EXT
sets an external trigger via the TRIGGER 1 connector.
BB:WLNN:TRIG:DEL 50
sets a delay of 50 samples for the trigger.

Manual operation: See "Trigger Delay" on page 92

[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

The command specifies the number of samples by which a restart is to be inhibited fol-
lowing a trigger event.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: BB:WLNN:TRIG:SOUR EXT
selects an external trigger via the TRIGGER 1 connector.
BB:WLNN:TRIG:INH 200
sets a restart inhibit for 200 samples following a trigger event.

Manual operation: See "Trigger Inhibit" on page 92

[:SOURce<hw>]:BB:WLNN[:TRIGger]:SEQuence <Sequence>

Selects the trigger mode:
● AUTO = auto
● RETRigger = retrigger
● AAUTo = armed auto
● ARETrigger = armed retrigger
● SINGle = single
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Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

*RST: AUTO

Example: BB:WLNN:SEQ AAUT
Sets the Armed_auto trigger mode; the device waits for the first
trigger (e.g. with *TRG) and then generates the signal continu-
ously.

Manual operation: See "Trigger Mode" on page 89

4.5  Marker Settings

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:MODE..................................................117
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:ONTime............................................... 118
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:OFFTime..............................................118
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FBINdex...............................................119
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FINDex................................................ 119
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FESHift................................................ 119
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:RESHift................................................120
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PATTern............................................... 120
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:DIVider..................................... 120
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:FREQuency?.............................121
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay................................................. 121
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut:DELay:FIXed............................................... 121
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MINimum?.................................122
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MAXimum?................................122

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Parameters:
<Mode> RESTart | FBLock | FRAMe | FAPart | PULSe | PATTern | RATio |

FIPart | TRIGger
RESTart
A marker signal is generated at the start of each signal
sequence (period = all frame blocks).
FRAMe
Number of Frame Blocks = 1, that is, a marker signal is gener-
ated at the start of each frame in the single frame block. Other-
wise, the frame block and frame index are entered and the spe-
cific frame is masked.
FBLock
Number of Frame Blocks = 1, that is, a marker signal is gener-
ated at the start of each frame block. Otherwise, a specific frame
block index is given and the whole frame block is marked.
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FAPart
Number of Frame Blocks = 1, that is, a marker signal is gener-
ated to mark every active part of each frame.
The active data transfer part (PPDU) of a frame period is
marked with high, the inactive part (idle time) with low. This
marker can be used to decrease the carrier leakage during inac-
tive signal parts by feeding it into the pulse modulator.
Otherwise, the frame block and frame index are entered and the
active part of the specific frame is masked.
PATTern
A marker signal is generated according to the user defined pat-
tern (command
SOURce:BB:WLNN:TRIGger:OUTPut:PATTern).

PULSe
A pulsed marker signal is generated. The pulse frequency
(= symbol rate/divider) is defined with the
SOUR:BB:WLNN:TRIG:OUTP:PULSe:DIVider command and
can be queried with the
SOUR:BB:WLNN:TRIG:OUTP:PULSe:FREQuency? command.

RATio
A marker signal corresponding to the Time Off / Time On specifi-
cations in the commands
SOURce:BB:WLNN:TRIGger:OUTPut:OFFT and
"SOURce:BB:WLNN:TRIGger:OUTPut:ONT" is generated.
TRIGger
A received internal or external trigger signal is output at the
marker connector.
*RST: RESTart

Example: BB:WLNN:TRIG:OUTP:MODE FRAM
selects the frame marker for the corresponding marker signal.

Manual operation: See " Marker Mode " on page 93

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:OFFTime <OffTime>

Sets the duration during which the marker output is on or off.

Parameters:
<OffTime> integer

Range: 1  to  16777215
*RST: 1

Example: BB:WLNN:TRIG:OUTP:OFFT 200
Manual operation: See " Marker Mode " on page 93
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[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FBINdex <FbIndex>

Sets the frame block index. For this/these frame block(s), a marker signal is generated.
The maximum value depends on the number of the currently active frame blocks (max
= 100).

Parameters:
<FbIndex> integer

Range: 0  to  100
Increment: 1
*RST: 1

Example: BB:WLNN:TRIG:OUTP1:FBIN 5
Sets the frame block index to 5.

Manual operation: See " Marker Mode " on page 93

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FINDex <FIndex>

Sets the frame index, that is, the frame to be marked in the frame block marked with
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FBINdex. The maximum value
depends on the number of frames set with command [:SOURce<hw>]:BB:WLNN:
FBLock<ch>:FCOunt . The maximum value is 1024.

Parameters:
<FIndex> integer

Range: 1  to  1024
Increment: 1
*RST: 1

Example: BB:WLNN:TRIG:OUTP1:FIND 100
Sets the frame index to 100.

Manual operation: See " Marker Mode " on page 93

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FESHift <Shift>

Shifts the falling edge of the marker the specified number of samples. Negative values
result in a shift back of the marker edge.

Parameters:
<Shift> integer

Range: -1000  to  1000
*RST: 0

Example: BB:WLNN:TRIG:OUTP2:FESH 75
shifts the falling edge of the marker 2 about 75 samples.

Manual operation: See " Marker Mode " on page 93
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[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:RESHift <Shift>

Shifts the rising edge of the marker the specified number of samples. Negative values
result in a shift back of the marker edge.

Parameters:
<Shift> integer

Range: -1000  to  1000
*RST: 0

Example: BB:WLNN:TRIG:OUTP2:RESH -20
shifts back the rising edge of marker 2 about 20 samples.

Manual operation: See " Marker Mode " on page 93

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PATTern <Pattern>

Defines the bit pattern used to generate the marker signal if [:SOURce<hw>]:BB:
WLNN:TRIGger:OUTPut<ch>:MODEis set to PATTern.

Parameters:
<Pattern> 64 bits

0 = marker off, 1 = marker on
*RST: #H2,2

Example: BB:WLNN:TRIG:OUTP2:PATT #B000000011111111,15
Sets a bit pattern.
BB:WLNN:TRIG:OUTP:MODE PATT
Activates the marker signal according to a bit pattern for the cor-
responding marker signal.

Manual operation: See " Marker Mode " on page 93

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

Sets the divider for the pulsed marker signal.

Parameters:
<Divider> integer

Range: 1  to  1024
Increment: 1
*RST: 2

Example: BB:WLNN:TRIG:OUTP:PULS:DIV 2
Sets the divider to 2 for the corresponding marker signal.
BB:WLNN:TRIG:OUTP2:FREQ?
Queries the resulting pulse frequency of the marker signal.
Response: 66 000
The resulting pulse frequency is 66 kHz.

Manual operation: See " Marker Mode " on page 93
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[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:FREQuency?

Queries the pulse frequency of the pulsed marker signal ([:SOURce<hw>]:BB:
WLNN:TRIGger:OUTPut<ch>:MODE PULSe). The pulse frequency is derived by
dividing the symbol rate by the divider.

Return values: 
<Frequency> float

Range: 0.0  to  max

Example: BB:WLNN:TRIG:OUTP:PULS:DIV 2
Sets the divider marker signal of the corresponding marker sig-
nal to the value 2.
BB:WLNN:TRIG:OUTP:MODE PULS
Enables the pulsed marker signal.
BB:WLNN:TRIG:OUTP:PULS:FREQ?
Queries the pulse frequency of the marker signal.
Response: 33 000
The resulting pulse frequency is 33 kHz.

Usage: Query only

Manual operation: See " Marker Mode " on page 93

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the sig-
nals.

Parameters:
<Delay> float

Range: 0  to  16777215
*RST: 0

Example: BB:WLNN:TRIG:OUTP:DEL 1600
Sets a delay of 1600 samples for the corresponding marker sig-
nal.

Manual operation: See "Marker x Delay" on page 96

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut:DELay:FIXed <Fixed>

Restricts the marker delay setting range to the dynamic range. In this range the delay
can be set without restarting the marker and signal. If a delay is entered in setting ON
but is outside this range, the maximum possible delay is set and an error message is
generated.

Parameters:
<Fixed> 0 | 1 | OFF | ON

*RST: OFF
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Example: BB:WLNN:TRIG:OUTP:DEL:FIX ON
Restricts the marker signal delay setting range to the dynamic
range.

Manual operation: See "Fix marker delay to current range" on page 96

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MINimum?
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MAXimum?
Queries the maximum marker delay, if [:SOURce<hw>]:BB:WLNN:TRIGger:
OUTPut:DELay:FIXed is set to ON.

Return values: 
<Maximum> float

Range: 0  to  depends on installed options

Example: BB:WLNN:TRIG:OUTP:DEL:FIX ON
Restricts the marker signal delay setting range to the dynamic
range.
BB:WLNN:TRIG:OUTP:DEL:MAX
Queries the maximum of the dynamic range.
Response: 2000
The maximum for the marker delay setting is 2000 samples.

Usage: Query only

Manual operation: See "Current Range without Recalculation" on page 96

4.6  Clock Settings

[:SOURce<hw>]:BB:WLNN:CLOCk:MODE....................................................................... 122
[:SOURce<hw>]:BB:WLNN:CLOCk:MULTiplier................................................................. 123
[:SOURce<hw>]:BB:WLNN:CLOCk:SOURce....................................................................123
[:SOURce<hw>]:BB:WLNN:CLOCk:SYNChronization:EXECute..........................................123
[:SOURce<hw>]:BB:WLNN:CLOCk:SYNChronization:MODE............................................. 124

[:SOURce<hw>]:BB:WLNN:CLOCk:MODE <Mode>

Sets the type of externally supplied clock.

Parameters:
<Mode> SAMPle | MSAMple | MSAMple

*RST: SAMPle

Example: SOURce1:BB:WLNN:CLOCk:MODE SAMPle
Selects clock type

Manual operation: See " Clock Mode " on page 97
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[:SOURce<hw>]:BB:WLNN:CLOCk:MULTiplier <Multiplier>

Note: This command is available for clock source "External" and in clock mode "Multi-
ple Sample" only.

Specifies the multiplier for clock type "Multiplied" (:BB:WLNN:CLOCk:MODE MSAMple)
in the case of an external clock source.

Parameters:
<Multiplier> integer

Range: 1  to  64
Increment: 1
*RST: 4

Example: SOURce1:BB:WLNN:CLOCk:SOURce EXTernal
selects the external clock source.
SOURce1:BB:WLNN:CLOCk:MODE MSAMple
selects clock type "Multiplied", i.e. the supplied clock has a rate
which is a multiple of the sample rate.
SOURce1:BB:WLNN:CLOCk:MULTiplier 12
the multiplier for the external clock rate is 12.

Manual operation: See " Chip Clock Multiplier " on page 97

[:SOURce<hw>]:BB:WLNN:CLOCk:SOURce <Source>

The command selects the clock source.

Parameters:
<Source> INTernal | EXTernal

INTernal
The internal clock reference is used.
EXTernal
The external clock reference is supplied to the CLOCK connec-
tor.
*RST: INTernal

Example: BB:WLNN:CLOC:SOUR EXT
selects an external clock reference. The clock is supplied via the
CLOCK connector.
BB:WLNN:CLOC:MODE SAMP
specifies that a sample clock is supplied via the CLOCK connec-
tor.

Manual operation: See " Clock Source " on page 97

[:SOURce<hw>]:BB:WLNN:CLOCk:SYNChronization:EXECute

Performs automatically adjustment of the instrument's settings required for the syn-
chronization mode, set with the command BB:WLNN:CLOC:SYNC:MODE.
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Example: BB:WLNN:CLOC:SYNC:MODE MAST
The instrument is configured to work as a master one.
BB:WLNN:CLOC:SYNC:EXEC
All synchronization's settings are adjusted accordingly.

Usage: Event

Manual operation: See "Set Synchronization Settings" on page 97

[:SOURce<hw>]:BB:WLNN:CLOCk:SYNChronization:MODE <Mode>

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of sev-
eral connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave one and between each two consecutive slave instruments must
have the same length and type.Avoid unnecessary cable length and branching points.

Parameters:
<Mode> NONE | MASTer | SLAVe

NONE
The instrument is working in stand-alone mode.
MASTer
The instrument provides all connected instrument with its syn-
chronization (including the trigger signal) and reference clock
signal.
SLAVe
The instrument receives the synchronization and reference clock
signal from another instrument working in a master mode.
*RST: NONE

Example: BB:WLNN:CLOC:SYNC:MODE MAST
The instrument is configured to work as a master one.

Manual operation: See "Sync. Mode" on page 96

4.7  Antenna Configuration Settings

[:SOURce<hw>]:BB:WLNN:ANTenna:MODE.................................................................... 125
[:SOURce<hw>]:BB:WLNN:ANTenna:SYSTem................................................................. 125
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:DESTination............................ 125
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[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:REAL...................................... 126
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:IMAGinary............................... 126
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:PHASe....................................126
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:MAGNitude..............................127
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[:SOURce<hw>]:BB:WLNN:ANTenna:MODE <Mode>

The command selects the number of transmit antennas to be used.

Parameters:
<Mode> A1 | A2 | A3 | A4 | A5 | A6 | A7 | A8

*RST: A1

Example: BB:WLNN:ANT:MODE A1
one antenna is used for transmission.

Manual operation: See " Antennas " on page 27

[:SOURce<hw>]:BB:WLNN:ANTenna:SYSTem <System>

Selects the coordinate system of the transmission chain matrix.

Parameters:
<System> CARTesian | CYLindrical

*RST: CARTesian

Example: BB:WLNN:ANT:SYST CART
Sets the coordinate system of the transmission chain matrix to
Cartesian.

Manual operation: See " Mapping Coordinates " on page 27

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:DESTination
<Destination>

Selects the destination of the calculated IQ chains.

Parameters:
<Destination> OFF | BB | BB_B | FILE

OFF
No mapping takes place.
BB
The IQ chain is output to the baseband A. Exactly one output
stream can be mapped as "Baseband A".
FILE
The IQ chain is saved in a file.
*RST: OFF (for antenna 2 .. 8); Baseband (for antenna 1)

Example: BB:WLNN:ANT:TCH1:OUTP:DEST BB
The IQ chain is saved in a file.

Manual operation: See " Output " on page 27

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:FSELect <FSelect>

The command saves the IQ chain in a file.
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Parameters:
<FSelect> string

Example: BB:WLNN:ANT:TCH1:OUTP:FSEL '<root>wlnn_1.wv'
saves the IQ chain in the selected file.

Manual operation: See " Output " on page 27

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:REAL <Real>

Sets the value for the Real coordinate.

Parameters:
<Real> float

Range: -1000  to  1000
Increment: 0.01

Example: BB:WLNN:ANT:TCH1:TX2:REAL 500
sets the real coordinate for the selected transmission chain to
500.

Manual operation: See " Real/Magnitude " on page 27

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:IMAGinary
<Imaginary>

Sets the value for the Imaginary coordinate.

Parameters:
<Imaginary> float

Range: -999.99  to  999.99
Increment: 0.01
*RST: 0

Example: BB:WLNN:ANT:TCH1:TX2:IMAG 500
sets the imaginary coordinate for the selected transmission
chain to 500.

Manual operation: See " Imaginary/Phase " on page 28

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:PHASe <Phase>

Sets the phase when cylindrical mapping coordinates are selected.

Parameters:
<Phase> float

Range: 0  to  359.99
Increment: 0.01
*RST: 0

Example: :BB:WLNN:ANT:TCH1:TX1:PHAS 10
Sets the phase to 10°.
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Manual operation: See " Imaginary/Phase " on page 28

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:MAGNitude
<Magnitude>

Sets the magnitude when cylindrical mapping coordinates are selected.

Parameters:
<Magnitude> float

Range: 0  to  999.99
Increment: 0.01
*RST: 0

Example: :BB:WLNN:ANT:TCH1:TX1:MAGN 100
Sets the magnitude to 100.

Manual operation: See " Real/Magnitude " on page 27

4.8  Frame Block Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BCSMoothing..................................................... 127
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BOOSt...............................................................128
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:FCOunt..............................................................128
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA................................................................. 128
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:DSELection............................................... 129
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:PATTern.................................................... 129
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE?......................................................130
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ITIMe.................................................................130
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PMODe..............................................................130
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STANdard.......................................................... 131
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STATe................................................................131
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TMODe..............................................................131
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TYPE.................................................................132
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY................................................................ 132
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete.............................................................. 132
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert................................................................ 132
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe................................................................133
[:SOURce<hw>]:BB:WLNN:FBLock:APPend.....................................................................133

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BCSMoothing <BCSmoothing>

Activates beam change and smoothing.

Parameters:
<BCSmoothing> 0 | 1 | OFF | ON

*RST: 1

Example: SOURce1:BB:WLNN:FBL1:BCSMoothing 1
Example: Beam change and smoothing is activated.
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BOOSt <Boost>

Assigns a specific RMS power boost/attenuation to the corresponding frame block
modulation.

The power level of a frame block modulation is calculated as sum of the power boost
and the power level set in the header of the instrument.

Note: At least one frame block should have a power boost set to 0 dB value for this
gated power mode functionality to work properly.

Parameters:
<Boost> float

Range: -80  to  0
Increment: 0.01
*RST: 0
Default unit: dB

Example: BB:WLNN:FBL5:BOOS -10.0
Sets the power boost

Manual operation: See " Boost /dB " on page 33

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:FCOunt <FCount>

Sets the number of frames to be transmitted in the current frame block.

Parameters:
<FCount> integer

Range: 1  to  20 000
Increment: 1
*RST: 1

Example: BB:WLNN:FBL5:FCO 1
Sets the number of transmitted frames in the current frame block
to 1.

Manual operation: See " Frames " on page 32

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA <Data>

Selects the data source.

Parameters:
<Data> ZERO | ONE | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt | AMPDU
PNxx
The pseudo-random sequence generator is used as the data
source. Different random sequence lengths can be selected.
DLISt
A data list is used. The data list is selected with the command
BB:WLNN:FBLocks:DATA:DSEL
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ZERO | ONE
Internal 0 and 1 data is used.
PATTern
Internal data is used. The bit pattern for the data is defined by
the command BB:WLNN:FBLocks:DATA:PATTern.

AMPDU
Aggregated mac protocol data unit (A-MPDU) data is used as
configured with the commands in Chapter 4.9.4, "MPDU Config-
uration", on page 158
*RST: PN9

Example: BB:WLNN:FBL5:DATA PN9
sets PN9 as the data source.

Manual operation: See " Data List Management… " on page 24

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:DSELection <DSelection>

Selects the data list for the DLISt data source selection.

The lists are stored as files with the fixed file extensions *.dm_iqd in a directory of the
user's choice. The directory applicable to the following commands is defined with the
command MMEMory:CDIR. To access the files in this directory, you only have to give
the file name without the path and the file extension.

Parameters:
<DSelection> string

Example: BB:WLNN:FBL5:DATA DLIS
Selects the data lists data source.
MMEM:CDIR '<root>Lists_DM'
Selects the directory for the data lists.
BB:WLNN:FBL5:DATA:DSEL 'dlist1'
Selects file 'dlist1' as the data source. This file must be in the
directory <root>Lists_DM and have the file extension
*.dm_iqd.

Manual operation: See " Data List Management… " on page 24

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:PATTern <Pattern>

Determines the bit pattern for the PATTern selection. The maximum length is 64 bits.

Parameters:
<Pattern> 64 bits

*RST: #H0,1

Example: BB:WLNN:FBL5:DATA:PATT #H3F,8
Sets the bit pattern.

Manual operation: See " Data " on page 32
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE?

The command queries the PPDU data rate.

Return values: 
<Rate> float

Example: BB:WLNN:FBL5:DATA:RATE?
queries the data rate.

Usage: Query only

Manual operation: See " Data Rate/Mbps " on page 33

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ITIMe <ITime>

Sets the time interval separating two frames in this frame block. The default unit for the
time interval are seconds. However, the time interval can be set in milliseconds. In this
case the unit has to be set.

Parameters:
<ITime> float

Range: 0  to  1
Increment: 100E-6
*RST: 100E-6

Example: BB:WLNN:FBL5:ITIMe 0.0025
sets the idle time to 2.5 msec.

Manual operation: See " Idle Time / ms " on page 32

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PMODe <PMode>

Selects the preamble design.

For physical type SOUNDING, only GREEN FIELD is available.

Parameters:
<PMode> LEGacy | MIXed | GFIeld

LEGacy
Compatible with 802.11 a/g OFDM devices.
MIXed
For High Throughput (HT) and 802.11a/g OFDM devices.
GFIeld
For HT only networks.
*RST: MIXed

Example: BB:WLNN:FBL5:PMOD LEG
Sets the physical mode to LEGACY.

Manual operation: See " Physical Mode " on page 30
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STANdard <Standard>

Sets the IEEE 802.11 WLAN standard.

Parameters:
<Standard> USER | WAG | WBG | WPJ | WN | WAC | WAX

USER
Sets a user defined standard.
WAG
Sets the IEEE 802.11a/g standard.
WBG
Sets the IEEE 802.11b/g standard.
WPJ
Sets the IEEE 802.11p/j standard.
WN
Sets the IEEE 802.11n standard.
WAC
Sets the IEEE 802.11a/c standard.
WAX
Sets the IEEE 802.11ax standard.
*RST: USER

Example: BB:WLNN:FBL1:STAN WN
Sets the IEEE 802.11n standard

Manual operation: See "Standard" on page 29

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STATe <State>

Enables the corresponding frame block for transmission.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: ON

Example: BB:WLNN:FBL5:STAT ON
Enables frame block 5 for transmission.

Manual operation: See " State " on page 33

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TMODe <TMode>

Sets the Tx mode. The available Tx modes are dependent on the physical mode.

Parameters:
<TMode> L20 | LDUP | LUP | LLOW | HT20 | HT40 | HTDup | HTUP |

HTLow | CCK | PBCC | V20 | V40 | V80 | V160 | V8080 | HE20 |
HE40 | HE80 | HE8080 | HE160
*RST: HT20
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Example: BB:WLNN:FBL5:TMOD HT40
Sets the Tx mode to HT 40 MHz.

Manual operation: See " Tx Mode " on page 30

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TYPE <Type>

The command selects the PPDU type.

Parameters:
<Type> DATA | SOUNding | BEACon | TRIGger

DATA
Only Data Long Training Fields are used to probe the channel.
SOUNding
Staggered preambles are used to probe additional dimension of
the MIMO channel. Only Physical Layer Mode GREEN FIELD is
available.
BEACon
Frame type "Beacon" is used to probe the channel.
*RST: DATA

Example: BB:WLNN:FBL5:TYPE DATA
sets the PPDU type data.

Manual operation: See " Type " on page 30

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY

Copies the specified frame block.

Usage: Event

Manual operation: See " Copy " on page 34

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete

Deletes the specified frame block.

Usage: Event

Manual operation: See " Delete " on page 34

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert

The command adds a default frame block before the selected frame block.

Example: BB:WLNN:FBL2:INS
inserts a default frame block before the selected frame block.

Usage: Event

Manual operation: See " Insert " on page 33

Frame Block Configuration



Remote-Control CommandsIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

133Operating Manual 1178.6985.02 ─ 23

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe

Pastes the copied frame block behind the selected frame block.

Usage: Event

Manual operation: See " Paste " on page 34

[:SOURce<hw>]:BB:WLNN:FBLock:APPend

Appends a frame block to the end of the frame blocks list.

Example: BB:WLNN:FBL:APP
Usage: Event

Manual operation: See " Append " on page 33

4.9  Frame Configuration Settings
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:SCRambler:PATTern......................... 146
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:PATTern........................................... 146
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:RIGHt106tone.................................................... 146
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CBINonht <CBINonht>

(Available only for VHT Tx mode)

The command is used to modify the first 7 bits of the scrambling sequence to indicate
the duplicated bandwidth of the PPDU.

Parameters:
<CBINonht> B20 | B40 | B80 | B160 | OFF

B20|B40|B80
Indicates 20 MHz, 40MHz, 80MHz or 80+80 MHz channel band-
width of the transmitted packet.
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OFF
Channel bandwidth in Non HT is not present.
*RST: OFF
Default unit: MHz

Example: BB:WLNN:FBL1:CBIN B80
Selects 80 MHz channel bandwidth of the transmitted packet.

Manual operation: See " Ch. Bandwidth in Non HT " on page 51

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:CODing:ENCoder?
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:ENCoder?
Queries the number of encoders to be used. This value depends on the data rate. For
data rate ≤ 300 Mps, this value is 1. Otherwise the number of encoders is 2.

Return values: 
<Encoder> E1 | E2 | E3 | E6 | E7 | E8 | E9 | E12 | E4 | E5 | E10 | E11

Example: BB:WLNN:FBL5:COD:ENC?
queries the number of encoders to be used.

Usage: Query only

Manual operation: See " Encoders " on page 41

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:CODing:RATE <Rate>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:RATE <Rate>

This command selects the coding rate.

Parameters:
<Rate> CR1D2 | CR2D3 | CR3D4 | CR5D6

*RST: CR1D2

Example: BB:WLNN:FBL5:COD:RATE CR1D2
sets the coding rate to CR1D2.

Manual operation: See " Cod Rate " on page 41

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:CODing:TYPE <Type>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:TYPE <Type>

Selects the channel coding.

Parameters:
<Type> OFF | BCC

*RST: BCC

Example: BB:WLNN:FBL5:COD:TYPE OFF
no channel coding is used.

Manual operation: See " Channel Coding " on page 40
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:DCM <DCM>

Enables dual carrier modulation.

Parameters:
<DCM> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See " DCM " on page 41

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DATA:BPSymbol?
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:BPSymbol?
Queries the number of data bits sent by an OFDM symbol on all spatial streams.

Return values: 
<BpSymbol> integer

*RST: 0

Example: BB:WLNN:FBL5:DATA:BPS?
queries the number of data bits sent by an OFDM symbol on all
spatial streams.

Usage: Query only

Manual operation: See " Data Bits Per Symbol " on page 40

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:DCYCle?

Queries the duty cycle, i.e. the ratio of frame duration and total signal length.

Frame duration and duty cycle are related to data length and number of data symbols.
Whenever one of them changes, the frame duration and duty cycle are updated.

Return values: 
<DutyCycle> float

Range: 0.1  to  1
Increment: 0.0001
*RST: 0.1

Example: SOURce1:BB:WLNN:FBLock1:DATA:DCYCle?
Response: 1
The frame duration and the total signal length are equal.

Usage: Query only

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:FDURation?

Queries the duration of the frame in milliseconds, i.e. the WLAN burst length.

Frame duration and duty cycle are related to data length and number of data symbols.
Whenever one of them changes, the frame duration and duty cycle are updated.
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Return values: 
<FrameDuration> float

Range: 0  to  1000
Increment: 0.0001
*RST: 0.1

Example: SOURce1:BB:WLNN:FBLock1:DATA:FDURation?
Response: 0.676
The WLAN burst has a length of 0.676 ms.

Usage: Query only

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DATA:LENGth <Length>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:LENGth <Length>

The command enters the size of the data field in bytes.

For Data Length = 0, no data field will be generated for the case of a sounding frame.

The maximum data length depends on the physical mode: In LEGACY mode, the max-
imum value is 4061 Bytes. In MIXED MODE and GREEN FIELD, the maximum value
is 65495 Bytes.

The data length is related to the number of data symbols. Whenever the data length
changes, the number of data symbols is updated and vice versa.

Parameters:
<Length> integer

Range: 0  to  Max
*RST: 1024 (for LEGACY); 1048575 (for GREEN FIELD

or MIXED MODE)

Example: BB:WLNN:FBL5:DATA:LENG 500
sets the data length to 500 Bytes.

Manual operation: See " Data Length " on page 50

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DATA:RATE?
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE?
The command queries the PPDU data rate.

Return values: 
<Rate> float

Example: BB:WLNN:FBL5:DATA:RATE?
queries the data rate.

Usage: Query only

Manual operation: See " Data Rate/Mbps " on page 33
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DATA:SYMBols <Symbols>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:SYMBols <Symbols>

Sets the number of data symbols per frame block.

If the number of OFDM data symbols is changed, the generator calculates the data
field length as a function of the set PPDU bit rate and displays it at Data Length.

Parameters:
<Symbols> integer

Range: 1  to  Max
*RST: 158

Example: BB:WLNN:FBL5:DATA:SYMB 1
sets the number of data symbols per frame block to 1.

Manual operation: See " Number Of Data Symbols " on page 52

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DBINonht <DBINonht>

(available only for VHT Tx mode)

Modifys the first 7 bits of the scrambling sequence to indicate if the transmitter is capa-
ble of "Static" or "Dynamic" bandwidth operation.

Parameters:
<DBINonht> STAT | DYN | OFF

STAT
The transmitter is capable of static bandwidth operation.
DYN
The transmitter is capable of dynamic bandwidth operation.
OFF
Dynamic bandwidth in Non HT is not present.
*RST: OFF

Example: BB:WLNN:FBL1:DBIN DYN
The transmitter is capable of dynamic bandwidth operation.

Manual operation: See " Dyn. Bandwidth in Non HT " on page 52

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:DPNSeed:STATe
<DefaultPNSeed>

Activates the default PN seed. The seed is used initially to generate the pseudo-ran-
dom noise sequence.

Parameters:
<DefaultPNSeed> 0 | 1 | OFF | ON

*RST: 1

Example: See [:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:
PNSeed on page 143.
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Manual operation: See "Default PN Seed" on page 51

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ESSTream <EsStream>

Sets the value of the extended spatial streams. This field is active for frame block type
sounding only to probe additional dimensions to the channel.

Parameters:
<EsStream> integer

Range: 1  to  dynamic
Increment: 1
*RST: 1

Example: BB:WLNN:FBL5:ESSTR 4
Sets the number of the extended spatial streams to 4.

Manual operation: See " Extended Spatial Streams " on page 38

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:GUARd <Guard>

Selects which guard interval is used for the OFDM guard.

In physical mode green field or legacy, only long guard intervals are possible. In this
case, the field is read-only.

GD08, GD16 and GD32 are available only for the IEEE 802.11ax standard.

Parameters:
<Guard> SHORt | LONG | GD08 | GD16 | GD32

*RST: LONG

Example: BB:WLNN:FBL5:GUAR LONG
Sets a long guard interval.

Manual operation: See " Guard " on page 41

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:ILEaver:STATe <State>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ILEaver:STATe <State>

The command activates/deactivates the interleaver of the data field.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: ON

Example: BB:WLNN:FBL5:ILE:STAT ON
activates the interleaver.

Manual operation: See " Interleaver Active " on page 51
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MCS <MCS>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MCS <MCS>

Selects the modulation and coding scheme for the spatial streams.

Parameters:
<MCS> MCS0 | MCS1 | MCS2 | MCS3 | MCS4 | MCS5 | MCS6 | MCS7 |

MCS8 | MCS9 | MCS10 | MCS11 | MCS12 | MCS13 | MCS14 |
MCS15 | MCS16 | MCS17 | MCS18 | MCS19 | MCS20 |
MCS21 | MCS22 | MCS23 | MCS24 | MCS25 | MCS26 |
MCS27 | MCS28 | MCS29 | MCS30 | MCS31 | MCS32 |
MCS33 | MCS34 | MCS35 | MCS36 | MCS37 | MCS38 |
MCS39 | MCS40 | MCS41 | MCS42 | MCS43 | MCS44 |
MCS45 | MCS46 | MCS47 | MCS48 | MCS49 | MCS50 |
MCS51 | MCS52 | MCS53 | MCS54 | MCS55 | MCS56 |
MCS57 | MCS58 | MCS59 | MCS60 | MCS61 | MCS62 |
MCS63 | MCS64 | MCS65 | MCS66 | MCS67 | MCS68 |
MCS69 | MCS70 | MCS71 | MCS72 | MCS73 | MCS74 |
MCS75 | MCS76
*RST: MCS1

Example: BB:WLNN:FBL1:MCS MCS8
selects MCS8 as the coding scheme used for the spatial stream.

Manual operation: See " MCS " on page 40

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MODulation<st>
<Modulation>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MODulation<st> <Modulation>

Selects the modulation used for the spatial stream.

Parameters:
<Modulation> BPSK | QPSK | QAM16 | QAM64 | QAM256 | QAM1024

*RST: QPSK; BPSK for Tx Mode > HT-Duplicate

Example: BB:WLNN:FBL5:MOD1 BPSK
sets BPSK as the modulation mode used for the spatial stream.

Options: QAM256|QAM1024 require R&S SMx/AMU-K86

Manual operation: See " Stream n " on page 40

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MUMimo:STATe <MUMimo>

Activates Multi User MIMO. This function applies to "Spatial Streams">1.

Parameters:
<MUMimo> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:BB:WLNN:FBL1:MUM:STAT ON
activates Multi User MIMO.
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Manual operation: See " Multi User MIMO " on page 38

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:GID <GID>

Sets the group ID for all available users.

Parameters:
<GID> integer

Range: 1  to  62
*RST: 1

Example: BB:WLNN:BB:WLNN:FBL1:MU1:GID 1.0
assigns group ID 1.0 to user 1.

Manual operation: See "Multi User MIMO Settings Table" on page 39

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:NSTS <NSTS>

Sets the number of space time streams for each user.

Parameters:
<NSTS> integer

Range: 0  to  Max
*RST: 1

Example: BB:WLNN:BB:WLNN:FBL1:MU2:NSTS 8.0
sets 8 space time streams for user 2.

Manual operation: See "Multi User MIMO Settings Table" on page 39

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:NTPS <NTPS>

(Available only for VHT Tx mode)

Indicates whether VHT AP allows VHT non-AP STAs in TXOP power save mode to
enter during TXOP.

Parameters:
<NTPS> OFF | ON

ON
Indicates that the VHT AP allows VHT non-AP STAs to enter
doze mode during a TXOP.
OFF
Indicates that the VHT AP does not allow VHT non-AP STAs to
enter doze mode during a TXOP.
*RST: 1

Example: BB:WLNN:FBL1:NTPS ON
Activates NTPS.

Manual operation: See " No TXOP PS " on page 54
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PAID:PATTern <Pattern>

(avaliable only for VHT Tx mode)

The command provides an abbreviated indication of the intended recipient(s) of the
frame.

Parameters:
<Pattern> 9 bits

Range: #H000,9  to  #H1FF,9
*RST: #H000,9

Example: BB:WLNN:FBL1:PAID:PAT #H1FB,9
Sets the 9 bits pattern 1FB.

Manual operation: See " Partial AID (hex) " on page 54

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:FORMat <Format>

(available only for CCK and PBCC transport modes)

Selects the packet type (PPDU format) with long or short PLCP (physical layer conver-
gence protocol).

Depending on the format selected, the structure, modulation and data rate of the PLCP
preamble and header are modified.

Parameters:
<Format> LONG | SHORt

*RST: LONG

Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY.
BB:WLNN:FBL5:TMOD CCK
sets the transport mode
BB:WLNN:FBL5:PLCP:FORM SHOR
sets the PLCP Format

Manual operation: See " PLCP P+H Format " on page 53

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:LCBit:STATe <State>

(available only for CCK and PBCC transport modes)

Sets the Locked Clock Bit in Service Field of the PLCP Header.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: ON
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Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY.
BB:WLNN:FBL5:TMOD CCK
sets the transport mode
BB:WLNN:FBL5:PLCP:LCB:STAT OFF
sets the Locked Clock Bit

Manual operation: See " Service Field Clock Bit " on page 53

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PREamble:STATe <State>

Activates/deactivates the preamble and signal fields of the frames in the current frame
block. For data type = SOUNDING, the preamble and signal field are always activated
and cannot be deactivated.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: BB:WLNN:FBL5:PRE:STAT ON
Activates the preamble and signal fields of the frames in the cur-
rent frame block.

Manual operation: See " Preamble/Header Active " on page 53

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:PNSeed <PNSeed>

Sets the PN seed. Use this setting, if you don't use the default PN seed.

Parameters:
<PNSeed> 24 bits | 24 bit

Range: #H000001,24  to  #H7FFFFF,24
*RST: #H000001,24

Example: SOURce1:BB:WLNN:FBL5:DATA PN9
Sets "PN9" as the data source.
BB:WLNN:FBL5:DPNSeed:STATe 0
Deactivates the default PN seed.
BB:WLNN:FBL5:PNSeed #H47FFFF,24
Sets a PN seed value of 47FFFF. The value is internally correc-
ted to the maximum 9 bit PN seed value of 1FF.

Manual operation: See "PN Seed" on page 53

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BRATe <BRate>

(available only for CCK and PBCC transport modes)

Sets the PSDU bit rate.
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Parameters:
<BRate> integer

Range: 0  to  22E6
*RST: 11E6

Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY
BB:WLNN:FBL5:TMOD CCK
sets the transport mode
BB:WLNN:FBL5:PSDU:BRAT 2E6
sets the PSDU bit rate of 2 Mbps

Manual operation: See " PSDU Bit Rate " on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BSPReading:STATe <State>

(available only for CCK and PBCC transport modes)

Enables/disables Barker spreading.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY.
BB:WLNN:FBL5:TMOD CCK
sets the transport mode
BB:WLNN:FBL5:PSDU:BRAT 2MBPS
sets the PSDU bit rate
BB:WLNN:FBL5:PSDU:BSPR:STAT ON
enables spreading

Manual operation: See " Barker Spreading " on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:MODulation?

(available only for CCK and PBCC Tx modes)

Queries the modulation type. The modulation mode depends on the selected PSDU bit
rate which depends on the selected physical layer mode (SOUR:BB:WLNN:MODE).

Return values: 
<Modulation> BPSK | QPSK | DBPSK | DQPSK | CCK | PBCC

*RST: CCK
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Example: BB:WLNN:FBL5:PMOD LEG
Sets the physical mode to legacy.
BB:WLNN:FBL5:TMOD CCK
Sets the transport mode to CCK.
BB:WLNN:FBL5:PSDU:BRAT P2MBPS
Sets the PSDU bit rate to 2 mbps.
BB:WLNN:PSDU:MOD?
Queries the modulation mode.
Response: "DQPSK"

Usage: Query only

Manual operation: See " PSDU Modulation " on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:SCRambler:MODE <Mode>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:MODE <Mode>

The command selects the different options for the scrambler.

Parameters:
<Mode> OFF | RANDom | USER | ON | PREamble

OFF
The scrambler is deactivated.
RANDom
(not for CCK/PBCC)
The scrambler is activated.
The initialization value of the scrambler is selected at random.
Each frame has a different random initialization value. This value
is also different in case of successive recalculations with the
same setting parameters so that different signals are generated
for each calculation.
USER
(not for CCK/PBCC)
The scrambler is activated.
The initialization value of the scrambler is set to a fixed value
that is set using the command BB:WLNN:FBL5:SCR:PATT. This
value is then identical in each generated frame.
ON
(CCK/PBCC only)
The scrambler is activated.
PREamble
(CCK/PBCC only)
The scrambler is activated. Only the preamble is scrambled.
*RST: USER

Example: BB:WLNN:FBL5:SCR:MODE RAND
activates the scrambler with an random initialization value.

Manual operation: See " Scrambler " on page 50
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:SCRambler:PATTern
<Pattern>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:PATTern <Pattern>

The command sets the initialization value for scrambling mode User. This value is then
identical in each generated frame.

Parameters:
<Pattern> 8 bits

*RST: #H01,8

Example: BB:WLNN:FBL5:SCR:PATT #H3F,8
sets the user defined initialization value for the scrambler.

Manual operation: See " Scrambler Init (hex) " on page 52

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:RIGHt106tone <Right106toneRu>

If enabled, indicates that the right 106-tone RU is within the primary 20 MHz.

Parameters:
<Right106toneRu> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "Right 106-Tone RU" on page 44

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SEGMent <SEGMent>

Selects one of the two segments in VHT-80+80 MHz mode with transmission band-
width 80 MHz or 160 MHz. Both segments can only be generated with bandwidth 160
MHz.

This parameter applies to VHT-80+80 MHz Tx mode only.

Parameters:
<SEGMent> SEG0 | SEG1 | BOTH

*RST: SEG0

Example: BB:WLNN:FBL1:SEGM BOTH
Selects both segments.

Manual operation: See " Segment " on page 38

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:SERVice:PATTern <Pattern>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SERVice:PATTern <Pattern>

The command sets the value of the service field. The standard specifies a default
value of 0. Other values can be entered in hexadecimal form for test purposes or future
extensions.

Parameters:
<Pattern> 16 bits

*RST: #H0000,16
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Example: BB:WLNN:FBL5:SERV:PATT #H3F,16
sets the value for the service field.

Manual operation: See " Service Field (hex) " on page 52

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMOothing <SMOothing>

(available for all Tx modes, except VHT)

This command indicates to the receiver whether frequency-domain smoothing is rec-
ommended as part of channel estimation.

Parameters:
<SMOothing> OFF | ON

ON
Indicates that channel estimate smoothing is recommended.
OFF
Indicates that only per-carrier independent channel
(unsmoothed) estimate is recommended.
*RST: 1

Example: BB:WLNN:FBL:SMO ON
switches on smoothing.

Manual operation: See " Smoothing " on page 54

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SSTReam <SStream>

Sets the number of the spatial streams. For physical mode LEGACY, only value 1 is
valid. For Tx Mode "HT-Duplicate", only value 1 is valid. In all other cases, the number
of spatial streams depends on the number of antennas configured with command
SOURce:BB:WLNN:ANTenna:MODE.

Parameters:
<SStream> integer

Range: 1  to  8
*RST: 1

Example: BB:WLNN:FBL5:SSTR 4
Sets the number of spatial streams to 4.

Manual operation: See " Spatial Streams " on page 38

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STBC:STATe?

Queries the status of the space time block coding.

Return values: 
<State> INACtive | ACTive

Example: BB:WLNN:FBL5:STBC:STAT?
Queries the status of the space time block coding.
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Usage: Query only

Manual operation: See " Space Time Block Coding " on page 39

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STSTream <Ststream>

Sets the number of the space time streams. This value depends on the number of spa-
tial streams defined with command SOURce:BB:WLNN:FBLock:SSTReam. Changing
the number of the Spatial Streams immediately changes the value of the Space Time
Streams to the same value.

Parameters:
<Ststream> integer

Range: 1  to  dynamic
*RST: 1

Example: BB:WLNN:FBL5:STBC:STAT?
Queries the status of the space time block coding.

Manual operation: See " Space Time Streams " on page 38

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TDWindowing:STATe <State>

Activates/deactivates the time domain windowing. Time domain windowing is a method
to influence the spectral characteristics of the signal, which is not stipulated by the
standard. However, it does not replace oversampling and subsequent signal filtering.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL5:TDW:STAT ON
Activates the time domain windowing.

Manual operation: See " Time Domain Windowing Active " on page 43

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TTIMe <TTime>

Sets the transition time when time domain windowing is active.

The transition time defines the overlap range of two OFDM symbols. At a setting of 100
ns and if BW = 20 MHz, one sample overlaps.

Parameters:
<TTime> float

Range: 0  to  1000 ns
Increment: 1 ns
*RST: 100 ns

Example: BB:WLNN:FBL5:TTIM 100
Sets the transition time to 100 ns.

Manual operation: See " Transition Time " on page 44
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:UINDex <UIND>

Defines the currently generated user. In activated Multi User MIMO only, one user can
be generated at a time. This parameter selects the generated one out of four available
users.

Parameters:
<UIND> UIDX0 | UIDX1 | UIDX2 | UIDX3

*RST: UIDX0

Example: BB:WLNN:BB:WLNN:FBL1:UIND UIDX1
Selects the generated user with index 1.

Manual operation: See "User Index" on page 39

4.9.2  HE Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BCHG................................................................149
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BDCM................................................................150
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BMCS................................................................150
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BSSColor...........................................................150
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CURPe?............................................................ 151
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DOPPler............................................................ 151
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:LINK.................................................................. 151
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:LOGFile?........................................................... 151
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:LOGGing............................................................152
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAXPe.............................................................. 152
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PED?.................................................................152
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PFORmat...........................................................152
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PFPFactor?........................................................153
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PPUNcturing:BW................................................ 153
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PPUNcturing:STATe............................................ 153
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SPAReuse<st>................................................... 154
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SYMDuration......................................................154
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TXOPduration.....................................................154

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BCHG <BeamChange>

If enabled, the beam is changed between pre-HE and HE modulated fields.

Parameters:
<BeamChange> OFF | ON | 1 | 0

Example: :BB:WLNN:FBL1 BCHG ON
Enables that the beam is changed between the pre-HE and HE
modulated fields.

Manual operation: See "Beam change" on page 44
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BDCM <SIGBDCM>

Enables the use of dual carrier modulation (DCM) in a signal B field.

Parameters:
<SIGBDCM> OFF | ON | 1 | 0

Example: :BB:WLNN:FBL1:BDCM OFF
Disables DCM in the signal B field.

Manual operation: See "SIG-B DCM" on page 45

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BMCS <SIGBMCS>

Sets the modulation and coding scheme (MCS) for the signal B field.

Parameters:
<SIGBMCS> MCS0 | MCS1 | MCS2 | MCS3 | MCS4 | MCS5 | MCS6 | MCS7 |

MCS8 | MCS9 | MCS10 | MCS11 | MCS12 | MCS13 | MCS14 |
MCS15 | MCS16 | MCS17 | MCS18 | MCS19 | MCS20 |
MCS21 | MCS22 | MCS23 | MCS24 | MCS25 | MCS26 |
MCS27 | MCS28 | MCS29 | MCS30 | MCS31 | MCS32 |
MCS33 | MCS34 | MCS35 | MCS36 | MCS37 | MCS38 |
MCS39 | MCS40 | MCS41 | MCS42 | MCS43 | MCS44 |
MCS45 | MCS46 | MCS47 | MCS48 | MCS49 | MCS50 |
MCS51 | MCS52 | MCS53 | MCS54 | MCS55 | MCS56 |
MCS57 | MCS58 | MCS59 | MCS60 | MCS61 | MCS62 |
MCS63 | MCS64 | MCS65 | MCS66 | MCS67 | MCS68 |
MCS69 | MCS70 | MCS71 | MCS72 | MCS73 | MCS74 |
MCS75 | MCS76

Example: :BB:WLNN:FBL1:BMCS MCS1
Sets the SIG-B MCSs to modulation scheme 1.

Manual operation: See "SIG-B MCS" on page 45

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BSSColor <BSSColor>

Sets the BSS color, an identifier of the basic service sets (BSS) field. This parameter
helps to check if a detected frame is coming form an overlapping station.

Parameters:
<BSSColor> integer

Range: 0  to  63
*RST: 0

Example: BB:WLNN:FBL1:BSSC 5
Sets the BSS color to 5.

Manual operation: See "BSS Color" on page 45
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CURPe?

Queries the current PE duration for all users.

Return values: 
<CurrentPe> integer

Range: 0  to  16
*RST: 0

Usage: Query only

Manual operation: See "Cur PE Duration" on page 44

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DOPPler <DOPPLER>

If switched on, the Doppler effect is used for the PPDU.

Parameters:
<DOPPLER> OFF | ON | 1 | 0

Example: :BB:WLNN:FBLock1:DOPP ON
Enables the Doppler effect to be used for the PPDU.

Manual operation: See "Doppler" on page 46

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:LINK <LinkDirection>

Sets the link direction.

Parameters:
<LinkDirection> DOWN | UP

*RST: DOWN

Example: :BB:WLNN:FBL1:LINK DOWN
Set the downlink link direction.

Manual operation: See "Link Direction" on page 43

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:LOGFile?

Queries the fixed file path used for logging the contents of HE-SIG-A and HE-SIG-B
fields, if [:SOURce<hw>]:BB:WLNN:FBLock<ch>:LOGGing is set to ON.

Return values: 
<LogFile> string

Usage: Query only

Manual operation: See "Output File" on page 47
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:LOGGing <LoggingState>

If enabled (ON), the contents of HE-SIG-A and HE-SIG-B fields are written to a file in a
text form. The location of the file can be queried with [:SOURce<hw>]:BB:WLNN:
FBLock<ch>:LOGGing.

Parameters:
<LoggingState> 0 | 1 | OFF | ON

Manual operation: See "Logging State" on page 47

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAXPe <MaxPeDuration>

Sets the maximum packet extension (PE) duration.

Parameters:
<MaxPeDuration> PE0 | PE8 | PE16

PE0: 0 us
PE8: 8 us
PE16: 16 us

*RST: PE0

Example: :BB:WLNN:FBL1:MAXP PE0
Set the maximum packet extension to 0 us.

Manual operation: See "Max PE Duration" on page 43

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PED?

Queries the disambiguity in the number of sybmbols occuring due to the packet exten-
sion.

Return values: 
<PEDisambiguity> integer

Range: 0  to  1
*RST: 0

Usage: Query only

Manual operation: See "PE Disambiguity" on page 46

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PFORmat <PpduFormat>

Sets the PPDU format.

Parameters:
<PpduFormat> SU | MU | SUEXt | TRIG

SU
HE SU (single-user) carries a single PSDU. The HE Signal A
(HE-SIG-A) field is not repeated.
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MU
HE MU (multi-user) carries multiple PSDUs to one or more
users.
SUEXt
Carries a single PSDU. The HE-SIG-A field is repeated.
*RST: SU

Example: :BB:WLNN:FBL1:PFOR SU
Sets the PPDU format to HE single user.

Manual operation: See "PPDU Format" on page 44

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PFPFactor?

Queries the pre-FEC padding factor.

Return values: 
<PreFECPadding> integer

Range: 0  to  3
*RST: 0

Usage: Query only

Manual operation: See "pre-FEC Padding Factor" on page 46

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PPUNcturing:BW <PreamblePuncBw>

Sets the bandwidth mode of preamble puncturing.

Parameters:
<PreamblePuncBw> 4 | 5 | 6 | 7

4|5
Sets the bandwidth mode for HE80 channels.

6|7
Sets the bandwidth mode for HE8080 channels.

*RST: 4

Example: See [:SOURce<hw>]:BB:WLNN:FBLock<ch>:
PPUNcturing:STATe on page 153.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PPUNcturing:STATe <PreamblePunc>

Enables preamble puncturing of the HE MU PPDU in 80 MHz or (80+80)/160 MHz
channels.

Parameters:
<PreamblePunc> 0 | 1 | OFF | ON

*RST: 0
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Example: BB:WLNN:FBL1:TMODe HE8080
BB:WLNN:FBL1:PPUNcturing:STATe 1
BB:WLNN:FBL1:PPUNcturing:BW 6

Manual operation: See "Preamble Puncturing" on page 45

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SPAReuse<st> <SpatialReuse>

Indicates if the spatial reuse is allowed (value set to 1) or not (value set to 0).

Parameters:
<SpatialReuse> integer

Range: 0  to  15
*RST: 0

Manual operation: See "Spatial Reuse" on page 46

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SYMDuration <HeLtfSymDur>

Selects the duration of the HE long training field (LTF).The symbol duration value does
not include the guard interval.

Parameters:
<HeLtfSymDur> SD32 | SD64 | SD128

*RST: SD64

Manual operation: See "HE-LTF Symb Duration" on page 44

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TXOPduration <TXOPDuraion>

If transmission opportunity (TXOP) is set to 127, it indicates no duration information. If
it is set to any other value, it indicates duration information for network allocation vector
(NAV) parameter and that the TXOP is protected.

Parameters:
<TXOPDuraion> integer

Range: 0  to  127
*RST: 127

Example: :BB:WLNN:FBL1:TXOP 127
Sets the transmission opportunity duration to 127.

Manual operation: See "TXOP Duration" on page 45

4.9.3  User Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH1:RUSelection<st>....................................... 155
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH2:RUSelection<st>....................................... 155
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH2:MUNum<st>............................................. 155
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH1:MUNum<st>............................................. 156
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CENRu<st>........................................................156
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:GAIN................................................. 156
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:MUMimo:STATe?................................ 156
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:NSTS................................................ 156
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:RUTYpe?........................................... 157
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:STAid................................................ 157
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:STATe................................................157
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:TXBF.................................................157

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH1:RUSelection<st> <RuSelCh1>

Sets the the resource unit of the first content channel for the respective channel and
station.

Parameters:
<RuSelCh1> RU0 | RU1 | RU2 | RU3 | RU4 | RU5 | RU6 | RU7 | RU8 | RU9 |

RU10 | RU11 | RU12 | RU13 | RU14 | RU15 | RU18 | RU19 |
RU20 | RU21 | RU22 | RU23 | RU24 | RU25 | RU34 | RU35 |
RU36 | RU37 | RU38 | RU16 | RU17 | RU26 | RU27 | RU28 |
RU29 | RU30 | RU31 | RU32 | RU33
*RST: RU34

Manual operation: See "RU Selection" on page 48

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH2:RUSelection<st> <RuSelCh2>

Sets the the resource unit of the second content channel for the respective channel
and station.

Parameters:
<RuSelCh2> RU0 | RU1 | RU2 | RU3 | RU4 | RU5 | RU6 | RU7 | RU8 | RU9 |

RU10 | RU11 | RU12 | RU13 | RU14 | RU15 | RU18 | RU19 |
RU20 | RU21 | RU22 | RU23 | RU24 | RU25 | RU34 | RU35 |
RU36 | RU37 | RU38 | RU16 | RU17 | RU26 | RU27 | RU28 |
RU29 | RU30 | RU31 | RU32 | RU33
*RST: RU34

Manual operation: See "RU Selection" on page 48

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH2:MUNum<st> <MuNumCh2>

Sets the number of MU-MIMO users for each RU and station of the second content
channel.

Parameters:
<MuNumCh2> integer

Range: 0  to  8
*RST: 1

Manual operation: See "Number of MU-MIMO users" on page 48
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CCH1:MUNum<st> <MuNumCh1>

Sets the number of MU-MIMO users for each RU and station of the first content chan-
nel.

Parameters:
<MuNumCh1> integer

Range: 0  to  8
*RST: 1

Manual operation: See "Number of MU-MIMO users" on page 48

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CENRu<st> <Center26toneRU>

For full bandwidth 80 MHz: if enabled, indicates that center 26 -tone RU is allocated
in the common block fields of both SIGB content channels with same value.

For full bandwidth 80+80 MHz: if enabled, indicates that center 26 -tone RU is alloca-
ted for one individual 80 MHz in Common Block fields of both SIGB content channels.

Parameters:
<Center26toneRU> OFF | ON | 1 | 0

Manual operation: See "Center 26-tone RU" on page 48

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:GAIN <Gain>

Sets the user gain.

Parameters:
<Gain> float

Range: -80  to  0
Increment: 0.01
*RST: 0

Manual operation: See "Gain / dB" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:MUMimo:STATe?

Queries if the MU-MIMO is used for current user.

Return values: 
<MuMimoState> 0 | 1 | OFF | ON

*RST: 0

Usage: Query only

Manual operation: See "MU MIMO" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:NSTS <UserNsts>

Sets the number of spatial streams, the number of space time streams minus 1.
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Parameters:
<UserNsts> integer

Range: 1  to  8
*RST: 1

Manual operation: See "Nsts" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:RUTYpe?

Queries the resource unit type for the current user.

Return values: 
<RuType> 26 | 52 | 106 | 242 | 484 | 996 | 2996 | C26

*RST: 242

Usage: Query only

Manual operation: See "RU Type" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:STAid <StaId>

Sets the station ID for the current user, the 11 least significant bits of the association
identifier (AID).

Parameters:
<StaId> integer

Range: 0  to  2047
*RST: 1

Manual operation: See "STA Id" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:STATe <UserState>

Switches the current user on and off.

Parameters:
<UserState> 0 | 1 | OFF | ON

*RST: 1

Manual operation: See "State" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:USER<di>:TXBF <TXBF>

If switched on, indicates that the beamforming matrix is applied to the waveform.

Parameters:
<TXBF> 0 | 1 | OFF | ON

Manual operation: See "TxBF" on page 49
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4.9.4  MPDU Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU:COUNt.................................. 158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:COUNt.................................................... 158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:DSELection............ 158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:DSELection.............................. 158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:LENGth..................159
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:LENGth....................................159
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:PATTern................. 159
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:PATTern................................... 159
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:SOURce.................159
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:SOURce...................................159
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU:EOF...................................... 160
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:EOF........................................................ 160

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU:COUNt <Count>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:COUNt <Count>

Determines the number of MPDUs in the frame.

Parameters:
<Count> integer

Range: 1  to  64
*RST: 1

Example: BB:WLNN:FBL1:MPDU:COUN 3
Determines the number of MPDUs in the frame.

Manual operation: See "Number of MPDUs" on page 55

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:
DSELection <Filename>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:DSELection
<Filename>

Selects the data list for the DLISt data source selection.

The lists are stored as files with the fixed file extensions *.dm_iqd in a directory of the
user's choice.

Parameters:
<Filename> string

Example: BB:WLNN:FBL1:MPDU1:DATA DLIS
Selects the Data Lists data source.
MMEM:CDIR '<root>Lists'
Selects the directory for the data lists.
BB:WLNN:FBL1:MPDU1:DATA:DSEL 'dlist1'
Selects the 'dlist1' as the data source. This file must be in the
directory specified above. It must have the file extension
*.dm_iqd.

Manual operation: See "DList / Pattern" on page 56
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:LENGth
<Length>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:LENGth <Length>

Determines the size of the data field in bytes.

Parameters:
<Length> integer

Range: 0  to  16384
*RST: 1024

Example: BB:WLNN:FBL1:MPDU1:DATA:LENG 1024
Determines the size of the data field.

Manual operation: See "Data Length / bytes " on page 56

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:PATTern
<Pattern>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:PATTern <Pattern>

Determines the bit pattern for the PATTern selection.

Parameters:
<Pattern> 64 bits

*RST: #H0,1

Example: BB:WLNN:FBL1:MPDU1:DATA:PATT #B0101,4
Sets the bit pattern.

Manual operation: See "DList / Pattern" on page 56

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU<st>:DATA:SOURce
<Source>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:SOURce <Source>

Selects the data source.

Parameters:
<Source> ZERO | ONE | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
PNxx
The pseudo-random sequence generator is used as the data
source. Different random sequence lengths can be selected.
DLISt
A data list is used. The data list is selected with the command
BB:WLNN:FBL<ch>:MPDU<st>:DATA:DSEL
ZERO | ONE
Internal 0 or 1 data is used.
PATTern
Internal data is used. The bit pattern for the data is defined by
the command BB:WLNN:FBL<ch>:MPDU<st>:DATA:PATT.
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*RST: PN9

Example: BB:WLNN:FBL1:MPDU1:DATA:SOUR PATT
Selects the data source.

Manual operation: See "Data" on page 56

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MPDU:EOF <EOF>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:EOF <EOF>

Sets the EOF value for the A-MPDU.

Parameters:
<EOF> DEFault | E0 | E1

*RST: DEFault

Manual operation: See "EOF" on page 55

4.9.5  MAC Header Configuration

4.9.5.1  Common Fields Commands

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:ADDRess<st>...........................161
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st>.............................................161
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:ADDRess<st>:STATe................ 161
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st>:STATe.................................. 161
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:DID..........................................162
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:DID............................................................162
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:BSSid........................................................ 162
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol................................. 162
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol................................................... 162
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:FDS.......................... 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:FDS............................................ 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:MDATa...................... 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MDATa........................................ 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:MFRagments............. 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MFRagments............................... 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:ORDer...................... 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:ORDer........................................ 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:PMANagement...........163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PMANagement.............................163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:PVERsion..................163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PVERsion....................................163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:RETRy...................... 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:RETRy........................................ 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:SUBType...................163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:SUBType.....................................163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:TDS.......................... 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TDS............................................ 163
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:TYPE........................ 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TYPE.......................................... 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:WEP......................... 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:WEP........................................... 163
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SA.............................................................164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCS:STATe.............................. 164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCS:STATe................................................ 164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:QSControl................................ 164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl..................................................164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:QSControl:STATe......................164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl:STATe........................................164
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:FRAGment:

INCRement......................................................................................................... 165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:INCRement................ 165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:FRAGment:STARt......165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:STARt........................165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:SEQuence:

INCRement......................................................................................................... 165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:INCRement.................165
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:SEQuence:STARt...... 166
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:STARt........................ 166
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:STATe....................... 166
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:STATe......................................... 166
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:STATe......................................166
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:STATe........................................................166

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:ADDRess<st>
<Address>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st> <Address>

The command enters the value of the address fields 1 ... 4. Exactly 48 bits must be
entered. Each address is 6 bytes (48 bit) long. The addresses can be entered in hexa-
decimal form in the entry field of each address field. The least significant byte (LSB) is
in left notation.

Parameters:
<Address> integer

Range: #H000000000000,48  to  #HFFFFFFFFFFFF,48
*RST: #H000000000000,48

Example: BB:WLNN:FBL1:MAC:ADDR2 #H124836C7EA54,48
set the value for address field 2.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:ADDRess<st>:STATe
<State>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st>:STATe <State>

The command activates/deactivates the selected address field.
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Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:FBL1:MAC:ADDR2:STAT ON
activates generation of address field 2.

Manual operation: See " MAC Address " on page 59

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:DID <Did>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:DID <Did>

The command enters the value of the duration ID field. Depending on the frame type,
the 2-byte field Duration/ID is used to transmit the association identity of the station
transmitting the frame or it indicates the duration assigned to the frame type. Exactly
16 bit must be entered.

Parameters:
<Did> integer

Range: #H0000,16  to  #HFFFF,16
*RST: #H0000,16

Example: BB:WLNN:FBL1:MAC:DID #HA5A5,16
sets the value of the duration ID field.

Manual operation: See " Duration Id " on page 59

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:BSSid <Bssid>

Sets the value of the basic service set identification (BSSID) field.

Parameters:
<Bssid> integer

Example: BB:WLNN:FBL1:MAC:BSS #H124836C7EA54,48
Sets the value of the BSSID field to 124836C7EA54

Manual operation: See "BSSID (hex)" on page 59

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol <FControl>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol <FControl>

The command enters the value of the frame control field. The frame control field has a
length of 2 bytes (16 bits) and is used to define the protocol version, the frame type,
and its function, etc.. As an alternative, the individual bits can be set with the following
commands.

Parameters:
<FControl> integer

Range: #H0000,16  to  #HFFFF,16
*RST: #H0000,16
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Example: BB:WLNN:FBL1:MAC:FCON #H100A,16
sets the value of the frame control field.

Manual operation: See " Frame Control " on page 58

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:FDS <Fds>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:FDS <Fds>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:MDATa

<MData>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MDATa <MData>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:

MFRagments <MFragments>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MFRagments

<MFragments>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:ORDer

<Order>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:ORDer <Order>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:

PMANagement <PManagement>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PMANagement

<PManagement>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:PVERsion

<PVersion>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PVERsion <PVersion>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:RETRy

<Retry>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:RETRy <Retry>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:SUBType

<Subtype>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:SUBType <Subtype>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:TDS <Tds>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TDS <Tds>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:TYPE

<Type>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TYPE <Type>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCONtrol:WEP <Wep>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:WEP <Wep>

The command enters the value of the individual bits of the frame control field.

Parameters:
<Wep> integer

Range: #H0,1  to  #H1,1
*RST: #H0,1

Example: BB:WLNN:FBL1:MAC:FCON:MDAT #H1,1
sets the value of the More Data bit.

Manual operation: See " Frame Control " on page 58
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SA <Sa>

Sets the value of the source address (SA) field.

Parameters:
<Sa> integer

Example: BB:WLNN:FBL1:MAC:SA #HFFFFFFFFFFFF,48
Sets the value of the SA field to FFFFFFFFFFFF.

Manual operation: See "SA (hex)" on page 59

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:FCS:STATe <State>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCS:STATe <State>

Activates/deactivates the calculation of the FCS (frame check sequence). The stan-
dard defines a 32-bit (4-byte) checksum to protect the MAC header and the user data
(frame body).

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:FBL1:MAC:FCS:STAT ON
activates the calculation of the FCS.

Manual operation: See " FCS (checksum) " on page 57

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:QSControl
<QsControl>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl <QsControl>

Sets the value for the QoS control field.

Parameters:
<QsControl> integer

Range: #H0000,16  to  #HFFFF,16

Example: BB:WLNN:FBL1:MAC:QSC #H5A5A,16
Sets the value for the QoS field to#H5A5A,16.

Manual operation: See " QoS Control " on page 73

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:QSControl:STATe
<State>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl:STATe <State>

The command enables/disables the QoS control.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: ON
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Example: BB:WLNN:FBL1:MAC:QSC:STAT ON
enables the QoS control.

Manual operation: See " QoS Control " on page 73

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:FRAGment:
INCRement <Increment>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:INCRement
<Increment>

Defines the number of packets required to increment the counter of the fragment bits of
the sequence control.

Parameters:
<Increment> integer

Range: 0  to  1024
*RST: 1

Example: BB:WLNN:FBL1:MAC:SCON:FRAG:INCR 2
two packets are required to increment the counter of the frag-
ment bits.

Manual operation: See " Increment Every " on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:FRAGment:
STARt <Start>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:STARt
<Start>

The command enters the start number of the fragment bits of the sequence control.

Parameters:
<Start> integer

Range: #H0,4  to  #HF,4
*RST: #H0,4

Example: BB:WLNN:FBL1:MAC:SCON:FRAG:STAR #H4,4
sets the start value of the fragment bits of the sequence control.

Manual operation: See " Start Number " on page 60

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:SEQuence:
INCRement <Increment>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:INCRement
<Increment>

Defines the number of packets required to increment the counter of the sequence bits
of the sequence control.
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Parameters:
<Increment> integer

Range: 0  to  1024
*RST: 1

Example: BB:WLNN:FBL1:MAC:SCON:FRAG:INCR 2
two packets are required to increment the counter of the
sequence bits.

Manual operation: See " Increment Every " on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:SEQuence:
STARt <Start>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:STARt
<Start>

The command enters the start number of the fragment bits of the sequence control.

Parameters:
<Start> integer

Range: #H000,12  to  #HFFF,12
*RST: #H000,12

Example: BB:WLNN:FBL1:MAC:SCON:SEQ:STAR #H444,12
sets the start value of the sequence bits of the sequence control.

Manual operation: See " Start Number " on page 60

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:SCONtrol:STATe
<State>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:STATe <State>

The command activates/deactivates the sequence control.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:FBL1:MAC:SCON:STAT ON
activates the sequence control field.

Manual operation: See " Sequence Control " on page 60

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:STATe <State>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:STATe <State>

The command activates/deactivates the generation of the MAC Header.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0
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Example: BB:WLNN:FBL1:MAC:STAT ON
activates the generation of the MAC Header.

Manual operation: See " MAC Header " on page 57

4.9.5.2  MAC Header HT Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl.................................................. 167
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ACConstraint.............................. 167
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:POSition...................168
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:SEQuence................168
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CSISteering................................ 168
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:FREQuest.................................. 169
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:VHTControl:HVINdicator?.......... 169
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:HVINdicator?.............................. 169
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:LAControl................................... 169
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:NDP...........................................170
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:RDGMore...................................170
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:REServed...................................171
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:SREServed.................................171
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HTControl:STATe...................... 171
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:STATe........................................ 171
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ZLF............................................172

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl <HtControl>

Sets the value for the HT control field.

Parameters:
<HtControl> integer

Range: #H00000000,32  to  #HFFFFFFFF,32
*RST: #H00000000,32

Example: BB:WLNN:FBL1:MAC:HTC #H5a5a5a5a,32
Sets the value for the HT control field to #H5a5a5a5a,32.

Manual operation: See " HT/VHT/HE Control " on page 74

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ACConstraint
<AcConstraint>

Sets the value for the AC signal field.

0 = The response may contain data from any TID (Traffic Identifier).

1 = The response may contain data only from the same AC as the last Data received
from the initiator.

Parameters:
<AcConstraint> integer

Range: #H0,1  to  #H1,1
*RST: 0
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Example: BB:WLNN:FBL1:MAC:HTC:ACC #H0,1
Sets the AC signal field to 0 (The response may contain data
from any TID)

Manual operation: See " AC Constraint " on page 75

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:POSition
<Position>

Sets the value for the calibration position.

00 = Not a calibration frame (Default setting)

01 = Calibration Start

10 = Sounding Response

11 = Sounding Complete

Parameters:
<Position> integer

Range: #H0,2  to  #H3,2

Example: BB:WLNN:FBL1:MAC:HTC:CAL:POS #H0,2
Sets the calibration position signal field to 00 (not a calibration
frame).

Manual operation: See " Calibration Position " on page 76

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:SEQuence
<Sequence>

Sets the value for the calibration sequence.

Parameters:
<Sequence> integer

Range: #H0,2  to  #H3,2

Example: BB:WLNN:FBL1:MAC:HTC:CAL:SEQ #H3,2
Sets the value for the calibration sequence.

Manual operation: See " Calibration Sequence " on page 76

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CSISteering
<CsiSteering>

Sets the value for the CSI steering.

00 = CSI

01 = uncompressed Steering Matrix

10 = compressed Steering Matrix

11 = Reserved
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Parameters:
<CsiSteering> integer

Range: #H0,2  to  #H3,2

Example: BB:WLNN:FBL1:MAC:HTC:CSIS #H1,2
Sets the value for the CSI steering to 01 (uncompressed Steer-
ing Matrix).

Manual operation: See " CSI Steering " on page 75

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:FREQuest <FRequest>

Sets the value for the feedback request.

00 = no request

01 = unsolicited feedback only

10 = immediate feedback

11 = aggregated feedback

Parameters:
<FRequest> integer

Range: #H0,2  to  #H3,2

Example: BB:WLNN:FBL1:MAC:HTC:FREQ #H2,2
Sets the value for the feedback request to 10 (immediate feed-
back).

Manual operation: See " Reserved " on page 75

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:VHTControl:
HVINdicator?

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:HVINdicator?
The command queries the used format (HT or VHT).

Return values: 
<HTVHT> integer

Example: BB:WLNN:FBL:MAC:HTC:HVIN?
Response: 1
HT format is used.

Usage: Query only

Manual operation: See " HT/VHT " on page 77

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:LAControl <LaControl>

Sets the value for the link adaption control.

B0 (1bit) MA - MA payload
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When the MA field is set to 1, the payload of the QoS Null Data MPDU is interpreted as
a payload of the management action frame.

B1 (1bit) TRQ - Sounding Request

1 = Request to the responder to transmit a sounding PPDU.

B2 (1bit) MRQ - MCS Request

1 = Request for feedback of MCS.

B3-B5 (3bit) MRS - MRQ Sequence Identifier

Set by sender to any value in the range '000'-'110' to identify MRQ. = Invalid if MRQ =
0

B6-B8 (3bit) MFS - MFB Sequence Identifier

Set to the received value of MRS. Set to '111' for unsolicited MFB.

B9-B15 (7bit) MFB - MCS Feedback

Link adaptation feedback containing the recommended MCS. When a responder is
unable to provide MCS feedback or the feedback is not available, the MFB is set to 'all-
ones' (default value) and also MFS is set to '1'.

Parameters:
<LaControl> integer

Range: #H0000,16  to  #HFFFF, 16

Example: BB:WLNN:FBL1:MAC:HTC:LAC #H5A5A,16
Sets the value for the link adaption control to #H5A5A,16.

Manual operation: See " Link Adaption Control " on page 76

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:NDP <Ndp>

Sets the value of the Null Data Packet (NDP) announcement.

0 = no NDP will follow

1 = NDP will follow

Parameters:
<Ndp> integer

Example: BB:WLNN:FBL1:MAC:HTC:NDP #H1,1
Sets the value for the NDP announcement to 1 (NDP will follow).

Manual operation: See " NDP Announcement " on page 75

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:RDGMore <RdgMore>

Sets the value for the RDG/More PPDU.

Transmitted by Initiator

0 = No reverse grant.
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1 = A reverse grant is present, as defined by the Duration/ID field.

Transmitted by Responder

0 = The PPDU carrying the MPDU is the last transmission by the responder.

1 = The PPDU carrying the frame is followed by another PPDU.

Parameters:
<RdgMore> integer

Range: #H0,1  to  #H1,1

Example: BB:WLNN:FBL1:MAC:HTC:RDGM #H0,1
Sets the value for the RDG/More PPDU to #H0,1.

Manual operation: See " RDG/More PPDU " on page 74

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:REServed <Reserved>

This signal field is currently defined, but not used. It is set to zero by the transmitter
and ignored by the receiver.

Parameters:
<Reserved> integer

Range: #H0,5  to  #H5,2

Manual operation: See " Reserved " on page 75

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:SREServed <Reserved>

This signal field is currently defined, but not used.

Parameters:
<Reserved> integer

Manual operation: See " Reserved " on page 75

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HTControl:STATe
<State>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:STATe <State>

The command enables/disables HT Control.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:FBL1:MAC:HTC:STAT ON
enables HT Control.

Manual operation: See " HT/VHT/HE Control " on page 74
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ZLF <Zlf>

Sets the value for the ZLF announcement.

0 = no ZLF will follow

1 = ZLF will follow

Parameters:
<Zlf> integer

Range: #H0,1  to  #H1,1

Example: BB:WLNN:FBL1:MAC:HTC:ZLF #H1,1
Sets the value for the ZLF announcement to 1 (ZLF will follow).

Manual operation: See " NDP Announcement " on page 75

4.9.5.3  MAC Header VHT Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl................................................ 172
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:ACConstraint............................ 173
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:CTYPe.....................................173
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:FTTYpe....................................173
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:GIDH....................................... 174
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:HVINdicator?............................ 174
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MFB........................................ 174
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MGL........................................ 175
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MRQ........................................175
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MSI..........................................175
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:RDGMore.................................176
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:UMFB...................................... 176
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:VREServed.............................. 176

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl <VHTContol>

The command sets the value for the VHT control field.

Parameters:
<VHTContol> integer

Range: #H00000000,32  to  #HFFFFFFFF,32
*RST: #H00000000,32

Example: BB:WLNN:FBL1:MAC:VHTC #H5a5a5a5a,32
sets the value for the VHT control field.

Manual operation: See " HT/VHT/HE Control " on page 74
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:ACConstraint
<VhtAcConstraint>

The command sets the value for the AC signal field. It indicates the access point of the
responder (1 bit).

Parameters:
<VhtAcConstraint> integer

0
The response may contain data from any TID (Traffic Identifier)
1
The response may contain data only from the same AC as the
last data received from the initiator.

Example: BB:WLNN:FBL:MAC:VHTC:ACC 0
the response may contain data from any TID.

Manual operation: See " AC Constraint " on page 77

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:CTYPe <CTYPe>

The command sets the coding information. If the Unsolicited MFB subfield is set to 1,
the Coding Type subfield contains the Coding information (set to 0 for BCC and set to
1 for LDPC) to which the unsolicited MFB refers.

Parameters:
<CTYPe> integer

0
BCC
1
LDPC

Example: BB:WLNN:FBL:MAC:VHTC:CTYP 1
sets the coding information for LPDC.

Manual operation: See " Coding Type " on page 78

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:FTTYpe <FbTxType>

The command sets the FB Tx Type subfield.

0 = If the Unsolicited MFB subfield is set to 1 and FB Tx Type subfield is set to 0, the
unsolicited MFB refers to either an unbeamformed VHT PPDU or transmit diversity
using an STBC VHT PPDU.

1 = If the Unsolicited MFB subfield is set to 1 and the FB Tx Type subfield is set to 1,
the unsolicited MFB refers to a beamformed SU-MIMO VHT PPDU.

Otherwise this subfield is reserved.

Parameters:
<FbTxType> integer
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Example: BB:WLNN:FBL1:PAID:FTTY #B1,1
sets the FTTY subfield.

Manual operation: See " FB Tx Type " on page 78

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:GIDH <GIDH>

Sets GID-H subfield. If the Unsolicited MFB subfield is set to 1, the GID-H subfield con-
tains the highest 3 bits of Group ID of the PPDU to which the unsolicited MFB refers.

Otherwise this subfield is reserved.

Parameters:
<GIDH> integer

*RST: #H0

Example: BB:WLNN:FBL:MAC:VHTC:GIDH #B111,3
sets the coding information for GID-H.

Manual operation: See " GID-H " on page 78

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:HVINdicator?

Queries the used format (HT or VHT). The command returns 0 for the HT format and 1
for the VHT format.

Return values: 
<HtVhtIndicator> integer

Example: BB:WLNN:FBL:MAC:VHTC:HVIN?
Response: 1
VHT format is used.

Usage: Query only

Manual operation: See " HT/VHT " on page 80

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MFB <Mfb>

The command sets the MFB subfield. This subfield contains the recommended MFB.
The value of MCS=15 and VHT N_STS=7 indicates that no feedback is present.

See also Table 3-4 for definition of the MFB subfield.

Parameters:
<Mfb> integer

Example: BB:WLNN:FBL:MAC:VHTC:MFB #B111111111111111,15
sets the information for the MFB subfield.

Manual operation: See " MFB " on page 78

Frame Configuration Settings



Remote-Control CommandsIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

175Operating Manual 1178.6985.02 ─ 23

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MGL <MfsiGidL>

The command determines the information of the MFSI/GID-L subfield.

MFB = 0

If the Unsolicited MFB subfield is set to 0, the MFSI/GID-L subfield contains the
received value of MSI contained in the frame to which the MFB information refers.

MFB = 1

The MFSI/GID-L subfield contains the lowest 3 bits of Group ID of the PPDU to which
the unsolicited MFB refers.

Parameters:
<MfsiGidL> integer

Example: BB:WLNN:FBL:MAC:VHTC:MGL #B111,3
sets the information for the MFSI/GID-L subfield.

Manual operation: See " MFSI/GID-L " on page 79

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MRQ <Mrq>

The command determines the information of the MRQ subfield.

Parameters:
<Mrq> integer

0
requests MCS feedback (solicited MFB).
1
otherwise

Example: BB:WLNN:FBL:MAC:VHTC:MRQ #B1,1
sets the information for the MRQ subfield.

Manual operation: See " MRQ " on page 79

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MSI <Msi>

The command sets the MSI subfield.

MRQ = 0

When the MRQ subfield is set to 0, the MSI subfield is reserved.

MRQ = 1

When the MRQ subfield is set to 1, the MSI subfield contains a sequence number in
the range 0 to 6 that identifies the specific request.

Parameters:
<Msi> integer

Example: BB:WLNN:FBL:MAC:VHTC:MSI #B111,3
sets the information for the MFSI/GID-L subfield.
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Manual operation: See " MSI " on page 79

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:RDGMore
<VhtRdgMore>

The command issues the reverse direction grant. When transmitted by an initiator or a
responder, this field is interpreted differently.

Transmitted by Initiator

0 = No reverse grant.

1 = A reverse grant is present, as defined by the Duration/ID field.

Transmitted by Responder

0 = The PPDU carrying the MPDU is the last transmission by the responder.

1 = The PPDU carrying the frame is followed by another PPDU.

Parameters:
<VhtRdgMore> integer

Example: BB:WLNN:FBL:MAC:HTC #H80000000,32
BB:WLNN:FBL:MAC:VHTC:RDGM #B1,1
sets the value for the RDG/More PPDU.

Manual operation: See " RDG/More PPDU " on page 77

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:UMFB
<UnsolicitedMfb>

The command sets the Unsolicited MFB subfield.

Parameters:
<UnsolicitedMfb> integer

0
if the MFB is a response to an MRQ.
1
if the MFB is not a response to an MRQ.

Example: BB:WLNN:FBL:MAC:VHTC:UMFB #B1,1
sets the information for the UMFB subfield.

Manual operation: See " Unsolicited MFB " on page 78

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:VREServed
<VhtReserved>

This signal field is currently defined, but not used. It is set to zero by the transmitter
and ignored by the receiver.

Parameters:
<VhtReserved> integer
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Manual operation: See " Rsv " on page 80

4.9.5.4  MAC Header HE Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HEControl................................ 177
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HEControl:ACONtrol................. 177
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HEControl:HEINdicator?............ 177

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HEControl
<HEControl>

Sets the value with the length of 4 bytes of the HE control field.

Parameters:
<HEControl> integer

Manual operation: See " HT/VHT/HE Control " on page 74

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HEControl:ACONtrol
<AggregatedCtrl>

Sets the value for the aggregated control field. The length of this value may vary
according to the selected control ID subfield.

Parameters:
<AggregatedCtrl> integer

Manual operation: See " Aggregated control " on page 80

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:MAC:HEControl:
HEINdicator?

Indicates the use of the HE format, if [:SOURce<hw>]:BB:WLNN:FBLock<ch>[:
USER<di>]:MAC:VHTControl:HVINdicator? is set to 1. The command returns 1
if the HE format is used and 0 if not.

Return values: 
<HEIndicator> integer

Usage: Query only

Manual operation: See " HE " on page 80

4.9.5.5  Trigger Frame Settings

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:BW......................... 178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:CINDication............. 178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:CSRequired............. 178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:DOPPler..................178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:GILTf.......................178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:HREServed..............178
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:LEN........................ 178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:LESSeg...................178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:MLTFmode.............. 178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:NHLSym..................178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:PEXTension............. 178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:RSV........................ 178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:SPAReuse............... 178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:STBC...................... 178
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:TTYPe?...................179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:TXPow.................... 179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:NUINfo.............................. 179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:AID................. 179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:CODType........ 179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:DCM............... 179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:MCS............... 179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:RSV................179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:RUALlocation...179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:SSALlocation... 179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:TDUSerinfo......179
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:TRSSi............. 179

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:BW <BW>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:

CINDication <CascadeInd>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:

CSRequired <CSRequired>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:DOPPler

<Doppler>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:GILTf

<GILTF>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:

HREServed <HESIGAReserved>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:LEN

<Length>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:LESSeg

<LDPCExtSymSeg>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:MLTFmode

<MUMIMOLTFMode>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:NHLSym

<NumHeLtfSym>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:

PEXTension <PacketExtension>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:RSV

<Reserved>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:SPAReuse

<SpatialReuse>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:STBC

<STBC>
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:TTYPe?
[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:CINFo:TXPow

<APTxPower>

Sets the value bits of the common info field.

Parameters:
<APTxPower> 6 bits

Manual operation: See "AP Tx Power" on page 69

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:NUINfo
<NoUserInfo>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:AID
<AID12>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
CODType <CodingType>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:DCM
<DCM>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:MCS
<MCS>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:RSV
<Reserved>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
RUALlocation <RUAllocation>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
SSALlocation <SSAllocation>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
TDUSerinfo <TrigDepUserInfo>

[:SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:UINFo<st0>:
TRSSi <TargetRssi>

Sets the value bits of the user info field.

You can configure the user info for up to 37 users with the command [:
SOURce<hw>]:BB:WLNN:FBLock<ch>[:USER<di>]:TFConfig:NUINfo.

Parameters:
<TargetRssi> 7 bits

Manual operation: See "Target RSSI" on page 72

4.9.6  Beacon Configuration

4.9.6.1  General Beacon Functions

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:BINTerval...................................180
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:DCCHannel?..............................180
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:IAWindow.................................. 180

Frame Configuration Settings



Remote-Control CommandsIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

180Operating Manual 1178.6985.02 ─ 23

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SRATe....................................... 180
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SSID......................................... 181
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:TSTamp.....................................181

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:BINTerval <BInterval>

Defines the time interval between two beacon transmissions.

Parameters:
<BInterval> float

Range: 0  to  65
Increment: 1E-9
*RST: 0.1
Default unit: s

Example: BB:WLNN:FBL1:BFC:BINT 200ms
Sets the time interval between two beacon transmissions to 200
ms.

Manual operation: See "Beacon Interval" on page 63

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:DCCHannel?

Queries the current channel of the DSSS network.

Return values: 
<DCCHannel> integer

Example: BB:WLNN:FBL1:BFC:DCCH?
Usage: Query only

Manual operation: See "DSSS(Current Channel)" on page 63

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:IAWindow <IAWindow>

Sets the parameters necessary to support an IBSS (2 bytes). The Information field
contains the ATIM Window parameter.

Parameters:
<IAWindow> integer

*RST: #H0000

Example: BB:WLNN:FBL1:BFC:IAW #HFFFF,16

Manual operation: See "IBSS(ATIM Window) (hex)" on page 63

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SRATe <SRATe>

Determines a set of data rates that are supported by the access point (Supported
Rates field).

Parameters:
<SRATe> integer
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Example: BB:WLNN:FBL1:BFC:SRAT #H06090C1218243036,64
Determines the following set of supported data rates: Hex num-
bers 06 09 0C 12 18 24 30 36.
This means: 6 Mbps, 9 Mbps, 12 Mbps, 18 Mbps, 24 Mbps, 36
Mbps, 48 Mbps and 54 Mbps are supported by the access point.

Manual operation: See "Supported Rates" on page 63

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SSID <Ssid>

Specifies the desired SSID or the wildcard SSID.

Parameters:
<Ssid> string

Range: 0 char  to  32 char

Example: BB:WLNN:FBL1:BFC:SSID "Rohde&Schwarz"
Sets the SSID to "Rohde&Schwarz".

Manual operation: See "SSID" on page 63

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:TSTamp <TStamp>

Sets the value of the TSF timer (Timing Synchronization Function of a frame’s source).

Parameters:
<TStamp> integer

Example: BB:WLNN:FBL1:BFC:TST #H1414AFAE891254BC, 64
Sets the value of the TSF timer to 1414AFAE891254BC.

Manual operation: See "Timestamp (hex)" on page 63

4.9.6.2  Capability Information Parameters

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:APSD........................ 182
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CAGility..................... 182
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CPOLlable................. 182
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CPRequest................ 182
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:ESS...........................183
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:IBACk........................183
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:IBSS..........................183
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:DBACk...................... 184
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:DOFDm..................... 184
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:PBCC........................ 184
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:PRIVacy.....................184
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:QOS..........................185
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:RMEasurement...........185
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SMGMt...................... 185
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SPReamble................186
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SSTime......................186
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:GFIeld....................186
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:STATe.................... 186

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:APSD
<CAPSd>

Informs the associated stations if automatic power save delivery (APSD, energy saving
function) is supported.

Parameters:
<CAPSd> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBLock1:BFC:CAP:APSD ON
Informs the associated stations that automatic power save deliv-
ery (APSD, energy saving function) is supported.

Manual operation: See "Capability Information Parameters" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CAGility
<CCAGility>

Informs the associated stations if channel agility is used.

Parameters:
<CCAGility> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:CAG ON

Manual operation: See "Capability Information Parameters" on page 64

Informs the associated stations that channel agility is used.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CPOLlable
<CCPollable>

Informs the associated stations if contention free is pollable.

Parameters:
<CCPollable> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:CPOL ON
Informs the associated stations that contention free is pollable.

Manual operation: See "Capability Information Parameters" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CPRequest
<CCPRequest>

Indicates if contention free poll (CF-poll) is requested.
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Parameters:
<CCPRequest> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:CPR ON
Tells the associated stations that contention free poll (CF-poll) is
requested.

Manual operation: See "Capability Information Parameters" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:ESS
<CESS>

Informs the associated stations if the network is an ESS type network.

Parameters:
<CESS> 0 | 1 | OFF | ON

*RST: 1

Example: BB:WLNN:FBL1:BFC:CAP:ESS ON
Informs the associated stations that the network is an ESS type
network.

Manual operation: See "Capability Information Parameters" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:IBACk
<IBACk>

Informs the associated stations if immediate block Ack is allowed.

Parameters:
<IBACk> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:IBACk ON
Informs the associated stations that immediate block Ack is
allowed.

Manual operation: See "Capability Information Parameters" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:IBSS
<CIBSs>

Informs the associated stations if the network is an IBSS type network.

Parameters:
<CIBSs> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:IBSS ON
Informs the associated stations that the network is an IBSS type
network.

Frame Configuration Settings



Remote-Control CommandsIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

184Operating Manual 1178.6985.02 ─ 23

Manual operation: See "Capability Information Parameters" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:DBACk
<CDBAck>

Informs the associated stations if delayed block Ack is allowed.

Parameters:
<CDBAck> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:DBAC ON
Informs the associated stations that delayed block Ack is
allowed.

Manual operation: See "Capability Information Parameters" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:DOFDm
<CDOFdm>

Indicates if Direct Sequence Spread Spectrum - OFDM is allowed.

Parameters:
<CDOFdm> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:DOFD

Manual operation: See "Capability Information Parameters" on page 64

Informs the associated stations that Direct Sequence Spread Spectrum - OFDM is
allowed.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:PBCC
<PBCC>

Informs the associated stations if PBCC is allowed.

Parameters:
<PBCC> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:PBCC ON

Manual operation: See "Capability Information Parameters" on page 64

Informs the associated stations that PBCC is allowed.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:PRIVacy
<PRIVacy>

Informs the associated stations if encryption is required for all data frames.
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Parameters:
<PRIVacy> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:PRIV ON

Manual operation: See "Capability Information Parameters" on page 64

Informs the associated stations that encryption is required for all data frames.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:QOS
<QOS>

Informs the associated stations if quality of service (QoS) is supported.

Parameters:
<QOS> 0 | 1 | OFF | ON

*RST: 0

Example: SOUR:BB:WLNN:FBL1:BFC:CAP:QOS ON
Informs the associated stations that quality of service (QoS) is
supported.

Manual operation: See "Capability Information Parameters" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:
RMEasurement <RMEasurement>

Informs the associated stations if radio measurement is supported.

Parameters:
<RMEasurement> 0 | 1 | OFF | ON

*RST: 0

Example: SOUR:BB:WLNN:FBL1:BFC:CAP:RME ON

Manual operation: See "Capability Information Parameters" on page 64

Informs the associated stations that radio measurement is supported.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SMGMt
<SMGMt>

Informs the associated stations if spectrum management is enabled.

Parameters:
<SMGMt> 0 | 1 | OFF | ON

*RST: 0

Example: SOUR:BB:WLNN:FBL1:BFC:CAP:SMGM ON
Informs the associated stations that spectrum management is
enabled.

Manual operation: See "Capability Information Parameters" on page 64
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SPReamble
<SPReamble>

Informs the associated stations if short preamble is allowed.

Parameters:
<SPReamble> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:SPR ON

Manual operation: See "Capability Information Parameters" on page 64

Informs the associated stations that short preamble is allowed.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SSTime
<SSTime>

Informs the associated stations if short slot time is supported.

Parameters:
<SSTime> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAPability:SST ON
Informs the associated stations that short slot time is supported.

Manual operation: See "Capability Information Parameters" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:GFIeld
<GreenField>

Enables/disables the support for the reception of PPDUs with HT Greenfield format.

Parameters:
<GreenField> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "Green Field" on page 66

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:STATe
<State>

Activates/ deactivates the HT capability information element.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "State" on page 66
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4.9.6.3  ERP Parameters

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:BPMode.............................187
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:NEPResent........................ 187
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:UPRotection....................... 187

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:BPMode
<EBPMode>

Informs associated stations whether to use the long or the short preamble.

Parameters:
<EBPMode> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:ERP:BPM ON
Informs associated stations that they should use the long pream-
ble.

Manual operation: See "ERP Parameters" on page 66

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:NEPResent
<ENEPresent>

Sets Non-ERP Present on. This is needed if there is a non-ERP MU associated to the
AP.

Parameters:
<ENEPresent> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:ERP:NEPR ON
Sets on Non-ERP Present.

Manual operation: See "ERP Parameters" on page 66

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:UPRotection
<EUPRotection>

Informs associated stations if they have to use protection.

Parameters:
<EUPRotection> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:ERP:UPR ON
Informs associated stations that they have to use protection.

Manual operation: See "ERP Parameters" on page 66
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4.9.7  Spatial Mapping Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:MODE............................................... 188
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:TSHift<st>..........................................188
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:INDex................................................ 189
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:I?........................ 189
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:Q?.......................189

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:MODE <Mode>

Selects the spatial mapping mode for the selected frame block. Except of the beam-
forming mode, the matrix element values are loaded by using info class methods.

Parameters:
<Mode> OFF | DIRect | EXPansion | BEAMforming | INDirect

OFF
(only "LEGACY" mode)
The spatial mapping mode is switched off automatically.
DIRect
(only active with physical modes MIXED MODE or GREEN
FIELD when NTX = NSTS)
The transmit matrix is a CSD matrix, that is, diagonal matrix of
unit magnitude and complex values that represent cyclic shifts in
the time domain.
EXPansion
(only active with physical modes MIXED MODE or GREEN
FIELD)
The transmit matrix is the product of a CSD matrix and a square
matrix formed of orthogonal columns, as defined in the IEEE
802.11n specification.
INDirect
(only active with physical modes MIXED MODE or GREEN
FIELD)
The transmit matrix is the product of a CSD matrix and the
Hadamard unitary matrix.
*RST: EXPansion

Example: BB:WLNN:FBL1:SMAP:MODE OFF
Sets the spatial mapping mode to OFF, that is, the spatial map-
ping mode is switched off automatically.

Manual operation: See " Mode " on page 82

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:TSHift<st> <TShift>

Sets the spatial mapping time shift. This value is relevant for spatial mapping mode
direct and spatial expansion only.

Frame Configuration Settings



Remote-Control CommandsIEEE 802.11n/IEEE 802.11ac, IEEE 802.11ax

189Operating Manual 1178.6985.02 ─ 23

Parameters:
<TShift> float

Range: -32000 ns  to  32000 ns
Increment: 1 ns
*RST: 0 ns

Example: BB:WLNN:FBL1:SMAP:MODE TSH 1000
Sets the spatial mapping time shift to 1000 ns.

Manual operation: See " Time Shift " on page 83

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:INDex <Index>

Sets the index of the subcarrier. A matrix is mapped to each subcarrier. Except for k=0,
the index can be set in the value range of -64 to 63

Parameters:
<Index> integer

Range: depends on TxMode  to  depends on TxMode
*RST: 20

Example: BB:WLNN:FBL1:SMAP:IND 30
Sets the index of the subcarrier to k = 30.

Manual operation: See " Index k " on page 82

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:I?

Queries the time shift value of element I of the selected row and column of the spatial
transmit matrix.

Return values: 
<I> float

Example: BB:WLNN:FBL1:SMAP:ROW2:COL2:I?
queries the time shift value of element I for row 2, column 2.

Usage: Query only

Manual operation: See " I (Transmit Matrix) " on page 83

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:Q?

Queries the time shift value of element Q of the selected row and column of the spatial
transmit matrix.

Return values: 
<Q> float

Example: BB:WLNN:FBL1:SMAP:ROW2:COL2:Q?
queries the time shift value of element Q for row 2, column 2.

Usage: Query only
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Manual operation: See " Q (Transmit Matrix) " on page 83
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List of Commands
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